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1 What�s New in This Release
What�s New in Siebel Sales Handheld
Table 1 lists changes described in this version of the documentation to support Release 7.7 of the 
software. 

Table 1. New Product Features in Siebel Sales Handheld, Version 7.7

Topic Description

Signature capture

�Enabling Signature Capture in 
Siebel Handheld� on page 36

You can configure views within your Siebel Sales Handheld 
application to allow you to capture signatures.

Barcode scanning

�Administering Barcode Settings for 
Siebel Handheld� on page 44

You can set up your Siebel Sales application to capture 
barcode information with a supported barcode scanner.
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2 Overview of Siebel Sales 
Handheld
This chapter includes the following topics:

■ �About Siebel Handheld� on page 13

■ �Overview of Siebel Handheld Synchronization� on page 14

■ �Siebel Handheld Synchronization Methods and Architecture� on page 14

■ �Overview of Siebel Handheld Client Application Configuration� on page 15

About Siebel Handheld
Siebel Handheld provides a subset of functionality to that of the Siebel Web Client. The Siebel 
Handheld Client differs from the Siebel Web Client and the Siebel Mobile Web Client in that it uses a 
selected subset of views, accommodates smaller screen sizes, and has a reduced memory capacity. 
For a list of functional differences, see Chapter 3, �Application Development.�

Some features that are available on the Siebel Mobile Web Client are not available on the Siebel 
Handheld. Scripting and Siebel engines (for example, Pricing and Reporting) are not supported on 
the handheld. For a list of features that are not supported, see �Unsupported Features for Siebel 
Handheld� on page 18. 

Some supported features of the Siebel Handheld client are as follows:

■ Application Development with Siebel Tools: Siebel Handheld applications can be configured 
in Siebel Tools using the Web Applet Designer. You can take your existing Siebel application and 
use this as the basis for the Siebel Handheld application, or you can create a new application by 
using the Siebel Tools application shipped on the Siebel Handheld application DVD. See 
Chapter 3, �Application Development,� for more information.

■ Data filtering: Filtering allows you to specify a subset of data to be used on the handheld device. 
Filtering is an important feature of a Siebel Handheld deployment because of the relatively large 
size of the average enterprise database in comparison to the relatively limited memory 
capabilities of handheld devices. It is important that you allocate sufficient time in the project 
plan to create and test the handheld filters. See �Application Development� on page 17 for more 
information.

■ Deployment options: The Siebel Handheld application can be installed on Windows-powered 
devices in one of two ways. The first is to create a partnership between a desktop or laptop PC 
and the handheld device using Microsoft ActiveSync. The second is to install the Siebel Handheld 
application from external media, for example, a Cabinet (CAB) file. Handheld patches can be 
remotely deployed using PatchAgent. For more information, see Chapter 6, �Deployment of Siebel 
Handheld.�
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Overview of Siebel Sales Handheld ■ Overview of Siebel Handheld Synchronization
■ Patch Updates. Siebel Handheld automatically applies the latest software patches to the 
handheld device when needed. Companion Sync allows users to Synchronize the Handheld 
Database to the local database on Companion PC and invokes Siebel Remote to synchronize the 
local database with the server database.

■ Backing Up and Restoring Data: The Siebel Handheld application provides database backup 
functionality. A database restore utility is also included with the application. See Chapter 4, 
�Application Administration,� and Appendix A, �Troubleshooting,� for details.

Overview of Siebel Handheld 
Synchronization
The Siebel Handheld Synchronization (Sync) client synchronizes data between the Siebel Handheld 
database and the Mobile Web Client database or server database. The synchronization process does 
the following: 

■ Updates the Siebel server database with changes made to the Siebel Handheld database

■ Updates the database on the handheld device with changes made to the Siebel server database

■ Downloads metadata changes, such as object definitions for new or modified screens or views

■ Allows users to select filters to limit the amount of data that is downloaded

■ Automatically applies the latest software patches to the handheld device when needed

Siebel Handheld Synchronization 
Methods and Architecture
The following methods can be used to synchronize data on the handheld device with data in the 
Siebel server database: Companion Sync (CS), Direct Server Sync (DSS) and Direct Server Sync by 
means of Proxy (DSSvP). The architecture of these methods is discussed in the following sections.

Handheld Synchronization Servers
There are two types of synchronization servers: direct synchronization servers and companion 
synchronization servers. A direct synchronization server run on the Siebel application server can 
accept concurrent synchronization requests from multiple synchronization clients. When connecting 
to a direct synchronization server, the Siebel Handheld Sync client synchronizes its data with the 
server-side database. Companion Sync allows users to synchronize the Handheld Database to the 
local database on a companion PC device and invokes Siebel Remote to synchronize a local database 
with the server database. 

In Direct Server Sync mode, the Siebel Handheld Synchronization client uses the HTTP protocol over 
a network connection to communicate with the handheld synchronization server. Users should 
configure their handheld devices for communication over the desired network.
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Overview of Siebel Sales Handheld ■ Overview of Siebel Handheld Client Application
Configuration
A companion synchronization server runs on a companion personal computer with a Mobile Web 
Client installation and supports synchronization with a data source specified in a client configuration; 
the database resides on the companion PC.

Companion Sync
Companion Sync allows users to synchronize the Siebel Handheld application and database with a 
Siebel Remote database on a Mobile Web Client.

Microsoft ActiveSync is used to connect the handheld device and the companion PC through a serial 
or USB connection or through a network connection. The user launches Siebel Handheld Sync from 
companion PC or the device. The user can change the default filters using Siebel Handheld Sync.

Direct Server Sync
Direct Server Sync allows users to synchronize their Siebel Handheld application and database 
directly with the Siebel server. The user connects the handheld device to the Siebel application server 
through a network connection that uses the HTTP protocol. The connection runs through a IIS Web 
server to the Siebel Gateway Name server and application server, where the Sync server components 
are installed and running. 

Direct Server Sync by Means of Proxy
Direct Server Sync by means of Proxy (DSSvP) allows users to synchronize their Siebel Handheld 
application and database directly with the Siebel server. The user connects the handheld device to 
the Siebel application server through ActiveSync and the network connection established by the 
companion PC. The connection runs through a IIS Web server to the Siebel Gateway Name server 
and application server, where the Sync server components are installed.

Overview of Siebel Handheld Client 
Application Configuration
The following provides an overview of the configuration process of the Handheld client. Complete the 
following steps to configure your handheld client application.

To configure the Siebel Handheld client

1 Define the user functionality. 

Determine which user interface elements (such as screens, views, toolbars, applets, find, and 
help) will be necessary for your Siebel Handheld Client end users. For more information, see 
�About Defining User Functionality in Siebel Handheld� on page 20.

2 Configure the Siebel Handheld Client user interface. 

The process for configuring user interface elements in the Siebel Handheld Client is the same as 
that for other Siebel clients. For more information, see �Configuring User Interface Elements in 
Siebel Handheld� on page 24 and Configuring Siebel eBusiness Applications.
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Overview of Siebel Sales Handheld ■ Overview of Siebel Handheld Client Application 
Configuration
3 Identify all eScript or VB script.

Siebel Handheld applications do not currently support scripting, including eScript or VB script. 
Scripting used in your Siebel application may conflict with your Siebel Handheld application 
configuration.

4 Compile the new configuration.

For more information, see �Compiling the Siebel Handheld Application� on page 33.

5 Test the new configuration. 

Test the configuration, repeating the previous steps, to address any configuration errors.

After completing the Siebel Handheld Client configuration, you are ready to install it on the handheld 
devices. To install the Siebel Handheld configuration on a handheld device, see the instructions in 
�Installing on the Siebel Handheld Application� on page 85.
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3 Application Development
This chapter includes the following topics:

■ �Overview of Siebel Handheld Architecture� on page 17

■ �Unsupported Features for Siebel Handheld� on page 18

■ �About Defining User Functionality in Siebel Handheld� on page 20

■ �Configuration Guidelines for Siebel Handheld� on page 21

■ �About Creating Siebel Handheld Projects� on page 22

■ �Designing Screens and Views for Siebel Handheld� on page 22

■ �Configuring User Interface Elements in Siebel Handheld� on page 24

■ �Preventing Synchronization Conflicts with Siebel Handheld� on page 32

■ �Recommended Configuration Guidelines for Siebel Handheld� on page 32

■ �Compiling the Siebel Handheld Application� on page 33

■ �Configuring Printing from the Siebel Handheld Application� on page 33

■ �Testing the Siebel Handheld Application� on page 38

Overview of Siebel Handheld 
Architecture
The process for configuring a Siebel Handheld Client has a few differences, described in this chapter, 
from the process for configuring other types of Siebel clients.

NOTE: Readers should familiarize themselves with the Siebel client configuration process described 
in Configuring Siebel eBusiness Applications before attempting to configure the Siebel Handheld 
Client.

The five layers in the Siebel Handheld architecture are comparable to those used on the Siebel Web 
Client: 

Application layer. The application layer starts and closes the application.

User Interface layer. The user interface layer renders the display and interacts with actions of the 
user.

Object Manager layer. The object manager layer provides a consistent object behavior and 
interaction between all business objects within the application.

Data Manager layer. The data manager layer maintains an object-oriented abstraction of the native 
data stored in the data repositories for the benefit of the object manager.
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Database layer. The database layer includes the data that Siebel Handheld users access.

Your Administrator configures an application on the Siebel client using Siebel Tools and compiles the 
Siebel repository (.srf) file. During the synchronization process, information specific to the Siebel 
Handheld Client is extracted from the Siebel repository file. This information is used to create a 
repository metalanguage (.rml) file, that is downloaded to the handheld device. The repository 
metalanguage file has all of the layout information for the handheld device. For more information on 
Siebel Tools, see Using Siebel Tools. 

Unsupported Features for Siebel 
Handheld
The differences between configuring user interface elements for the Siebel Web Client and the Siebel 
Handheld Client are shown in Table 2.

The following are not supported in Siebel Handheld applications:

■ The following applet types are not supported:

■ Chart

■ Explorer

■ More than two applets per view is not supported. A maximum of two applets may be displayed 
at one time. 

■ Group boxes are not supported. See �Group Boxes� on page 26 for information on how to 
accommodate this limitation.

■ Alarm Manager is not supported. Therefore, if an alarm check box is added to an applet and the 
check box is selected, no alarm sounds.

■ The base time zone is determined by the system settings on the server and cannot be changed 
on the handheld device.

■ Alphabet tabs are not supported.

■ Scripting is not supported. However, any scripts on the business components will be executed 
during synchronization.

■ Siebel Workflow is not supported. 

■ Assessment creation is not supported.

Table 2. Configuring Siebel Client User Interface Elements

Client Siebel Tools SWT Template Files
Specialized 
Algorithms

Siebel Web Client Yes Yes No

Siebel Handheld Client Yes No Yes
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Application Development ■ Unsupported Features for Siebel Handheld
See the following topics which outline, more specifically, other unsupported features. 

Multi-Value Groups (MVG)
The Multi-Value Group applet is not supported on the Siebel Handheld Client; however, the Multi-
Value Group relationship is supported. The Multi-Value Group (MVG) control button does not appear 
on fields in Siebel Handheld Client applications. Instead, MVGs can be implemented as parent-child 
views. As a result, MVG fields are not editable within the parent record. In the Siebel Web Client, 
addresses of accounts are added, deleted, or edited through the Business Address MVG applet. 
However, in the Siebel Sales Handheld Client, these functions must be done through a Business 
Address child applet with an Account applet as its parent.

On the handheld, all MVG fields are displayed as read-only fields with the primary record visible. If 
you have an application or business requirement that requires the user to view or update all the 
records in the MVG, you must configure a separate view for that MVG. For example, the Address field 
in the Accounts or My Accounts view is an MVG. In the Siebel Handheld Client that field is read-only 
and displays the primary record. In order for the handheld user to see and update the addresses, 
the new Address view is configured in Siebel Tools. This new Address view is visible in the Show drop-
down list.

Functions
Siebel Handheld applications support most of the calculated fields and operations used in the Siebel 
Web applications with a few exceptions. See Table 3 for a list of the unsupported functions.

Table 3. Unsupported Functions

Function Name

BCHasRows

DockingNodeId

DockingNodeName

DockingNodeRoutId

EAILookupExternal

EAILookupSiebel

EXISTS

GetHQInstanceId

GetHQInstanceName

GetNumBCRows

GetProfileAttr

GetXAval

IsDocked
Siebel Medical Handheld Guide Version 7.7 ■ 19



Application Development ■ Installing the Siebel Handheld Client
The NOT key word is not supported on Booleans. Use the != operator instead. For example, "Active" 
!= "Y".

The RowIdToRowNum function is supported differently in the handheld applications than in the Web 
applications. In Web applications, RowIdToRowNum converts a row Id to a numeric value. In the 
handheld applications, it returns the row ID itself.

Installing the Siebel Handheld Client
For information on installing the Handheld client, see Chapter 6, �Deployment of Siebel Handheld.�

About Defining User Functionality in 
Siebel Handheld
The first step in configuring a Siebel Handheld Client is to determine which user interface elements 
are necessary. Siebel Handheld Client users have different requirements from Siebel Web Client 
users. Keep in mind the differences in display size, memory capacity, and input methods between 
handheld devices and larger computers, such as desktop computers.

The goal is to create applications that are easy for your end users to use and which take advantage 
of the strengths of the handheld device platform. Because of processing speed, memory limitations, 
and form factor differences, you should only include those user interface elements that are necessary 
for users to complete their job responsibilities.

LanguageName

LocaleName

LookupMessage

LookupTranslation

NOT

RepositoryId

RepositoryName

RowIdToRowNum

ToolsLanguage

Table 3. Unsupported Functions

Function Name
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Application Development ■ Configuration Guidelines for Siebel Handheld
Configuration Guidelines for Siebel 
Handheld
There are a few general guidelines you should bear in mind when configuring for the Siebel Handheld 
application. Use these guidelines when you design any new objects for the Siebel Handheld Client. 
This approach facilitates a logical separation of the Siebel Handheld Client user interface elements 
from the Siebel Web Client user interface elements. 

■ Identify User Activities

To conserve memory (and thereby improve performance) and ease navigation, identify business 
processes that are required by end users and develop applications that support these processes. 
If more than one type of user needs a Siebel Handheld Client application, it is preferable to divide 
the application into multiple responsibilities rather than give all possible users access to all 
available screens and views. Responsibilities are fully configurable by the application developer.

■ Limit the number of screens and views

Limit the number of screens and views. Determine critical business processes that the handheld 
will support and only pick the views that are necessary and make sense based on business 
requirements. 

■ Limit the number of applets for each view

Design each view so that it has one or, at most, two applets. Limiting the number of applets 
enhances performance, and enriches the user experience.

NOTE: In some instances, Siebel Systems found it necessary to create a view with three applets 
in its handheld applications. For these views, a toggle button was added to the applet so that the 
user can easily navigate between the two child applets.

■ Limit the number of columns and fields for each applet

Design each applet so that it only contains columns and fields that are required for end-user 
tasks. 

■ Design applications that contain as few screen and view hierarchy levels as possible

In a Web-based application, you may have views with many applets, and the user toggles 
between the applets. However, for handheld applications, create a larger number of views with 
fewer applets to allow users to quickly find information with a minimal amount of toggling.

■ Design for the Handheld Screen

Consider the following questions when designing your applets:

■ If you are using a list applet, how wide is that list applet going to be? 

■ What are the most important fields and columns that a user needs to see at a glance before 
scrolling? 

■ If you have a form applet that is a parent, for example, what fields do you really need in 
order to avoid scrolling?

■ Because there is less screen space on a handheld device than on a laptop or desktop, the 
most important data should be immediately visible.
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About Creating Siebel Handheld Projects
The Siebel Handheld projects appear in the list of projects in Siebel Tools; when Project is selected 
in the Object Explorer, the list of projects is displayed in the Object List Editor.

Use a naming convention that allows you to easily identify applications, screens, views, and applets 
belonging to a particular Siebel Handheld application. This allows you to locate all the object 
definitions in a Siebel Handheld application by querying on the name in the Object List Editor. For 
example, all of the Siebel Handheld Client screens, views, applets, toolbars, and menus use either 
an SHCE prefix (for example, SHCE Sales Account List View) or a CE suffix. Use the Object List Editor 
to query for views that contain the prefix SHCE or the suffix CE; doing so displays all of the Siebel 
Handheld Client views.

If you create a new Siebel Handheld application, create a new suffix or prefix to identify the name 
of the application and each screen, view, and applet name. For example, you could use PPC_SHCE 
for an application.

Designing Screens and Views for Siebel 
Handheld
Each view in a Siebel Handheld application can display a maximum of two applets at a time, 
regardless of the number of applets in the view. If there are more than two applets in a view, the 
user can navigate to additional applets by toggling.

Screen Allocation
The amount of screen space available for applets is determined by the type of applets in the view. 
Two applets are stacked above one another. A parent form applet in a two-applet view displays 
multiple fields on a screen. Users use the scroll bar to navigate. The form applet dynamically resizes 
if there are fewer than five fields and, therefore, does not waste screen display space with empty 
lines. The maximum number of fields that are displayed at one time is configurable by setting the 
Max Parent Applet Size preference in the User Preferences dialog. See �Setting User Preferences in 
the Siebel Handheld Application� on page 100 for more information on this user preference.

Toggling Between Multiple-Applet Views 
The Siebel Handheld Client application displays up to two applets at one time. If the view has only 
one applet, the applet takes up the entire display area. For views with two or more applets, the first 
two applets in the view are displayed, and the user toggles to see the other applets. The first applet 
is always displayed and the second applet changes as you toggle.

By default, the user toggles by choosing the View > Toggle menu item. In addition, it is 
recommended that you provide a toggle button as a visual cue to the end user that there are 
additional applets. Add a toggle button to each applet except the first applet. Identify the button with 
a Toggle caption and set methodInvoked to ToggleApplet.
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Drill-down Only Views
Some views may be drill-down only views�that is, they can only be accessed by navigating from 
another view. These views should not be accessible through the Show drop-down list. However, when 
the end user navigates to the view, the view title appears in the Show drop-down list. To configure 
a drill-down only view, set the view title as you would for any other view and set the ScreenMenu 
property to FALSE. See Configuring Siebel eBusiness Applications for more information.

Applet Focus Behavior
When navigating between views, there may be instances when you need to override the default 
behavior for giving focus to an applet

The GotoView method is used to navigate from one view to another. A button control is added to the 
applet in the view you want to navigate from, the button�s methodInvoked property is set to 
GotoView and the button�s View property is set to the view that is to be created. When the GotoView 
method is executed, it builds the specified view. If the view includes a parent and child applet, 
GotoView gives focus to the child applet. This is the desired behavior in most instances when you 
are simply navigating from one view to another.

If the desired behavior is to navigate to a new view and, additionally, create a new record, then you 
must use the GotoViewNewRecord method. This method calls two methods; it calls GotoView, and 
then it calls NewRecord, which creates a new record in the new view. 

In some instances the default behavior of these methods does not produce the intended behavior. 
For example, in the Orders view of the Service Requests screen, when you tap the Create New Order 
button, it takes you to the Order Details view, which contains a parent form applet (Service Request 
Order) and a child list applet (Service Order Entry Line Item). In this instance, when the Create New 
Order button�s GotoViewNewRecord method is executed, you want a new order to be created. 
However, the default behavior is to give focus to the child applet rather than creating a new record 
in the parent applet. Therefore, you need to override the default behavior of GotoView with the 
control user property OverrideDefaultApplet, and set the value to the applet that you want to give 
focus. The valid values are 0 (parent) and 1 (child). For example, if you create a button labeled 
�Create Service Request Order,� you would define user properties shown in Table 4:

Views with Associated Print Templates or Reports
Print templates are text files that you design and create for printing. After creating a print template, 
you associate it with an applet. When an end user chooses to print a view, the print template that is 
associated with the applet is automatically selected and used for printing. Follow these guidelines 
when creating print templates:

■ Only one print template can be associated with an applet.

Table 4.

Name Value

View SHCE Service Order Line Items View

OverrideDefaultApplet 0
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■ The print template name for a particular display applet is registered in the Mail Template property 
in the Applet object associated with the applet.

■ The template must be placed in the Templates directory.

■ The template name that goes into the Mail Template property should not include a path name or 
extension. For example, if the full path of the template is \Program Files\Siebel 
Handheld\Templates\InvoiceTemplate.txt, you would enter only the root name InvoiceTemplate 
in the property field.

■ The template file itself must have a .txt extension on the device. 

For more information, see Appendix F, �Print Configuration Settings.�

Configuring User Interface Elements in 
Siebel Handheld
When configuring user interface elements on the Siebel Handheld Client, also consider the processing 
speed and memory constraints of handheld devices. The constraint on processing speed affects the 
performance of a handheld device. The performance of a handheld device is also related to the 
number of screens and views downloaded to the handheld device. Because handheld devices are not 
meant to provide the same functionality as larger devices, such as laptops, the number of screens 
and views must be kept to a minimum on the handheld device.

Due to size constraints on handheld devices, the Siebel Handheld Client displays user interface 
elements differently from the Siebel Web Client. Consider these differences when configuring the 
Siebel Handheld Client application. For example, Siebel Handheld Client does not support an 
alphabetical index.

Configuring List Applets for the Handheld Client
You configure list applets and list columns for Siebel Handheld applications the same way you 
configure them for other Siebel applications. 

Recommended Strategy for Configuring List Applets
The recommended strategy when configuring the Siebel Handheld Client is to use the list applets for 
record navigation and to rely on form applets to provide the record details.

The following are additional guidelines to follow when designing list applets:

■ Configure specific list applets for your Siebel Handheld application, rather than reusing Siebel 
Web Client list applets.
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■ Remove all but the essential list columns. Because there is limited screen area to display list 
columns, omit all unnecessary columns to minimize horizontal scrolling. 

You may either remove the columns from the application or set the Show in List property on the 
column to FALSE.These two methods are different in the following ways. If the columns are 
removed from the application, these data won't be downloaded to the handheld device, which 
keeps the handheld data and a minimum and, in turn, optimizes synchronization performance. 
If the Show in List property on the column is set to FALSE, the data is still downloaded to the 
device but is not shown by default. This second approach, though without the synchronization 
optimization benefit, does allow convenience for the user who wants to customize visible 
columns. You should take these concerns into account when setting up users. 

■ Reorder the remaining list columns so that the most frequently used columns are furthest to the 
left.

■ Reduce the default width of the list columns so that more columns can be viewed at one time.

■ Use hyperlinks to ease navigation by enabling users to drill into a form applet. 

These changes can minimize the amount of horizontal scrolling and column reordering that users 
must do. Limiting the number of list columns to those that are essential minimizes the amount of 
data downloaded to the device, resulting in faster synchronization times and more economical use 
of device memory.

NOTE: All required fields on form and list applets appear with an asterisk (*). If an administrator 
specifies that a field is required, the field appears with an asterisk in the user interface.

Use Siebel Tools to modify, or rearrange List Columns. For more information on the List Column 
options, see Configuring Siebel eBusiness Applications.

You may make columns available, but not visible by default, by setting the Show In List property of 
the column to FALSE. From the Siebel Handheld application, you can make the columns visible from 
the View > Columns Displayed menu option. In order for the change to be reflected in the application, 
you must compile the application and synchronize with the handheld device. In addition, you must 
delete the \Program Files\Siebel Handheld\siebel.ssf file on the handheld. If this file is not deleted, 
the change to the Show In List parameter is not reflected in the application. 

Configuring Form Applets for the Handheld Client
The handheld uses a specialized algorithm to format and display form applets. Due to the display 
limitations on the device, only one pair of label and field controls are displayed on each row of the 
form, regardless of the layout shown within Siebel Tools.

Layout Sequence
When configuring for the handheld device, the Applet Web Template Items in the Applet Web 
Template determine the controls that appear on a form applet. The layout of form applets on the 
handheld device is determined by the HTML Sequence field set on control objects.
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The HTML Sequence field determines the screen layout of a handheld device. Controls are ordered 
from top-to-bottom based on their HTML Sequence property values. Label and control pairs that do 
not fit on the same line as other label and control pairs wrap to the next line.

Labels
Keep field labels in applications short (approximately 12 characters or fewer, depending on the 
character width). Use abbreviations where possible. Labels that are too long are truncated.

Group Boxes
Group boxes are not supported and are not displayed in form applets, even if they are added in the 
Web Applet Designer. Therefore, reword the field labels to include group box information if necessary. 
For example, you may have two group boxes on the form, one labeled Ship To and another labeled 
Bill To. Each group box includes a field named Address. Because group boxes are not supported, the 
Ship To and Bill To labels are lost, and two fields with the identical Address label remain. Therefore, 
you must rename the Address labels �Ship To Addr� and �Bill To Addr,� or some other label that 
distinguishes them.

Using Auto Pop-Up Lists in the Handheld Client
Sometimes when a user encounters a new view, he or she must perform an action, such as filling in 
a required field by selecting a value from a pop-up list. Rather than requiring the end user to tap the 
control to open the pop-up list, you can configure the view so that the pop-up list automatically opens 
when the end user gets to that view. To configure a pop-up list to open automatically, add the user 
property on the applet with Name set to AutoPopupField. Depending on the type of applet, this 
property is set differently:

■ For list applets, set the AutoPopupField property to the Business Component field name.

■ For form applets, set the AutoPopupField property to the name of the control.

About Home Page Applets in Siebel Handheld
To configure a Home Page applet, create an applet that has controls of HTML Type Button only. Use 
the following guidelines in creating your Home Page applets:

■ Set the MethodInvoked property of these controls to GotoView. Then add a user property for the 
control, and set the Name parameter to �View� and set the Value parameter to the view name.

■ Set the Caption field.

■ Set the HTML Sequence field according to the order in which the buttons are laid out on the 
device. The buttons appear on the Home Page applet of the handheld device, laid out in rows of 
three buttons.

■ Set the class property of the Applet to CSSFrameCEHome.
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About Buttons in Handheld
Set the HTML Type field on buttons to Button, MiniButton, PushButton, or MiniButtonEditNew. All of 
these HTML Types map to the same button control on the handheld device.

Buttons with text labels on them are sized to the minimum width required to fit the text on the 
buttons.

NOTE: You cannot use scripting to augment the button functionality in handheld applications.

You may add buttons as long as the method invoked is supported by the class or superclass of the 
frame or business component. You may also remove buttons from an applet. Be careful when 
removing buttons because you may alter the behavior of your application in unintended ways. Table 5 
describes the behavior of buttons on the different screens. Use this table to guide your decisions 
about removing buttons from your handheld applications.

Table 5. Button Functionality 

Screen View Button Button Functionality

Billings Invoice 
Line Items

Cancel Only applies to Invoices in which Type = Receivable.

■ Changes the invoice status to Cancelled.

■ Changes the Order status to Open.

■ Opens the Order Line Items view.

If the order cannot be found, displays a warning 
message.

Billings Invoice 
Line Items

Pay Opens the Invoice Payments view.

Billings Invoice 
Line Items

Print Prints an invoice.

Billings Invoice 
Line Items

Visit Home Opens the Outlet Visits view, Activities screen. The 
focus is on the visit in progress for the account on the 
invoice.

Billings Invoice 
Payments

Print Prints a payment receipt.

Billings Invoice 
Payments

Visit Home Opens the Outlet Visits view, Activities screen. The 
focus is on the visit in progress for the account on the 
invoice.
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Billings Invoice 
Line Items

Deliver If Type = Receivable:

■ Checks the inventory to see if there is sufficient 
stock to fill the order. If the requested quantity 
exceeds the on-hand stock, a message is 
displayed informing the user that there is 
insufficient inventory.

■ Compares the order total against the account�s 
available credit. If the order exceeds the available 
credit, a warning message is displayed.

■ Changes the invoice status.

■ Decrements inventory.

■ Decrements available credit.

If Type = Payable:

■ Creates a credit memo.

■ Increments inventory by the total quantity 
shipped.

■ Changes the invoice status to Credited.

Orders Order Line 
Items

Invoice ■ Checks the inventory to see if there is sufficient 
stock to fill the order. If the requested quantity 
exceeds the on-hand stock, a message is 
displayed informing the user that there is 
insufficient inventory.

The user is asked if he or she wants to update the 
order based on the available quantity. If the user 
chooses to continue, the system adjusts the Qty and 
Bonus Qty fields so that the totals do not exceed the 
available stock.

Otherwise, the user is returned to the Order Line 
Items view where he or she can edit the quantities.

■ Compares the order total against the account�s 
available credit. If the order exceeds the available 
credit, a warning message is displayed.

■ Changes the order status to Billed.

■ Generates an invoice for the order.

■ Cleans the order of all zero-quantity items.

■ Opens the Billings screen, Invoice Line Items view.

Table 5. Button Functionality 

Screen View Button Button Functionality
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Orders Order Line 
Items

List 
Products

Lists all products in the account�s Product Distribution 
list that are flagged as orderable (Retail Order flag).

Order Order Line 
Items

Print Prints the order.

Outlet Visits My Outlet 
Visits

End Visit ■ Records the current timestamp in the Actual End 
field.

■ Changes the status.

■ Makes the record read only.

■ Calculates the actual duration of the visit.

Outlet Visits My Outlet 
Visits

Prepare 
Visits

■ Verifies that a retail order activity is assigned to a 
selected visit.

■ If a retail order activity exists, an order header is 
created for the account and products that are 
flagged as orderable for the account are listed as 
line items in the order.

■ If a retail order product does not exist for the 
selected visit, an order header is created for the 
account.

Outlet Visits My Outlet 
Visits

Start Visit ■ Records the current timestamp in the Actual Start 
field.

■ Changes the status.

■ Opens the Visit Activities view.

Outlet Visits Visit 
Activities

End 
Activity

■ Records the timestamp in the Actual End field.

■ Changes the status.

■ Makes the record read only.

Outlet Visits Visit 
Activities

End Visit ■ Records the current timestamp in the Actual End 
field.

■ Changes the status.

■ Makes the record read only.

■ Calculates the actual duration of the visit.

Table 5. Button Functionality 

Screen View Button Button Functionality
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About the Menu Bar in Handheld
The menu object definition in the Siebel repository that is implemented in handheld applications is 
named SHCE Generic. The default menu bar configuration for the Siebel Handheld Client includes the 
following menus: File, Edit, View, and Help. You may remove or rename menus on the menu bar, but 
you cannot add new menus. You may reorder the menu items by changing the Position property for 
the menu items. Generally, use the default menu bar configuration for all of your Siebel Handheld 
Client applications. 

About Toolbars in Handheld
This section describes how to configure the toolbar for your application.

Outlet Visits Visit 
Activities

Start 
Activity

■ Records the current timestamp in the Actual Start 
field.

■ Changes the status.

Opens one of the following views:

■ If Type = Retail Assessment, opens the Accounts 
screen, Assessments view.

■ If Type = Retail Audit, opens the Retail Audit view.

■ If Type = Retail Order, opens the Orders screen, 
Order Line Items view.

■ If Type = Stock Transfer, opens the Activities 
screen, Product Movement view.

■ If Type = Review Billings, opens the Accounts 
screen, Invoices view.

■ If Type = Return Order, opens the Accounts 
screen, RMAs view.

Outlet Visits Visit 
Activities

Start Visit ■ Records the current timestamp in the Actual Start 
field.

■ Changes the status.

RMAs RMA Line 
Items

Credit ■ Changes RMA status to Billed.

■ Generates a credit note.

■ Opens the Billings screen, Invoice Line Items view.

Table 5. Button Functionality 

Screen View Button Button Functionality
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Table 6 shows the supported toolbar functions.

The default toolbar can be configured in Siebel Tools by configuring the SHCE Main toolbar object. 
SHCE Main is the main toolbar that is downloaded to the handheld device. If a toolbar named SHCE 
Main does not exist in your repository, a default toolbar, Main, is downloaded instead.

The SHCE Main toolbar contains the default buttons for the device: Back, Forward, New Record, New 
Query, and Execute Query. Change the order of the buttons on the display by modifying the Position 
property of the toolbar items. Remove a toolbar button by deleting it or making it inactive.

You can add additional default buttons to the toolbar by creating toolbar items whose Command 
property matches the name of an active bitmap in the SHCE Command Icons bitmap category. Do 
not add bitmaps to the SHCE Command Icons bitmap category because only those commands, which 
are already provided, are supported on the device. No additional commands are supported. You can 
remove a bitmap or make a bitmap inactive if you do not want it to appear in the Customize Toolbar 
dialog box.

You can change the bitmap for a toolbar by reimporting the bitmap from the SHCE Command Icons 
bitmap category.

An end user can personalize the toolbar by selecting View > Toolbar.

For more information on toolbars, refer to Configuring Siebel eBusiness Applications.

About the Status Bar in Handheld
The status bar is located above the toolbar. The status bar displays the status of an applet with focus, 
including the applet title and record item count (for example, Contacts: 1 of 13).

About Hyperlinks in Handheld
Configuring a drilldown, or clicking a hyperlink or dynamic hyperlink in the Siebel Handheld Client, 
is performed the same way as with other Siebel clients. For more information on configuring 
drilldowns, see Configuring Siebel eBusiness Applications.

Table 6. Supported Toolbar Functions

Toolbar Functions

Back, Forward

New Record

New Query, Execute Query

Next Record, Previous Record, First Record, Last Record

Minimize/Maximize

Delete Record
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Preventing Synchronization Conflicts 
with Siebel Handheld
Because multiple users are synchronizing with the server, conflicts may occur when any single user 
synchronizes his handheld. For more information on how to configure your application to prevent 
synchronization conflicts, see Chapter 7, �Synchronization Conflict Handling and Recovery with 
Handheld.�

Recommended Configuration Guidelines 
for Siebel Handheld
The Siebel Handheld Client application performs best if you use the following guidelines: 

■ Keep the number of views in your application to 30 or fewer.

■ For optimal usability, limit each view to one or two applets.

■ To minimize horizontal scrolling, limit the number of columns displayed in a list applet to no more 
than ten.

■ There is no limit on the number of fields in form applets of single-applet views. However, to 
minimize scrolling, keep the number of fields to 20 or fewer.

■ For each screen, create a view called My * or All * as a single list-applet view. For example, for 
the Activities screen, create a My Contacts view that has the Contacts list applet only.

■ For each screen, create a single-applet More Info view. Create this applet as a form applet. For 
example, for the Contacts screen, create a More Info view that has the Contacts form applet only.

■ Use a form applet for the parent for each parent-child view.

■ In a multi-applet view, limit the number of fields in form applets to five or fewer. Add additional 
fields only if the field width is short�for example a check box field. Reduce the number of fields 
if the fields are multiline�for example, a Comments box that contains three lines of text.

■ Do not include read-only check boxes in form applets. It is very difficult for users to discern that 
the check box is not editable.

■ Limit the number of views within a screen to 12 or fewer so that the View drop-down list is not 
too long and unwieldy.

■ Limit the number of screens to six or fewer so that the Screen drop-down list is not too long and 
unwieldy.

■ Keep query names to about 15 characters or fewer, so that they fit in the Queries drop-down list. 
For example, North American Organization is too long for a query name, so you should change 
it to a shorter name, such as N. American Org. The number of characters is a general guide 
because characters vary in width (for example, W is wider than i).

■ Keep screen names to about 15 characters or fewer, so that they fit in the Screen drop-down list. 
The number of characters is a general guide because characters vary in width.
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■ Keep view names to about 30 characters or fewer so that they fit in the View drop-down list. The 
number of characters is a general guide because characters vary in width.

■ Limit the size of the dbfile.txt file to less than two megabytes (MB). The RDBMS on the handheld 
device is approximately three times the size of dbfile.txt. If the data files are so large that they 
cannot be imported into the database with the available memory, users cannot successfully 
synchronize their data. 

Compiling the Siebel Handheld 
Application
Compiling the repository for the Siebel Handheld Client is identical to compiling on the Siebel Web 
Client Using Siebel Tools. Perform a full compilation the first time; subsequent compilations can be 
incremental, replacing only the projects that are affected. This assumes that you have organized all 
of your handheld object definitions in one project or a limited set of projects.

When you compile your application, a Siebel repository file (.srf) is created and put in the destination 
directory you specified during the compile procedure. Make this .srf file the source of repository 
information for the Siebel Handheld test client machine, defining all Siebel applications for that 
client, when you move it to your local \Siebel\objects directory.

It is strongly recommended that you make a backup of the existing .srf file in your local 
\Siebel\objects directory before overwriting it with the new one. That way, if you make an error or 
you want to revert to the original application, you have a backup that you can easily restore. For 
more information, see Using Siebel Tools.

Configuring Printing from the Siebel 
Handheld Application
Users may print from any view in the application. However, they are not necessarily printing what 
they see on their screen. They may print a portion of the data they view or data that is not viewable 
at the time. 

A print template defines the document that is to be printed. After the template has been defined, it 
must be associated with an applet in a view.

This section provides information on the following topics:

■ Defining documents

■ Designing print applets

■ Configuring applets for printing

■ Creating print buttons

■ Creating print templates
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Defining Documents for Handheld
Defining documents for printing includes several steps:

■ Determine the documents your users need to print.

■ Determine the views from which they are most likely to print the documents.

■ Lay out the document for printing.

Determining which documents users will need and the views from which they are most likely to print 
requires that you have a good understanding of the users� day-to-day work.

Whether the existing applets in a view include most of the required data or only a small portion is a 
secondary consideration. It is not likely that a printout of the existing applets, which are formatted 
for an electronic PDA interface, will provide an acceptable or usable printed document. In most 
instances, you need to create additional applets that are specifically used for printing data.

The printed document will be composed of several applets which are added to the view. The applets 
pull the data from the underlying business components. These applets, in turn, direct the data to the 
print templates discussed in Appendix E, �Print Tagging Language.�

Designing Print Applets for Handheld
The print template references applets associated with the view and is how you specify what data 
appears in the printed document. For information on print templates, see �Creating Print Templates 
for the Handheld Application� on page 36. As you design your applets, you should be aware of the print 
specifications of the printers used in the field. Portable printers typically print on two-inch or 
four-inch wide paper. You need to design your applets so that the data fits within the limits of the 
paper width. Keep your documents simple so that they work with different sizes of paper. The 
following are some guidelines to use when designing your applets to accommodate the smaller paper 
sizes.

Form Applets 
Data from only one business component can be displayed on each line in your document. When you 
design your form applets, keep in mind that you can display a maximum of two columns of data in 
form applets. You can specify that each column of data is preceded by an optional caption column. 
This means you can have up to four columns displayed in your document�two data columns and two 
caption columns. Alternatively, you may have no captions, and simply display one or two columns of 
data.

The ratio between caption and data columns is, respectively, 35 percent and 65 percent. This is a 
fixed relationship that cannot be customized in the template.
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List Applets 
When specifying the width of a column, you can either specify it with a unit of measurement or as a 
percentage of the total page width. For example, you can specify that the first column is 20 mm, and 
the second column is 40 mm. If the width of the paper you print to is narrower than 60 mm, the 
column widths automatically adjust to fit the printable width as a proportion of the specified width. 
Therefore, the first column will always be 33 percent, and the second column will be 67 percent of 
the paper width. The minimum width for a column is 8 mm, which includes a 3 mm gutter margin 
between columns.

You can specify any number of columns in your list applet. However, if the width of the column is less 
than 8 mm, the application ignores the column and does not print it.

On narrow paper widths, data from a field may not all fit on one line. Data that does not fit can be 
specified, in the Applet tag, to wrap to the next line and keep wrapping until the data in that field is 
completely displayed. The printable width of the page is equal to the paper width minus the left and 
right margins (PaperWidth � [LeftMargin + RightMargin]). These parameters are set in the setup.ini 
file. For more information on setting these parameters, see Appendix F, �Print Configuration Settings.�

Configuring Applets for Printing for the Handheld 
Application
Configure print applets as you would any other applet using Siebel Tools. In addition, set the 
following properties for each applet in the view.

■ Set the HTML Popup Dimension value to 0x0. 

The 0x0 setting hides the applet from the end user who should not see the applet that is used to 
generate the document. Exposing these applets would complicate a product that is tightly 
configured for an effective and efficient workflow on a small mobile device.

NOTE: For compatibility with previous versions, Siebel Systems continues to support the name, 
Popup Dimension, for this property. However, it is recommended that you use HTML Popup 
Dimension.

■ Set the name of the Mail Template to be the name of the print template file. For more information 
on the print template file, see �Creating Print Templates for the Handheld Application� on page 36. 
For more information on the Mail Template property, see �Views with Associated Print Templates 
or Reports� on page 23.

Configuring Print Buttons for the Handheld Application
While users can use the File > Print menu option to print a document, it is helpful to include a Print 
button on the applet to give users a visual reminder that it is possible to print from a particular view.

When you design your applets, keep the following in mind when deciding where to place the print 
button:
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■ Add the print button to the applet that is visible to the user. Do not add the print button to the 
print applet, which the user never sees.

■ Consider what the desired behavior is when determining the placement of a print button. 

For example, in a parent-child view, you may want to add the print button to the parent applet 
to ensure that the print button is always enabled. This is not necessarily true if the print button 
is placed on the child list applet. If there are no items in the list applet, the print button is 
disabled, and the end user cannot print from that view. If you only want the end user to print 
when there are list items, then placing the button on the child list applet is appropriate.

To configure a print button

1 From Siebel Tools, add a control to the print applet and specify HTML Type = Button.

2 Set Method Invoked = Print.

3 Set the Display Name property of the button. Generally, this is set to Print.

Creating Print Templates for the Handheld Application
Once you have identified and created the necessary views, you are ready to create print templates. 
A print template is a text file that includes instructions for printing a document. It specifies the data 
to be printed, document layout options, and text formatting. These instructions are specified using 
a print tagging language that is described in Appendix E, �Print Tagging Language.�

Configuring Business Object Filters in 
Siebel Handheld
You must configure the Business Object Filters for the Handheld application. These filters affect how 
data is synchronized between the handheld device and the Siebel database. For information about 
configuring the default Business Object Filters, see �Setting Business Object Filters for Siebel Handheld 
Users� on page 43. 

Enabling Signature Capture in Siebel 
Handheld
You can enable any handheld view to launch and capture signatures from a customer. The views are 
able to capture multiple signatures from within any view. Signatures are converted to an ASCII text 
format and stored with the Siebel database as ASCII text. Signatures can also be optionally encoded 
so as to prevent use of the signature outside of the context in which the signature was captured. The 
header is configurable allowing you to display any literal value, field value or calculated field value.

The signature field can be configured to show information such as disclaimers and, optionally, the 
date and time a signature is being captured. 
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At the bottom of the signature dialog box are 3 buttons. These buttons are described in Table 7:

Signature Capture Applet Control User Properties
There are 17 customizable applet level user properties that control various elements of signature 
capture. Most of these user properties are optional except for one user property that is required to 
pop up the signature dialog. This user property is named, "Signature." Setting this property to "Y" 
(yes) will enable the signature control to pop the signature dialog.

Table 8 lists the Applet control user properties to control the display of signature control. 

Table 7. Signature Capture screen buttons

Button Description

Accept Tap this button to commit the signature to the database.

Clear Tap this button to reset and clear the signature field.

Cancel Tap this button to discard the signature, closet the signature 
dialog box and return to the view that first invoked the 
signature dialog box. 

Table 8. Signature Capture Applet Control User Properties

User Property Description

SignatureDataField Field to save and fetch signature data.

NOTE: This field can be a calculated field.

SignatureHeaderField Field to fetch signature header data.

NOTE: This field can be a calculated field.

SignatureFooterField Field to fetch signature footer data.

SignatureHeaderSaveField Field to save the signature header data.

SignatureFooterSaveField Field to save the signature footer data.

MaximumHeaderLines Maximum number of text lines to display header.

MaximumFooterLines Maximum number of text lines to display footer.

SignatureHeight Height of signature capture control. The default value is 80 
pixels. Maximum value is 200 pixels.

SignatureDate �Y� appends a date to the end of the footer.

SignatureTime �Y� appends a time to the end of a footer and date.

Signature �Y� enables a signature control for the field.

ShowData �Y� enables redisplay of signature data.

EncryptKey Encryption string for storing and reading signatures.
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Testing the Siebel Handheld Application
Before deploying your application to your end users, be sure to thoroughly test the application by 
synchronizing to a handheld device. The handheld configuration is downloaded to the device where 
you can test the functionality and verify that you have the desired behavior. Another equally 
important aspect of handheld testing is to check to see how much data is downloaded to the device. 
If too many records are downloaded, this increases the length of time it takes to synchronize the 
handheld and slows down the application performance. Check the server log file to see how many 
records are downloaded for each business component. You must set the LoggingLevels parameter to 
25555 to capture this information in the log file. 

For more information on the LoggingLevels parameter, see �Configuring Server Logging Levels� on 
page 66. For more information on the server log files, see �Direct Server Sync Log Files� on page 133 
and �Companion Sync Log Files� on page 134. 

WritingGuide Defines appearance of the writing guide within the signature 
control.

InkColor Color of the ink used to display signatures.

InkWidth Width of ink writer.

BorderStyle Defines border style.

Table 8. Signature Capture Applet Control User Properties

User Property Description
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This chapter includes the following topics:

■ �Overview of Siebel Handheld Administration Screens� on page 39

■ �Setting Up Users in Siebel Handheld� on page 41

■ �Assigning User Responsibilities to Siebel Handheld Users� on page 41

■ �Administering Siebel Handheld Views� on page 41

■ �Setting Business Component Filters for Siebel Handheld Users� on page 42

■ �Setting Business Object Filters for Siebel Handheld Users� on page 43

■ �Administering Barcode Settings for Siebel Handheld� on page 44

■ �About Monitoring Synchronization Sessions for Siebel Handheld� on page 46

■ �Monitoring Synchronization Sessions for Siebel Handheld� on page 47

■ �Obtaining Error Details from Siebel Handheld Synchronization Sessions� on page 47

■ �Obtaining Business Component Information from Siebel Handheld Synchronization Conflicts� on 
page 48

■ �Obtaining an Audit Trail for Siebel Handheld Synchronization Sessions� on page 48

■ �Acting Upon Synchronization Errors in Siebel Handheld� on page 48

■ �Administering Server Components for Siebel Handheld� on page 49

Overview of Siebel Handheld 
Administration Screens
You Administer Siebel Handheld from a number of administration screens. You access the 
administration screens from the Site Map on the Siebel Mobile Web Client, and you access the Siebel 
server from the Siebel Connected Web Client. 

The chapter is designed to show you how to administer Siebel Handheld. Key tasks are outlined that 
you can perform using the Mobile Administration screens. Your organization may follow a different 
task sequence according to its business requirements.

Following is a list of Administration screens you use when administering your handheld applications. 
You access these through either the Siebel Mobile Web Client, or through a direct server 
synchronization.

■ Application Administration: This screen lists all the handheld applications available within 
your enterprise. From this view you can create new application settings and administer settings 
that have already been created. The following views are used by the synchronization engine to 
extract application definition and user data.
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■ Business Component Filters: This view contains the synchronization filter settings for 
business components. If you wish to make other business components visible to your users, 
you change filter settings in this view. 

■ Business Object Filters: This view is where you define data which is downloaded to the 
Handheld client upon synchronization.

■ Settings: This view allows you to define parameter settings for your application. 

■ Barcode Administration: This screen allows you to create new barcode definitions for your 
handheld applications.

■ Barcode Enabling: This screen allows you to set which views in the Siebel Handheld application 
are enabled for barcode scanning.

■ Conflict Administration: This screen allows you access to all data conflict information created 
by handheld users who synchronize directly to the server. You can take action on particular 
conflicts and review audit trail information of all conflicts. 

■ Audit Trail: This view, when enabled, allow you to obtain information about action taken on 
a particular data conflict. 

■ Business Component Detail: This setting allows you to see business component 
information associated with a particular data conflict. 

■ Error Details: This view allows you to get detailed information about specific data conflicts. 
You are also able to take particular action about any given conflict. 

■ Field Value: This view shows the details of a conflict. This provides a more detailed view 
than the Error Details view. 

■ Server Component Administration: This screen allows you to manage server-level settings 
for synchronization components. These settings are used by the synchronization engine to 
extract application definition and user data. 

■ Session Administration: This screen contains a detailed information about user 
synchronization sessions. Use this view to monitor and investigate handheld user 
synchronization activities. 

■ User Administration: This screen allows you to manage user-specific settings, such as business 
object and business components filters, that filter the data that display to the user. The data sets 
contained in these user screens are used by the synchronization engine to extract application 
definitions and user data. The Siebel Handheld application is populated by these data when the 
user performs synchronization.

■ User Business Component Filters: This setting contains user-specific sync filter directives 
for business components. 

■ User Business Object Filters: These settings contain user-specific queries for business 
objects. In this setting, you define a data set that is downloaded, at the time of sync, to the 
Handheld client. 

■ User Settings: This setting allows you to control user-specific settings which override 
component and application settings.
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Setting Up Users in Siebel Handheld 
To set up users on a Siebel Handheld application, perform the following tasks: 

■ �Assigning User Responsibilities to Siebel Handheld Users� on page 41

■ �Administering Siebel Handheld Views� on page 41

■ �Setting Business Component Filters for Siebel Handheld Users� on page 42

■ �Setting Business Object Filters for Siebel Handheld Users� on page 43

Assigning User Responsibilities to Siebel 
Handheld Users
You must create user accounts and assign responsibilities and passwords for each handheld user. The 
steps are the same as those for creating user accounts, assigning responsibilities and passwords for 
the Siebel Web Client. See Applications Administration Guide for more information on this topic.

Administering Siebel Handheld Views
There are two administrative tasks associated with handheld views:

■ If you have added a new view or changed the name of a view, you must add the view or update 
the name of the view in the Application Administration screen.

■ Add the default views in the Application Administration screens.

Adding Views to the Handheld Application
You add new views to the Siebel Handheld application from the Application Administration screen in 
any Siebel Web Client application. You must be logged on as an administrator. (If you are using the 
Siebel Mobile Web Client to log in as an administrator, you must also specify the /editseeddata 
parameter.)

To add new views to Siebel Handheld

1 Launch the Web Client application that uses the same database which the Siebel Handheld 
application will synchronize to (or will use to synchronize to).

NOTE: If you launch the application from a mobile Web client, specify the 
/editseeddata parameter.

2 Choose Navigate > Site Map > Administration-Application > Views.

3 Add the new views.

4 In the Responsibilities view, associate each view with the appropriate handheld responsibility.
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5 Add appropriate users to the responsibility.

NOTE: For more detailed instructions on adding views and associating views with 
responsibilities, see Applications Administration Guide.

Specifying Views for the Handheld Application
The Siebel Handheld application uses a small subset of views in the Siebel enterprise application. 
Because there are memory resource constraints on the handheld devices, it is recommended that 
you extract only those views that are used on the handheld.

There are two methods for specifying which views are extracted to the handheld. The first method 
is to compile an .srf of only those views that are relevant to the Siebel Handheld application. Or, 
alternatively, you may specify the handheld views in Administration-Mobile > Settings view. 

The views are specified in the Administration-Mobile > Settings view. By default, all views for the 
Siebel Handheld application are listed here. Edit the list so that only those views which your 
application is using appear in the list. 

The combination of the .srf file, the specified settings in the Settings view, and the user's 
responsibility determines which views are extracted. Siebel Server uses the information in the 
Settings view and the .srf file during synchronization in the following way:

■ If no default views are specified, all the views in the .srf are extracted during synchronization. If 
the .srf contains only the handheld-specific views, then this is the same as listing each handheld 
view in the handheld configuration file.

■ If default views are specified Application-Administration > Settings view, then only those views 
are extracted. If there are some views that do not match the views in the .srf file, these are 
ignored.

■ If default views are specified in the Application-Administration > Settings view, but none of the 
views match those listed in the .srf file, then all the views in the .srf are extracted.

Setting Business Component Filters for 
Siebel Handheld Users
The Business Components View in the Application Administration screen contains the sync filter 
settings for business components. If you wish to add or remove business component filter settings 
for users, you do so in this view. 

To add a business component filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, then click the 
Business Component view tab.
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3 Click New, then enter the required information. 

Some fields in the Business Component view are described in the following table: 

To remove a business component filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, then click the 
Business Component Filters view tab.

3 Select the filter setting record wish to remove. 

4 From the Business Component Filters menu, choose Delete Record. 

Setting Business Object Filters for Siebel 
Handheld Users
The Business Components View in the Application Administration screen contains the sync filter 
settings for business objects. If you wish to add or remove business object filter settings for users, 
you do so in this view.

To add a business object filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile. 

2 In the Application Administration screen, select the appropriate application, and then click the 
Business Object Filters view tab.

3 Click New, and then enter the required information. 

Field Comments

Owner A text box. Enter the Handheld application to which the 
business component will be associated. For example, Siebel 
<Application name> for CE.

Business Component A text box. Enter the business component name. For 
example, Period.

Name A text box. Enter the business component filter name. For 
example, Filter 1.

Query A text box. Enter the syntax for the query. For example, 
[Start Date] <=Today()
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4 The fields in the Business Object Filters view are described in the following table: 

To remove a business object filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, and then click the 
Business Object Filters view tab.

3 Select the filter setting record wish to remove. 

4 From the Business Object Filters menu, choose Delete Record. 

Administering Barcode Settings for 
Siebel Handheld
By default Siebel Handheld can scan and parse data from HIBC and UCC/EAN barcodes. However, 
Siebel Administrators can set up Siebel Handheld to scan and parse any 1-dimensional barcode. To 
do this, Siebel Administrators would need to define the barcodes and how data will be parsed from 
these barcodes in the Barcode Administration views. 

Creating New Barcode Definitions for the Handheld 
Application
You can define new one-dimensional barcodes in the Barcode Administration views. To define a new 
barcode, you would need to create a new barcode definition in the Barcode screen, then create 
corresponding records in the Barcode Item view to define data elements within the barcode. 

To create a new barcode definition

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Barcode 
Administration.

Field Comments

Owner A text box. Enter the Handheld application to which the 
business component will be associated. For example, Siebel 
<Application Name> for CE.

Default Check the box to allow the filter to work by default. 

Business Object A text box. Enter the business object name. For example, 
Account.

Name A text box. Enter the business object filter name. For 
example, BOFilter 1.

Query A text box. Enter the syntax for the query. For example, All.
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2 Click New, then fill in the fields. 

The fields in the Barcodes list are described in the following table: 

3 In the Barcode Item view, add new records to identify how data will be parsed from barcode.

Depending on the type of barcode standard you just defined (either Location or Code), you then 
need to create new records in the Barcode Item Applet to identify how data will parse into 
property sets.

4 In the Barcode Item applet, Click New, then update the required fields.

Some of the fields are described in the following table:

Field Comments

Name Required. Any descriptive name for the barcode. Must be 
unique for all records defined in the Barcode screen.

Sequence Required. Order in which to parse a barcode.

Barcode Type Required. Type of Barcode Standard. Can either be 
Location or Code. For details on Location and Code barcode 
types, see �Administering Barcode Settings for Siebel 
Handheld� on page 44.

Buscomp Required. Used to designate which business component the 
target data is be placed into.

Min Length Used to determine a minimum number, in digits, for data 
scanned. If data is of a fixed, minimum length is equal to 
maximum length. 

Max Length Used to determine a maximum number, in digits, for data 
scanned. If data is of a fixed, maximum length, enter a 
number which stands for the number of digits. 

Prefix Required. Defines the value that the parsing algorithm will 
use to identify barcode definition to use.

Suffix Optional. Allows you to associate suffixes with individual 
fields.

Field Comments

Name Required. Used by algorithm to identify what field to parse 
this data into (for example Lot Number, corresponds to Lot 
Number field).

Code Applicable for Code barcodes only. The number that 
precedes a data element in a barcode.
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Enabling Applications Views for Barcode Scanning
You can enable any existing or new view for barcode scanning.

To enable an application view for barcode scanning

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Barcode 
Enabling.

2 Click New, then enter the necessary information. 

The fields in the Barcodes list are described in the following table: 

About Monitoring Synchronization 
Sessions for Siebel Handheld
You monitor Handheld application synchronization sessions and synchronization conflicts from a 
number of screens within the Siebel Mobile Web Client, or if you are using DSS or DSSvP you do so 
directly on the Siebel server. Every time a user synchronizes with the server, a record is made. 

Sequence Required. For Code barcodes, once code has been 
matched, this corresponds to sequence used to parse data 
from barcodes for that data element. For Location 
barcodes, this corresponds to sequence used to parse data 
from barcodes.

Min Length Required. Minimum Length of the character string for this 
data element. If this is a variable length string, then 
Minimum Length is not equal to Maximum Length. 

Max Length Required. Maximum Length of the character string for this 
data element. If this is a variable length string, then 
Minimum Length is not equal to Maximum Length. 

Data Format Optional. Defines format for data element (for example for 
date, MMDDYY).

Field Comments

View The view in the handheld device from which the scan 
occurs.

Applet The applet within the view.

Buscomp The business component from which the information is be 
drawn.

Buscomp Field The specific field within the business component.

Field Comments
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The following topics relate to synchronization monitoring. 

■ �Monitoring Synchronization Sessions for Siebel Handheld� on page 47

■ �Obtaining Error Details from Siebel Handheld Synchronization Sessions� on page 47

■ �Obtaining Business Component Information from Siebel Handheld Synchronization Conflicts� on 
page 48

■ �Obtaining an Audit Trail for Siebel Handheld Synchronization Sessions� on page 48

■ �Acting Upon Synchronization Errors in Siebel Handheld� on page 48

Monitoring Synchronization Sessions for 
Siebel Handheld
The Session Administration > Sync Status screen allows you to gather all data related to each sync 
session a user performs. The Sync Status screen contains two views: the Sync Sessions view, and 
the Extraction Info view. These views allow you to do the following:

■ Sync Status Screen: Allows you to monitor each user sync session, and includes such data as: 
sync status, the date, type of sync and so on. 

■ Sync Sessions View: Allows you to gather further information on the status of each sync session, 
including conflicts during the sync, the size of the data extracted, and so on.

■ Extraction Info View: Allows you a detailed look at all data extracted during the sync session, 
including business component information, the number of records extracted, the filters applied 
and so on. 

To monitor synchronization sessions
■ From the application-level menu, select Navigate > Site Map > Administration-Mobile > Session 

Administration. 

The Sync Status screen appears, with two subordinate views, Sync Sessions and Extraction Info.

Obtaining Error Details from Siebel 
Handheld Synchronization Sessions
This setting allows you to obtain details of sync errors that occur during individual sync sessions. 

To obtain synchronization error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions screen appears.
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2 In the Transactions screen, select the appropriate record, and then click the Error Details view 
tab.

3 In the Error Details list, select or query for the desired record. 

Obtaining Business Component 
Information from Siebel Handheld 
Synchronization Conflicts
The Transactions view on the Conflict Administration screen allows you to obtain business component 
information related to synchronization errors that occur during individual sync sessions. 

To obtain business component error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions screen appears.

2 In the Transactions screen, select the appropriate record, and then click the Business 
Components view tab.

Obtaining an Audit Trail for Siebel 
Handheld Synchronization Sessions
The Transactions view on the Conflict Administration screen allows you to obtain audit trail 
information for an action that was taken against a particular transaction. 

To obtain synchronization error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions screen appears.

2 In the Transactions screen, select the appropriate record, and then click the Audit view tab.

Acting Upon Synchronization Errors in 
Siebel Handheld
Upon reviewing a synchronization error, you can act upon it by performing one of three different 
actions. 
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To act upon handheld sync transaction errors

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration.

The Transactions list appears. The transaction buttons are described in the following table:

2 Click either Reapply, Export, or Ignore depending on your needs.

Administering Server Components for 
Siebel Handheld
You administer server components from the Administration-Mobile > Server Component screen. The 
component displayed is based on the application selected in the Application Administration view. The 
Server Component Administration screen is used for overriding application settings at the component 
level on a specific server. This screen is where you define server level settings, which override 
settings defined at the application level. The data entered here is used by the synchronization engine 
when the user synchronizes with the server. 

The Server Component screen contains a list of server components associated with the application 
that was selected in the Application Administration screen. For each server component, the Settings 
view details the associated settings. 

Action Result

Reapply Reapplies the selected transaction with values listed in the 
view (or Field Value view).

Export Exports the content of the transaction into a text file.

Ignore Accepts the current status and does not act upon the error.
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5 Data Filtering
The following topics are covered in this chapter:

■ �Developing Data Filters for Handheld� on page 51

■ �General and Default Business Object Filters� on page 52

■ �Siebel Sales Handheld Business Object Filters� on page 52

■ �Recommendation for Managing Handheld Business Object Filters� on page 55

■ �Filtering Data for Pick Applets� on page 56

Developing Data Filters for Handheld
The following general steps for are recommended for developing Handheld synchronization filters.

■ Identify the screens and views of your application. Then identify the business components that 
are required to support each screen and view, noting the areas where each business component 
occurs. For example, identify the form, list, or pick applets that are based on each business 
component.

■ Within Siebel Tools, establish the base parent-child relationships and any reverse relationships 
at the component level.

■ Review the business components that occur in picklists and consider creating default sync filter 
declarations for those that will cause large numbers of records to synchronize to the device. 
These declarations are created and maintained in the Mobile Administration screens.

■ For each business component, determine whether it is possible to apply a search specification to 
all instances of the business component within the Siebel Handheld application. Develop a set of 
suitable Query by Example (QBE) declarations in the Mobile Administration screens. Common 
examples of business components that are suitable for global QBEs include: 

■ Employees (for large organizations)

■ Activities (for example, filter for current Activities, Activities of only certain kinds)

■ Accounts (for example, by geography) 

■ Products (for example, active, orderable products)

■ Orders (for example, open, closed in last three months)

■ Create appropriate business object synchronization filters for each business object and make 
sure that each business object includes a default filter. Default filters make sure that users avoid 
accidental download of an excessive number of records.
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General and Default Business Object 
Filters
There are two types of synchronization filters in Siebel Handheld�general and default filters.

■ General sync filters. Filters users select to specify the records users want downloaded to their 
Siebel Handheld application.

■ Default sync filters. Filters displayed by default the first time the user taps the Select Filters 
button on the Handheld Sync user interface or if the user synchronizes without first selecting a 
filter.

There is no naming convention for Siebel Handheld Business Object Filters. The default filter for a 
business object is indicated by checking the Default flag in the Administration-Mobile > Application 
Administration > Business Object Filters view. 

An asterisk (*) preceding a filter name indicates the filter could be used for sync, if selected, and 
does not display in the query list in the application. For example, �*No_Accounts.�

General filters appear in the Set Filters dialog when users synchronize their data and, if selected, in 
the Siebel Handheld application in the Queries drop-down list.

An example of a general filter name is My_Recent_Orders.

Default filters appear in the Set Filters dialog when users synchronize their data and, if selected, in 
the Siebel Handheld application in the Queries drop-down list. Default filters with the asterisk (*) 
prefix only appear in the Set Filters dialog; this filter does not show up in the application.

There should only be one default query for each business object. An example of a default filter 
isDef_Current Activities

CAUTION: Administrators must be sure to define a default filter for each business object in the 
Siebel Handheld application. If no filters are applied during the synchronization process, an 
unacceptably high volume of data will be downloaded to the handheld device.

Siebel Sales Handheld Business Object 
Filters
Table 9 shows the list of filters that come with the Sales Handheld application and the query defined 
for each filter. All filters are public�that is, they are visible to all end users. You may create additional 
PDQs or modify the ones that come with the product.
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The Sales Handheld application includes all Handheld Business Object Filters for all of the Siebel 
Handheld applications, some of which are not relevant to Sales Handheld. Therefore, it is 
recommended that you do a thorough audit of the Business Object Filters and maintain only the ones 
that apply to your particular business.

NOTE: A default filter must be defined for each screen (or business object) in the application. Only 
one default filter can be defined per screen or business object. 

Table 9. Sales Handheld Business Object Filters

Business 
Object

Business Object 
Filter Name Query Syntax

Account All_All Accounts 'Account'.Search = "" "'Account'.Sort = "Name, Location""

Account Def_*No Accounts 
(Sales)

'Account'.Search = [Id] IS NULL""

Account Active Accounts 'Account'.Search = "[Account Status] = LookupValue ( 
""ACCOUNT_STATUS"", ""Active"" )" "'Account'.Sort = 
"Name, Location""

Account CA Accounts 'Account'.Search = "[State] = LookupValue ( 
""STATE_ABBREV"", ""CA"" )" "'Account'.Sort = "Name, 
Location""

Action All_All Activities 'Action'.Search = "" "'Action'.Sort = "Due""

Action Def_Uncompleted 
Activities

'Action'.Search = "[Status] <> 
LookupValue(""EVENT_STATUS"",""Done"") OR [Status] IS 
NULL" "'Action'.Sort = "Due""

Action *No Activities 'Action'.Search = [Id] IS NULL""

Action This Week's 
Activities

'Action'.Search = "[Planned] >= Today() AND [Planned] < 
Today() + 7" "'Action'.Sort = "Due""

Contact All_All Contacts 'Contact'.Search = "" "'Contact'.Sort = "Last Name, First 
Name""

Contact Def_*No Contacts 'Contact'.Search = [Id] IS NULL""

Contact CA Contacts 'Contact'.Search = "[State] = LookupValue ( 
""STATE_ABBREV"", ""CA"" )"' "Contact'.Sort = "Last Name, 
First Name""

Employee All_All Employees 'Employee'.Search = "" "'Employee'.Sort = "Last Name, First 
Name""

Employee Def_North American 
Organization

'Employee'.Search = "EXISTS ([Organization] = ""North 
American Organization"")" "'Employee'.Sort = "Last Name, 
First Name""

Employee *No Employees 'Employee'.Search = [Id] IS NULL""
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Employee All Employees 'Employee'.Search = "" "'Employee'.Sort = "Last Name, First 
Name""

Expense All_All Expense 
Reports

'Expense'.Search = "" "'Expense'.Sort = "Start Date""

Expense Def_All Expense 
Reports

'Expense'.Search = "" "'Expense'.Sort = "Start Date""

Expense *No Expense 
Reports

''Expense'.Search = [Id] IS NULL""

Expense In Progress Expense 
Reports

'Expense'.Search = "[Status] = 
LookupValue(""EXP_STATUS"", ""In Progress"") OR [Status] 
= LookupValue(""EXP_STATUS"", ""Submitted"")" 
"'Expense'.Sort = "Submitted Date (DESCENDING)""

Internal 
Product

All_All Products 'Internal Product'.Search = "" "'Internal Product'.Sort = 
"Name""

Internal 
Product

Def_Active Products 'Internal Product'.Search = "[End Date] >= Today() OR [End 
Date] IS NULL" "'Internal Product'.Sort = "Name""

Internal 
Product

*No Products 'Internal Product'.Search = [Id] IS NULL""

Internal 
Product

All Products 'Internal Product'.Search = "" "'Internal Product'.Sort = 
"Name""

Opportunity All_All 
Opportunities

'Opportunity'.Search = "" "'Opportunity'.Sort = "Primary 
Revenue Amount (DESCENDING), Primary Revenue Close 
Date (DESCENDING)""

Opportunity Def_Big 
Opportunities

'Opportunity'.Search = "[Primary Revenue Amount] > 
""500000""" 'Opportunity'.Sort = "Primary Revenue Amount 
(DESCENDING), Primary Revenue Close Date 
(DESCENDING)" "'Account'.Sort = "Name, Location""

Opportunity *No Opportunities 'Opportunity'.Search = [Id] IS NULL""

Opportunity Current 
Opportunities

'Opportunity'.Search = "[Primary Revenue Close Date] > 
Today () - 30" "'Opportunity'.Sort = "Primary Revenue Close 
Date (DESCENDING)""

Opportunity New Opportunities 'Opportunity'.Search = "[Row Status] = ""Y""" 
"'Opportunity'.Sort = "Primary Revenue Amount 
(DESCENDING), Primary Revenue Close Date 
(DESCENDING)""

Order Entry 
(Sales)

All_All Orders 'Order Entry - Orders'.Search = "

Table 9. Sales Handheld Business Object Filters

Business 
Object

Business Object 
Filter Name Query Syntax
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Recommendation for Managing 
Handheld Business Object Filters
The following sections provide recommendations for creating and managing filters with various 
synchronization methods.

Companion Deployments
Administrators typically provide their users with an initial set of Handheld Business Object filters and 
instruct them how to manage the synchronization filters themselves later. They are maintained in 
the Administration-Mobile > Application Administration > Business Object Filters view. This view is 
hidden from mobile users so they cannot create their own Business Object Filters. 

There are several sample Handheld Business Object Filters in the sample database, as well as in the 
Siebel 7.7 seed data.

Order Entry 
(Sales)

Def_Open Orders 'Order Entry - Orders'.Search = [Status] <> 
LookupValue(""FS_ORDER_STATUS"",""Closed"") AND 
[Status]  <> 
LookupValue(""FS_ORDER_STATUS"",""Cancelled"")""

Order Entry 
(Sales)

*No Orders 'Order Entry - Orders'.Search = [Id] IS NULL""

Order Entry 
(Sales)

All Orders 'Order Entry - Orders'.Search = "

Price List All_All Price Lists 'Price List'.Search = "" "'Price List'.Sort = "Name""

Price List Def_Current Price 
Lists

'Price List'.Search = "[End Date] > Today()" "'Price List'.Sort 
= "Name""

Price List *No Price Lists 'Price List'.Search = [Id] IS NULL""

Price List All Price Lists 'Price List'.Search = "" "'Price List'.Sort = "Name""

Quote All_All Quotes 'Quote'.Search = "

Quote Def_All Quotes 'Quote'.Search = "

Quote *No Quotes 'Quote'.Search = [Id] IS NULL""

Quote Active Quotes 'Quote'.Search = [Active] = 'Y' OR [Status] = 
LookupValue(""QUOTE_STATUS"", ""Active"")""

Table 9. Sales Handheld Business Object Filters

Business 
Object

Business Object 
Filter Name Query Syntax
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Stand-Alone Deployments
For Direct Server Sync deployments, administrators can create user-specific business object and 
business component filters in the Administration-Mobile > User Administration view. For more 
information, see �Setting Business Component Filters for Siebel Handheld Users� on page 42 and 
�Setting Business Object Filters for Siebel Handheld Users� on page 43. 

NOTE: These Business Object Filters are made available to all end users and, therefore, must be 
defined with the needs of all end users in mind. 

Filtering Data for Pick Applets
Exercise caution when modifying filter for pick applets, and do so only with the support of a skilled 
Siebel configurator. 

Use default Business Object declarations to force the extraction of data for a given business 
component in the context of a given Business Object and Visibility type. For more information on 
visibility designations, see �Designating Visibility� on page 59. The Default Business Object 
extractions are performed in the first phase of data extraction.

You will most often use these declarations to extract additional data that is not extracted as part of 
the user interface extraction. This may be useful for business components that are referenced 
programmatically by other business components, but are not exposed in the user interface. The 
default business object declarations are used to enforce the extraction of a subset of data to the 
handheld that would not have been otherwise extracted or, most commonly, to filter the data 
downloaded for dynamic picklists or pick applets.

All pick data is not downloaded to the device due to the memory constraints on the device. Only pick 
data for fields that are editable is downloaded. Therefore, if you are doing a query on a pick field, 
you may not be able to display the picklist. When viewing a record in an applet, if a pick field is read-
only, its pick button will be disabled. If end users select a read-only field with a pick control, they 
receive the following error: �No data available in picklist because field is read-only.�
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Configuration Directives
These directives are located in the Mobile Administration > Application Administration > Settings 
view. Table 10 lists the configuration directives that are used to filter data:

Table 10. Configuration Directives

English LOV Display Name Definition

Allow Remember Password Enable option for end user to remember username and 
password.

Batch Download Stagger Distributes extraction over a period of time.

Batch Initial Download Sets base time for first poll.

Batch Poll Frequency Sets polling frequency.

Client Sync Default Default sync type for sync client.

DB Extract Thread Load The load (or weight) assigned to each individual Database 
Extractor thread.

Database Extract Threshold This is the minimum time the Database Extractor will 
continue extraction of business components before 
causing a handshake with the client.

Default BusComp User Props Defines subset of user props extracted for a business 
component.

Default Business Object Amends application definition to include additional 
business objects including "hidden" and RBOs.

Default Fields Identifies fields from DefaultBusObj that will be extracted 
to device.

Default Insert Mode Sets default for Insert Failure Mode.

Default Pick Mode Sets default for Extended Pick.

Enable Batch Extraction Enables Batch Sync.

Enable Sql Trace Interweaves SQL tracing into handheld sync log file.

Extraction Expiration Determines valid life span of extract.

Logging Levels Sets logging levels (must be 5 octal digits).

Max Throttle Wait Time This is the upper limit on the amount of time any 
individual throttling request will be allowed to wait.

Max Total Thread Loads The maximum number of total thread loads that will be 
allowed to run across the scope defined by Thread 
Throttle Scope.

No Database BusComp Define a business component that must be omitted from 
the device database and excluded from database 
extraction.
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CAUTION: Be extremely careful when modifying these declarations. The business objects that are 
required for internal application functioning differ by application.

Examples of Business Object Declarations
You can set the Default Business Object declarations in the Administration-Mobile > Application 
Adminitration > Settings screen, as described in the following examples.

The general format is as follows:

DefaultBusObjs22 = Opportunity | 3 | | Account | [Account Status]  = "Active" | Action 
| [Start Date] >= Today () - 30 AND [Start Date] < Today () + 90

The example Default Business Object declaration results in an extraction of the Account and Action 
business components where they occur with visibility �3� using the business object filter indicated. 
They are not extracted in context of opportunities even though the Opportunity business object was 
identified. The business object filters are generally used only for extracting business components 
that do not correspond to any views or applets. Business object declarations identify specific business 
components within the business object to be extracted. The business object filters normally give a 
query based on the primary business component in the business object, but do not force extraction 
of any business components mentioned in the query, therefore, in order for a business component 
to be extracted from the business object it must be attached to an applet.

Note that there is no business object filter included in the example. A business object filter is only 
included when you want to force the use of a particular business object synchronization filter. See 
�General and Default Business Object Filters� on page 52 for more information on business object 
synchronization filters.

In the following example, the declaration is used to extract all of the Price List Line Items that will 
display within the Orders screen.

DefaultBusObjs13=  Order Entry (Sales)|0||Price List Item|

No Extract BusComp Define a business component that must be excluded from 
database extraction.

Schema Change Notification Define a Business Service which should receive the 
Handheld Schema Change Notification.

Thread Throttle Scope Defines the scope of the thread throttling mechanism.

Transaction Thread Load The load (or weight) assigned to each individual 
Transaction Processor thread.

Transaction Threshold This is the minimum time the Transaction Processor will 
continue processing transactions before causing a 
handshake with the client.

Table 10. Configuration Directives

English LOV Display Name Definition
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Note that this declaration lacks an associated business component statement. When this is the case, 
all of the records available to the user for the given visibility are extracted.

Another less common way to use the Default Business Object declarations is to set a single Handheld 
business object synchronization filter for the business objects that are synchronized.

Designating Visibility
It is very important that you use the correct visibility designation in the Default Business Object 
declarations. The visibility entered should be the visibility that governs the data displayed for the 
business component within the context of the Business Object specified in the declaration. In the 
previous Example 1, visibility code 3 is designated. This corresponds to All Visibility, which is the 
visibility that applies to the Account business component when it is used in a pick applet.

You determine the correct visibility to use by examining View and Business Component properties 
within Siebel Tools. When creating a Default Business Object declaration to restrict the volume of 
data extracted for a pick applet, begin by examining the Popup Visibility Type in Business Component 
Properties. Cross-reference the visibility type to the list below, and enter the appropriate visibility 
code in the declaration. If the Popup Visibility Type field on the Business Component is null, the 
default value is All. Table 11 summarizes popup visibility types and the corresponding visibility codes.

.

NOTE: Do not use the Group, Catalog, or Sub Organization Popup Visibility Types. These are not 
supported in the CE handheld applications.

Table 11. Visibility Codes

Popup Visibility Type Visibility Codes

Sales Representative 0

Manager 1

Personal 2

All 3

None 4

Organization 5

Contact 6
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Overriding the Popup Visibility
If the Popup Visibility Type setting is not sufficiently restrictive (for example, All visibility), this can 
lead to a large number of records being extracted when the picklist is processed during 
synchronization. Making the Popup Visibility Type more restrictive reduces the number of records 
extracted for picklists. The OverridePopupVisibility user property for an applet overrides the Popup 
Visibility Type on a business component. Use this property when the desired visibility differs from the 
business component�s Popup Visibility Type, and you do not want to change the Popup Visibility Type. 
If several picklists use the same business component, you can also use the OverridePopupVisibility 
user property to vary the visibility of the picklists in the different applets.

There are two considerations you should keep in mind if multiple applications are sharing the same 
repository. First, changing the Popup Visibility Type has a global effect for all instances where the 
business component is used. If multiple applications share the same repository and use the same 
business components, changing the Popup Visibility Type for a common business component could 
have an undesirable effect for another application. Second, if multiple applications share the same 
applet, the picklist in each applet shares the same visibility as defined by OverridePopupVisibility 
property. This is because the OverridePopupVisibility property is set on the containing applet.

In Siebel Tools, navigate to Applet > Applet User Properties, and define the OverridePopupVisibility 
user property on the applet containing the control that opens the pick applet. See Table 12 for a 
description of the syntax. Assign a value to this property using the syntax shown, where <buscomp 
field n> is the underlying business component field of an applet control or column, and <visibility 
type> is the code corresponding to the desired visibility of the picklist�s business component. (See 
Table 11 for a list of the visibility codes.) Because the name of the OverridePopupVisibility parameter 
must be unique, append a unique number to the name of the parameter for any other picklists, for 
example, OverridePopupVisibility1, OverridePopupVisibility2, and so on.

NOTE: If OverridePopupVisibility is used, then the picklist and pick applet search specifications are 
ignored during synchronization when the records for the picklist are extracted.

Table 12. OverridePopupVisibility Syntax

Name Value

OverridePopupVisibility <buscomp field 1>, <visibility type>

OverridePopupVisibility1 <buscomp field 2>, <visibility type>

OverridePopupVisibility<n> <buscomp field n + 1>, <visibility type>
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This chapter includes the following topics:

■ �Scripting in the Siebel Handheld Client� on page 61

■ �Overview of Server Installation in Support of the Siebel Handheld Client� on page 62

■ �Process of Server Installation for Siebel Handheld Direct Server Sync� on page 64

■ �About Siebel Handheld Synchronization Performance and Scalability� on page 67

■ �Siebel Mobile Web Client Installation� on page 68

■ �Process for Installing the Siebel Handheld Application� on page 68

■ �Installing Print Templates in the Siebel Handheld Install Directory� on page 72

■ �Setting up Siebel Handheld Application Installation on a CompactFlash Card� on page 72

■ �Setting the Siebel Handheld Application Restart Parameter� on page 73

■ �Changing the SyncURL on Siebel Handheld Devices� on page 73

■ �Installing the Siebel Handheld Application from External Media� on page 74

■ �Distributing Siebel Handheld Application Patches� on page 74

Scripting in the Siebel Handheld Client
The Siebel Handheld Client does not execute Siebel Visual Basic (VB) or Siebel eScript scripting.

The Siebel Web Client application runs Siebel VB or Siebel eScript scripts and specialized business 
component logic at synchronization time, rather than in real time on the handheld device. This has 
significant consequences in applets and controls, because scripts attached to applets and controls 
are ignored.

Be aware of the following additional issues with respect to scripts and validation: 

■ Deactivating scripts. Do not deactivate existing scripts in Siebel Tools to make the handheld 
device or the synchronization process accept data it is excluding. The script is probably used by 
the Siebel Web Client, and you can cause damage elsewhere.

■ Calls to user interface methods. When a business component script makes a call to a user 
interface method (such as MsgBox), the script cannot be executed, and the record update, 
deletion, or addition is rejected during synchronization. Strictly speaking, a script attached to a 
business component should not interact with the user interface, but it is nevertheless a common 
practice.
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Any Siebel Visual Basic code should be restricted to the business component level. Applet-level Siebel 
Visual Basic will not be executed and, therefore, should not be written for the Siebel Handheld Client 
application. As a substitute to using Siebel Visual Basic on the Siebel Handheld Client application, for 
real-time execution, use the following business component user properties:

■ BC/Field Read Only Field...for making fields or business components read-only dynamically.

■ Pickmap for fields on the picklist.

Do not use message boxes or prompts on the Siebel Visual Basic code used in conjunction with the 
Siebel Handheld Client application business components. If the business component is shared 
between the Siebel Handheld Client application and a laptop, use the following construct to 
determine if the code is being executed in real time on the laptop or during synchronization:

'ActiveViewName is only available when the script is called real time on the laptop

If (TheApplication.ActiveViewName<>"") then

MsgBox"....."

End If

Overview of Server Installation in 
Support of the Siebel Handheld Client
This section provides an overview of important factors to consider when planning Direct Server 
Synchronization (DSS) infrastructure. One aspect of successful planning and execution of a Siebel 
Handheld DSS deployment is to understand hardware and network requirements. While these factors 
are generally applicable to all deployments, there are unique aspects to each customer configuration 
and implementation strategy. Therefore, it is highly recommended that customers conduct detailed 
configuration, sizing, and production readiness reviews with Siebel Expert Services. This is especially 
important for complex deployments, such as those supporting large numbers of users over wide 
geographic areas. 

You can also improve the performance and scalability of DSS deployments by working with the Siebel 
application server component parameters. For more information about the Siebel application server, 
see �Optimizing Server Process Management� on page 67.

NOTE: The recommendations in this chapter are general ones and are intended to raise your 
awareness of the key factors in handheld synchronization, performance, and scalability. These 
factors must be confirmed for your actual environment, and the usage patterns in your enterprise 
should be taken into consideration.
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Server Topology Overview
The diagram in Figure 1 shows the servers and components that are required to deploy Direct Server 
Sync. The components are the Siebel database, Siebel server, Siebel Web engine, and Siebel 
Handheld. The synchronization components are the Siebel Sync engine which resides on Siebel 
server and the Sync client on Siebel Handheld. 

CAUTION: Companion Sync uses Siebel Remote to complete the synchronization process to the 
Siebel server from the laptop. The remote mobile user's routing model must be set to Handheld User. 
Otherwise, sync will fail. For more information, see Siebel Remote and Replication Manager 
Administration Guide.

You can improve performance by properly selecting the machine that each server runs on (Web 
server, Siebel server, database server). For example, increasing the memory and number of spindles 
improves the database server performance, and increasing the number of CPUs and the amount of 
memory improves the performance of the application server.

Recommended Hardware and Network Configuration
There are many factors to take into account when designing and implementing your server and 
network hardware and architecture, and sizing your database. The critical factor in sizing a handheld 
implementation is the expected peak synchronization load. Specific application variables to consider 
in calculating this load are: the number of concurrent users, number of transactions, and size of the 
data file. These variables should be considered within the context of the hardware specifications, 
including memory and processor speed.

The following resources are available as you plan your Siebel Handheld implementation:

■ Refer to Microsoft and manufacturer documentation for comprehensive information on server 
hardware and registry parameters.

■ Refer to Siebel Technical Note 405, Siebel Handheld Synchronization for specific 
recommendations on the following topics: 

■ Server Architecture

■ Server Hardware and Registry Parameters

Figure 1. DSS Servers and Components
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■ Database Server Sizing

■ Database Tuning

■ Dial-Up and Network

■ Wireless

■ VPN (Virtual Private Networks)

■ The Expert Services Handheld Review Package assists customers with planning their hardware 
and network for handheld implementations. Contact Siebel Expert Services for more information 
about this program.

Process of Server Installation for Siebel 
Handheld Direct Server Sync
The server components that are required for Siebel Handheld are installed when you install the Siebel 
server. See the Siebel Server installation guide for your operating system for details on installing and 
configuring Siebel server. The Siebel server installer copies the necessary DLLs to create an Object 
Manager for Direct Server Sync and creates and configures a Server Component and Component 
Group. The rest of this subsection describes which options you must select to correctly install the 
software, along with creating or configuring additional Object Managers.

This process includes the following tasks:

■ �Installing the DSS Components Using the Siebel Server Installer� on page 64

■ �Editing the DSS Object Manager Configuration File� on page 65

■ �Configuring Server Logging Levels� on page 66

■ �Optimizing Server Process Management� on page 67

Installing the DSS Components Using the Siebel Server Installer
Install the Siebel server, following the instructions in the Siebel server installation guide for the 
operating system you are using. When you reach the Setup Type screen in the Installer wizard, you 
are presented with three installation options:

■ Typical. This setup option installs all Siebel server components except those displayed. 

■ Compact. This setup option installs only those components necessary to run the Siebel server, 
but no additional components or help.

■ Custom. This setup option lets you customize your installation by choosing the specific 
components you want to install.
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Direct Server Sync
To install the Direct Server Sync components with your Siebel Server installation

1 In the Setup Type screen, choose the Custom setting, and then click Next.

NOTE: At this screen, you may also choose a different directory for your Siebel server 
installation. 

2 Choose from the following components:

■ Object Manager Component

■ Handheld Synchronization

■ Siebel Data Quality Connector

■ Remote Search Support

■ Siebel Java Integrator

The listed Custom Installation options are all selectable.

NOTE: You must enable Handheld Synchronization to enable Direct Server Sync for your DSS 
installation.

3 Click Next.

Continue with the installation in Siebel Installation Guide for Microsoft Windows: Servers, Mobile 
Web Clients, Tools.

The install wizard automatically installs and configures the DSS components. In addition, the 
installer creates a configuration file that includes the parameters necessary to properly run the DSS 
server components and the Business Component filters file.

Editing the DSS Object Manager Configuration File
You must edit the configuration (.cfg) file associated with the DSS server components that you 
installed and configured to reflect your company's environment.

To edit your configuration file

1 In Windows Explorer, navigate to the directory where the Siebel server is installed and locate the 
configuration file associated with the DSS server component. By default, this directory is 
C:\Siebel Root\ siebsrvr\BIN\ENU.

NOTE: By default, the name of the DSS Object Manager configuration file is salesce.cfg, but you 
can change the name of this file.

2 Create a backup copy of the configuration file and name it salesce.cfg.bak.

This step allows you to recover the original version of the file if you encounter errors.

3 Open the configuration file using a text editor.
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4 Enter parameter values appropriate for your deployment.

The following table shows the parameters in the .cfg file that may need to be edited to reflect 
your environment. All other parameters in this section should not require change. 

5 Save your changes.

6 Restart the component or server.

Configuring Server Logging Levels
To set the logging level, two things need to be done. Logging level must be a number 0-5. 

To configure server logging levels

1 Log into Server Manager from a (m:\siebel\bin\w32ud) prompt. 

2 Run the following: 

change evtloglvl HandheldSyncLog=[LogLevel] for comp [OMName], where [LogLevel] = an 

integer between 1 - 5 (5 enables all logging) and [OMName] = the OM name (for example, 

<ApplicationName>CEObjMgr_enu). 

Parameter Default Value Description

[Siebel] 
section 

ApplicationName SiebelSales for 
CE

The Siebel Handheld application. This 
value must match the name of the 
application as it is specified in Siebel Tools.

ApplicationTitle Siebel Sales The name of the Siebel Handheld 
application as shown on the Title bar on 
the browser. This parameter is only used if 
the Siebel Tools application developed for 
the handheld is run on the Web client.

ApplicationSplash
Text

Siebel Sales The Siebel Handheld application name as 
shown on the splash screen. This 
parameter is only used if the Siebel Tools 
application developed for the handheld is 
run on the Web client.

ComponentName Siebel Sales 
Client 

Required for Direct Server Sync, it is 
entered in the registry on the handheld 
device.
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Optimizing Server Process Management
Several parameters are outlined below that help optimize server processing for Direct Server Sync. 
To set these parameters, log into a Siebel client as a user with Administrative responsibility and 
navigate to Servers > Components > Component Parameters through the Screens menu. Select the 
SalesCE ObjManager (or the appropriate Siebel Handheld application) and update the following 
parameters to optimize threads per process. For further information and assistance, see Technical 
Note 405, Siebel Handheld Synchronization, and contact Siebel Expert Services about the Siebel 
Expert Services Handheld Review Package.

■ Max tasks. This parameter determines the maximum number of threads that can run 
concurrently for a given component. The value of this parameter should equal the maximum 
expected peak number of concurrent synchronizations.

■ Min MT servers. This parameter determines how many multithreaded server processes are 
started by default for the Siebel Object Manager.

■ Max MT Servers. This parameter defines the maximum number of processes supported by the 
instance of the Siebel Object Manager. The value for this parameter should be the same as Min 
MT servers and should be set so that threads per process (Max Tasks/Max MT Servers) is 
optimized.

About Siebel Handheld Synchronization 
Performance and Scalability
There are a number of factors that affect the performance and scalability of handheld 
synchronization. It is very important that administrators and those involved in the design and 
deployment of Siebel Handheld understand the impact of usage parameters on synchronization 
performance and scalability. For more information, see Technical Note 405, Siebel Handheld 
Synchronization for application-specific variables affecting synchronization and data from 
synchronization scalability tests. 

Using Multiple Synchronization Servers
As you scale your deployment, you may need to use multiple synchronization servers to 
accommodate all of your users. Your end users must be manually assigned to a particular server. 
Resonate products cannot be used for load balancing. Refer to Technical Note 405, Siebel Handheld 
Synchronization and to your hardware manufacturer�s documentation for more information on 
scaling deployments.

Synchronization Security
The synchronization data stream can be secured using SSL (Secure Sockets Layer). 
Siebel Medical Handheld Guide Version 7.7 ■ 67



Deployment of Siebel Handheld ■ Siebel Mobile Web Client Installation
Siebel Mobile Web Client Installation
You must edit the configuration (.cfg) file associated with syncmanager.exe (the Companion Sync 
executable) that was installed with the Siebel Mobile Web Client to reflect your user's environment. 
It may not be practical to individually edit each Companion Sync user's .cfg file; therefore, it is 
recommended that you create one edited file and distribute it to all your users with Siebel Anywhere. 
See Siebel Anywhere Administration Guide for more information.

Process for Installing the Siebel 
Handheld Application
Before you deploy the Siebel Handheld application, there are several tasks you need to perform. This 
process includes the following tasks:

■ �Editing the Handheld Application Installation Configuration File� on page 68

■ �Enabling Handheld User Database Backup� on page 70

■ �Deploying Patches to the Handheld Application with Direct Server Sync� on page 75

■ �Deploying Handheld Application Patches with Companion Sync� on page 76

■ �Creating Handheld Application Upgrade Kits to Remotely Deploy Patch Files� on page 77

■ �Downloading Patches to the Handheld Device� on page 77

Editing the Handheld Application Installation 
Configuration File
The Siebel Handheld application setup.ini file configures the Siebel Handheld Client application 
installer. Before you deploy a custom-configured Siebel Handheld application, you must update the 
parameters in the setup.ini file so that the correct values are written to the device registry before 
distributing the client installer to end users.

The setup.ini file resides in the Siebel Handheld application directory (for example, the Sales 
Handheld  directory) on the Siebel Handheld DVD-ROM. To modify this file, create a Siebel Handheld 
installation directory on the network, or create and duplicate a custom DVD-ROM for distribution to 
end users. This installation directory must include the same files and directory structure as the 
original DVD-ROM. Then, modify the setup.ini file in the custom installation directory.

NOTE: If you wish to set up parameter values other than default values, add the parameter to the 
setup.ini file and add the proper values.
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Table 13 lists the parameters that you may need to modify in the setup.ini file, their default value, 
and a description of the parameter.

Table 13. Siebel Handheld setup.ini Parameters

Parameter Default Value Description

Version 7.7 Version of the desktop Siebel application 
against which the Siebel Handheld version 
synchronizes.

Application Title Siebel Sales for 
CE

The Siebel Handheld application. This value 
must match the name of the application as it 
is specified in Siebel Tools.

ApplicationName Siebel Sales for 
CE

The Siebel Handheld application. This value 
must match the name of the application as it 
is specified in Siebel Tools. 

ApplicationSplashText Sales Handheld The Siebel Handheld application name as 
shown on the splash screen.

MultiCurrency True Required for the application to handle 
multiple currencies.

SyncURL http://Web 
Server Name or 
IP address/
Virtual Directory 
Name

Required for Direct Server Sync or 
Companion Server Sync. This value is 
entered in the registry on the handheld. See 
�Changing the SyncURL on Siebel Handheld 
Devices� on page 73 for more information on 
this parameter.

[EndUserLocalization] Section

User DefinedLang Y

LogUserDefinedLangErrors N

[Printing] Section See Appendix F, �Print Configuration 
Settings,�for more information on the 
parameters used to configure printing.

[Backup] Section Enables handheld database backups.

See �Editing the Database Backup Parameters� 
on page 71 for more information on settings 
for the parameters in this section of the 
setup.ini file.

[ApplicationLocation] Section Specifies where the Siebel Handheld 
application and database are installed.

See �Setting up Siebel Handheld Application 
Installation on a CompactFlash Card� on 
page 72 for more information on the 
parameters in this section of the setup.ini 
file.
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Enabling Handheld User Database Backup 
Siebel Systems provides a way to automatically back up a snapshot of the user�s database and 
current settings, and to restore those settings in the event of a total device failure. The backup 
functionality automatically copies all the necessary files to a single compressed file. Each time the 
user backs up, the backup process creates a new copy of the file and deletes older backups. The 
backup process must close the application in order to copy the RDBMS and handheld configuration 
files. After the files are copied, it automatically restarts the application.

The backup feature must be enabled in the application. (For more information on enabling the backup 
feature, see �Setting Up Database Backups.�) If the backup feature is enabled, a backup is created 
during every synchronization. This way, the user retains an up-to-date snapshot of the database, 
and older backup versions are removed.

InternetOptionReceiveTimeout 600000 Length of time to receive data (except data 
extraction) from the server before the 
handheld client times out. This parameter 
only applies to synchronizations using Direct 
Server Sync.

In milliseconds. The default value, 600000, is 
10 minutes.

InternetOptionSendTimeout 600000 Length of time to send data to the server in a 
single call the handheld client times out. This 
parameter only applies to synchronizations 
using Direct Server Sync.

In milliseconds. The default value, 600000, is 
10 minutes.

InternetOptionDataExtractionTi
meout

900000 Length of time to extract data from the 
server to the handheld device the handheld 
client times out. This parameter only applies 
to synchronizations using Direct Server Sync.

[Logging] Section

TXNErrorLevel 1 This level controls the extent of transaction 
error information received from the server

DefaultLogLevel 2 This is for logging messages

MaxLogFileSize 2000 This is for the maximum log file size in KB

MaxSavedLogFiles 3 Determines the number of log files to save.

Table 13. Siebel Handheld setup.ini Parameters

Parameter Default Value Description
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When the database backup feature is enabled, a database backup occurs automatically at the end of 
each synchronization. This makes the overall time to synchronize somewhat longer. The size of the 
database and the speed of the CompactFlash card also affect the time it takes to complete 
synchronization.

NOTE: Backups should not be used as a replacement for synchronization.

Setting Up Database Backups
In order to back up the database:

■ Provide users with an external memory card.

■ Install the Siebel Handheld application with the backup functionality enabled.

■ Instruct users to back up their database on a regular basis.

Backing Up to External Media
It is recommended that you back up to external media�for example, a CompactFlash card.

Backing up data to a directory in memory is an option, if external media is not available on the 
handheld device. However, if the handheld device is damaged, the backup in memory may not be 
retrievable. Also, when backup data is stored in memory, the amount of memory available to run the 
application decreases, and application performance may suffer.

Editing the Database Backup Parameters
Before users can back up the database on their handheld devices, you must first enable the Backup 
menu item on the Siebel Handheld application. This requires editing the setup.ini file to enable 
backup.

The following is an example of the default settings for the backup parameters:

[Backup]
BackupLocation = \Storage Card\Siebel Backup
BackupEnabled = N

■ BackupEnabled = [Y/N] The default is N (No). Change this setting to Y (Yes) to enable the Backup 
menu item and to trigger a backup to occur automatically after each synchronization.

If the product is installed with Backup = N, the backup menu item is disabled. You need to change 
the parameter, then reinstall the product in order to enable the menu item.

■ BackupLocation = [Backup location] The default is an external storage card. Specify the location 
where you want the data backed up. It is recommended that you do not back up to internal RAM 
because this may have a negative effect on the performance of the application. However, if you 
back up to RAM, then specify the directory location where you want the data backed up.

For more information on the setup.ini file, see Chapter 8, �Installing the Handheld Application.�
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Restoring from a Backup
For information on restoring a database from a backup, see �Backing Up and Restoring Data with the 
Siebel Handheld Client� on page 100.

Installing Print Templates in the Siebel 
Handheld Install Directory
If your application allows printing, you must include all print templates in the template subdirectory 
of the Siebel Handheld Install directory. The print templates are language-specific, so copy the 
templates to the template subdirectory within the language directory of the language you are 
deploying (for example, ...\ENU\Template). If the template includes double byte characters, such as 
Japanese string, you must save the template files as Unicode (UTF16) files. For supported language 
codes, see System Requirements and Supported Platforms on Siebel SupportWeb. 

See Appendix F, �Print Configuration Settings�for more information about Printing.

Setting up Siebel Handheld Application 
Installation on a CompactFlash Card
The default, when installing Siebel Handheld applications, is to install both the application and the 
database into RAM on the device. In most instances, there is sufficient available memory, and end 
users are satisfied with the application performance. There are situations, however, where you may 
need to optimize the application performance. You can improve performance by installing the Siebel 
Handheld application on an external storage device.

To improve the performance of the application, it is recommended that you install the application 
binary files on a CompactFlash card. By doing so, you can free up program memory. Installing the 
data on the CompactFlash card is not recommended because performance likely degrades.

You can specify, in the application�s setup.ini file, where the application files and database files are 
to be installed. By default, this is set to the handheld device. In the ApplicationLocation section of 
the setup.ini file, there are two parameters. The following shows the default settings for these 
parameters:

[ApplicationLocation]
ApplicationBinariesLocation = Device
ApplicationDataLocation = Device

■ ApplicationBinariesLocation = Device. The default is Device. To improve application performance, 
set this to CF (CompactFlash).

■ ApplicationDataLocation = Device. The default is Device. It is recommended that you always 
install the data files on the device.

After you have edited the setup.ini file, follow the instructions for installing the Siebel Handheld 
application on the client.
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Setting the Siebel Handheld Application 
Restart Parameter
Because of the limited memory on handheld devices, users may find that the performance of the 
application degrades during the course of a handheld session. This is more likely to occur if the user 
is making many customer visits and carrying out transactions that involve intensive processing. To 
minimize the effects of these occurrences, the application can be restarted to release application 
memory that is not actively being used. The memory that becomes available allows for better 
performance in the next handheld session.

The application prompts the user to periodically restart the application. A dialog box appears with 
the message �For optimal application performance it is advised that you Restart your Siebel 
application by selecting File > Restart.� The user can restart the application or ignore the message. 

The application prompts the user after a specified number of visits, which is indicated by the number 
of times the user taps the End Visit button. The frequency with which this message appears is set 
with the PressureThreshold parameter in the setup.ini file. The default is:

PressureThreshold = 29

The message is triggered when the user taps the End Visit button N + 1 times, where N is the number 
specified by the parameter. For example, using the default value of 29, the message appears after 
the 30th time (29 + 1) that the user taps the End Visit button.

If the user restarts the application after the message appears, the application resets a counter to 0. 
If the user ignores the message and does not restart the application, the counter is not reset and, 
therefore, the message does not reappear.

Changing the SyncURL on Siebel 
Handheld Devices
Once the Siebel Handheld application is installed, the SycnURL cannot be changed. If you need to 
change the SyncURL, contact Siebel Technical Support.
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Installing the Siebel Handheld 
Application from External Media
You may create an image of the Handheld Installer that can be loaded onto external media such as 
a CompactFlash card. When you create a stand-alone installer platform, a Cabinet file (CAB) is 
created in a location that you specify. The CAB file name should be siebel.pocketpc_arm.CAB. You 
can copy the CAB file to a CompactFlash card, insert the card into the handheld device, and single-
click on the file to install the Siebel Handheld application on the device.

NOTE: When installing the application on the device, the end user is asked if he or she wants to 
install the application in the default directory. Regardless of the user's answer, the application is 
always installed in the directory specified by the setup.ini file. Therefore, the only way to change the 
directory the application is installed in is to modify the parameters in the ApplicationLocation section 
of the setup.ini file.

Creating a Stand-Alone Installer
Users who synchronize in DSS mode may not have a PC, and so may not be able to create a 
partnership and synchronize using Microsoft ActiveSync. You can install the application for each user 
through a standard partnership, or you can configure a stand-alone installer as shown in the 
following pages.

During the installation, the InstallShield Wizard screen prompts you by asking, Would you like to 
deploy a CAB file to enable rapid installation for additional devices? You can configure a stand-alone 
installer by selecting Yes.

You are prompted to select a language for the application and to specify a location for the CAB file. 
The installer creates the CAB file in the location you specify.

The CAB file is a self-extracting file that includes all the files needed to install the Siebel Handheld 
application on the handheld device. When you single-click the file, the CAB file installs the 
application.

Distributing Siebel Handheld Application 
Patches
The Siebel Handheld patch delivery mechanism, PatchAgent, is a tool that automates the deployment 
of patches to handheld devices as part of the synchronization process. It allows administrators to 
distribute patches to end users with minimal involvement by the users.

During synchronization the PatchAgent executable is called, and if it detects a handheld patch, it 
automatically installs the patch on the handheld device. In order for PatchAgent to detect and deploy 
the patch, the patch files must be created and placed in the directory where PatchAgent expects to 
find the files.
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Deploying Patches to the Handheld Application with 
Direct Server Sync
In order to set up patch deployment for Direct Server Sync users, you need to patch the Siebel server 
and patch one handheld client which serves as the �model� from which patch files are pulled. Then 
the patch files are then packaged and placed in the location on the server where PatchAgent expects 
to find the files. The next time the end user synchronizes with Siebel server, the patch is installed 
onto his or her device. 

For more information on how the patch process works with synchronization, see �Downloading 
Patches to the Handheld Device� on page 77.

To set up patch deployment

1 On Siebel server, verify that the following directories exist. If they do not, create the directories.

■ C:\patch\AppBinDir

■ C:\patch\WinDir

NOTE: You may specify a drive other than C:. However, the directory names must be specified 
as shown.

2 Apply the patch to Siebel server.

3 Apply the patch to one handheld client.

4 Contact Siebel Technical Support to obtain the list of files to copy from the handheld directory 
(My Device\Program Files\Siebel Handheld) to the Siebel server directory (C:\patch\AppBinDir).

5 Contact Siebel Technical Support to obtain the list of files to copy from the handheld directory 
(My Device\Windows) to the Siebel server directory (C:\patch\WinDir).

6 From the DOS prompt, change directory to Siebel Root\SWEApp\BIN.

7 Execute the following command to stage the patch files and the patchlist.txt in the correct 
location on the server:

C:\Siebel Root\SWEApp\BIN>createpatchlist /s c:\patch /t c:\Siebel 
Root\sweapp\cepatch

/s � source directory. The directory where the patch files were moved.

/t � target directory. The directory where PatchAgent checks for the patch files.

NOTE: You may specify a drive other than C:. However, the location of the source and target 
directories must be specified exactly as shown.

After the patch files have been moved and the patch list created, the following message appears: 
�Patch List has been successfully created in Siebel Root\SWEApp\cepatch files transferred 
successfully.�

The patch files are now ready to be deployed to Direct Server Sync end users. 
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Deploying Handheld Application Patches with 
Companion Sync
In order to set up patch deployment for Companion Sync users, you need to create a �model� of a 
patched Siebel Mobile Web Client and a patched handheld client. Then you pull the designated patch 
files and place them in the correct directory on the end user�s Mobile Web Client. You may use Siebel 
Anywhere to create upgrade kits to automate this process of distributing patch files to your end 
user's Mobile Web Client. The next time the end user uses Companion Sync to synchronize their 
handheld device with the Siebel Mobile Web Client, the patch is installed on the device. 

For more information on how the patch process works with synchronization, see �Downloading 
Patches to the Handheld Device� on page 77.

To set up patch deployment

1 On Siebel server, verify that the following directories exist. If they do not, create the directories.

■ C:\patch\AppBinDir

■ C:\patch\WinDir

2 Apply the patch to Siebel server.

3 Apply the patch to Siebel Mobile Web Client.

This Mobile Web Client serves as the model from which the patch files can be pulled.

4 Apply the patch to one handheld client.

This handheld client serves as the model from which the patch files can be pulled.

5 Contact Siebel Technical Support to obtain the list of files to copy from the model handheld 
directory (My Device\Program Files\Siebel Handheld) to the Siebel server directory 
(C:\patch\AppBinDir).

6 Contact Siebel Technical Support to obtain the list of files to copy from the model handheld 
directory (My Device\Windows) to the Siebel server directory (C:\patch\WinDir).

7 From the DOS prompt, change directory to C:\Siebel Root\SWEApp\BIN.

8 Execute the following command to move the patch files to the correct location and generate a 
patchlist.txt file:

C:\Siebel Root\SWEApp\BIN>createpatchlist /s c:\patch /t c:\Siebel 
Root\sweapp\cepatch_xxx (where xxx is the language [enu, esn, and so on])

/s � source directory. The directory where the patch files were moved.

/t � target directory. The directory where PatchAgent checks for the patch files.

NOTE: You may specify a drive other than C:. However, the location of the source and target 
directories must be specified exactly as shown.

After the patch files have been moved and the patch list created, the following message appears: 
�Patch List has been successfully created in Siebel Root\SWEApp\cepatch_xxx files transferred 
successfully.�
Siebel Medical Handheld Guide Version 7.776 ■



Deployment of Siebel Handheld ■ Distributing Siebel Handheld Application Patches
9 Create the following directory on the end user�s Mobile Web Client: Siebel 
Root\client\cepatch_xxx (where xxx is the language [enu, esn, and so on]), and push the files 
from the \Siebel Root\SWEApp\cepatch_xxx directory on Siebel server to the Siebel 
Root\client\cepatch_xxx on the Mobile Web Client.

NOTE: Siebel Anywhere upgrade kits can be used to carry out this step.

Creating Handheld Application Upgrade Kits to 
Remotely Deploy Patch Files 
NOTE: This step is optional. Additionally, you must have a license for Siebel Anywhere to remotely 
distribute patches to end users.

You may use Siebel Anywhere upgrade kits to remotely distribute self-extracting zip files to your end 
users� PCs. You can use self-extracting zip files to create new directories and immediately extract 
files into the directories. Create one upgrade kit for each of the following:

■ Create the Siebel Mobile Web Client upgrade kit (Siebel Client Revisions). 

Create a single, self-extracting zip file that includes the upgraded .exe and .dll files in the Siebel 
Root\client\BIN directory on the model Mobile Web Client. Contact Siebel Technical Support to 
obtain the list of files to include. Configure the zip file to self-extract in the Siebel Root\client\BIN 
directory on the end user�s Mobile Web Client.

■ Create the Siebel Handheld upgrade kit (Siebel Client Revisions).

Create a self-extracting zip file that includes the files in the Siebel Root\SWEApp\cepatch 
directory on the server. Configure the zip file to self-extract in the \client\cepatch directory on 
the end user�s Mobile Web Client.

■ Create any other upgrade kits as needed (for example, the Siebel Customer Repository File).

Refer to Siebel Anywhere Administration Guide for information on creating upgrade kits.

NOTE: If there are read-only files on the Mobile Web Client, the end user may need to change the 
file attributes to read-write before receiving and installing the upgrade kits. Contact Siebel Technical 
Support for the list of files whose attributes need to be changed. You may use Siebel Anywhere to 
distribute a batch script that makes this change.

Downloading Patches to the Handheld Device
Patches are downloaded as part of the synchronization process. Once the patch is staged, the patch 
is downloaded the next time the end user synchronizes the handheld with Siebel server. The end user 
synchronizes as he normally would using Direct Server Sync or Companion Sync. First, any 
transactions are uploaded from the handheld device. Then:

■ If a patch needs to be applied to the handheld, the synchronization process terminates, and the 
patch process is started, which downloads the patch.
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■ If no patch needs to be applied, the synchronization process continues until the process is 
complete.

After a successful patch installation, Siebel Handheld Sync will launch automatically and continue the 
extraction. 

If the patch files are not successfully downloaded, the end user is prompted to restart the patch 
process. The end user must locate and launch patchagent.exe manually. Then, once the patch is 
successfully installed, the end user is prompted to complete the synchronization.
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7  Synchronization Conflict 
Handling and Recovery with 
Handheld
This chapter includes the following topics:

■ �Preventing Synchronization Transaction Conflicts with Siebel Handheld� on page 79

■ �Recovering Error Data in Siebel Handheld� on page 84

Preventing Synchronization Transaction 
Conflicts with Siebel Handheld
When multiple end users synchronize with a remote database, transaction conflicts may occur which 
can result in data loss. The Extended Pick and Extended Insert functionality minimizes 
synchronization conflicts. If transaction conflicts are unavoidable, then Siebel Handheld Journaling 
captures the transaction information so that the data can be recovered. The combination of Extended 
Pick, Extended Insert, and journaling eliminates the potential for data loss.

There are two features that minimize synchronization transaction conflicts.

■ Extended Pick processing

■ Extended Insert processing

The next several sections describe these features in detail.

Extended Pick Processing in Siebel Handheld
The handheld is used to capture and record transactions entered by the handheld user. During 
synchronization, these transactions are processed on the server. A situation may arise in which a 
transaction fails when it is applied to the Siebel server (through Direct Server Sync) or Siebel Mobile 
Web Client (through Companion Sync)�both of which are referred to as �server.� For example, a 
Siebel Handheld user creates a professional call activity for one of his contacts. However, since he 
last synchronized with the server, the contact involved in this transaction was deleted from the server 
database. When he tries to synchronize his handheld, the server does not find his contact, and the 
call activity for the contact cannot be inserted into the server database. To generalize this example, 
any transaction that involves data selected through picklists or pick applets fails on the server if that 
pick data is not present at the time of synchronization.

With many handheld users synchronizing with Siebel server and modifying data at different times, 
this scenario is not uncommon.
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The following describes how a pick transaction is recorded on the handheld device and processed on 
the server during synchronization. Assume that the handheld user wants to create a new call activity 
for the contact. In order to do this, the user inserts a new record in the Professional Call screen and 
�picks� the desired contact. When the contact is selected on the handheld, the Row Id of the contact 
(Contact Id) is recorded. However, on the handheld, the application does not record any of the pick 
map fields associated with the contact; only the Contact Id is recorded. When the user synchronizes 
his handheld, that Contact Id is used to locate the contact record in the server database. The Contact 
Id is then used to retrieve all of the fields used in the pick map for the Contact Id (Last Name, First 
Name, Middle Initial, Address, City, State, Zip Code, and so on).

In order to minimize pick processing failures, the handheld must record the pick row Id and all of 
the pick map data that is required for a successful transaction. This data must be recorded at the 
time of the pick, so that it can be passed to the server for processing. This enhanced functionality is 
called Extended Pick processing. Now, when the user synchronizes, the transaction is processed on 
the server as follows:

■ The synchronization process first looks for the pick record on the server database. For example, 
to add an activity it looks for the contact and, if it finds the contact, it retrieves the necessary 
data and adds the activity. This is the default behavior. 

■ If the server does not find the pick map record in the database and extended pick processing is 
enabled, it retrieves the pick record Id and pick map data from the handheld transaction and 
applies the data directly to the server.

Enabling Extended Pick Processing in Siebel Handheld
You can enable Extended Pick processing through the Application Administration screen in the Mobile 
Web Client. The parameter is as follows:

DefaultHandheldSyncPickMode

This parameter, when enabled, applies globally throughout the application. When enabled, every 
handheld pick transaction is subject to pick processing.

To enable extended pick processing

1 From the application-level menu, choose Navigate > Site Map > Administration-Mobile > 
Application Administration.
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2 Click the Settings view tab, then Query on the following value:

DefaultHandheldSyncPickMode

If there is no such record, a new record with that value should be created. See Table 14 for the 
values to enter. 

■ Business component user property.

The user property is defined on specific business components. The syntax for setting Extended 
Pick on a business component and the parameter values (Table 15) follow:

HandheldSyncPickMode=Fieldname|Mode

You may apply Extended Pick processing to multiple fields in a single business component, using 
the following syntax:

HandheldSyncPickMode=Fieldname1|Mode1, Fieldname2|Mode2

The setting on the business component takes precedence over the setting defined in the Settings 
view. For example, you can use the business component setting to nullify the global application 
of Extended Pick. See �Extended Insert Processing in Siebel Handheld� on page 82 for an example. 
Conversely, you can enable Extended Pick processing on specific business components if the 
setting in the Settings view has disabled the functionality.

Table 16 shows the combined effect of the settings in the Application-Mobile > Settings View and on 
a business component.

■ The DefaultHandheldSyncPickMode setting is omitted from application settings. 

Table 14. Business Component User Property Parameters

Business Component User 
Property Mode Value Description

DefaultHandheldSyncPickMode NoFail Turns Extended Pick processing ON.

FailOnError Turns Extended Pick processing OFF 
This is the default behavior if the 
parameter is not specified in the 
Settings view.

Table 15. Business Component User Property Parameters

Business Component 
User Property Parameter Value Description

HandheldSyncPickMode Fieldname � Specify the field name as defined in 
Siebel Tools.

Mode NoFail Turns Extended Pick processing ON.

FailOnError Turns Extended Pick processing OFF.
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■ If there is no setting on a particular business component, the setting defined in the Settings view 
applies.

■ If there is no setting defined in the Settings view, or on the business component, the default 
behavior is for Extended Pick to be turned OFF.

Extended Insert Processing in Siebel Handheld
When the server executes an insert transaction and the insert fails, there are two ways the insert 
failure can be handled:

■ A record is logged that indicates the insert failed, and synchronization continues. This is the 
default insert behavior. The Conflict Administration screen can be used to recover the data.

■ The insert failure is logged, including details of the failure, and synchronization is interrupted. 
This is the extended insert behavior. Extended insert behavior guarantees that, should an insert 
fail, data loss does not occur since synchronization is stopped until the circumstances causing 
the failure are resolved.

NOTE: If Extended Insert processing takes place, synchronization is interrupted. The 
synchronization process continues to fail until the problem is resolved. End users must contact their 
system administrators to recover from the failure. The recovery effort may involve modifying 
transactions queued for processing, modifying data on the server, or reentering transactions through 
the Siebel Handheld application.

Enabling Extended Insert Processing
You can, optionally, have a setting with the following setting name: 

DefaultHandheldInsertMode.

This parameter, when enabled, applies globally throughout the application. When enabled, every 
failed insert interrupts synchronization.

You can enable Extended Insert processing through the Settings view in the Administration-Mobile 
screen.

Table 16. Combined Effect of Extended Pick Settings

Business Component Setting

DefaultHandheldSyncPickMode=

Application Settings Value

DefaultHandheldSyncPickMode=

NoFail FailOnError Omitted 

NoFail NoFail NoFail NoFail

FailOnError FailOnError FailOnError FailOnError

Omitted NoFail FailOnError FailOnError
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Table 17 shows the settings for this parameter.

■ Business component user property.

The user property is defined on specific business components. The setting in the business 
component takes precedence over the setting defined in the Settings view. Table 18 shows the 
syntax for setting the Extended Insert on a business component and the parameter values.

HandheldInsertFailMode=Mode

Table 19 shows the combined effect of the setting in the Settings view and the setting on a business 
component.

■ The business component setting always takes precedence over the settings defined in the 
Administration-Mobile > Settings view. 

■ If there is no setting on a particular business component, the Applications Settings value applies.

■ If there is no setting in either the Settings view or on the business component, the default 
behavior is for Extended Insert to be disabled.

Table 17. Extended Insert Processing Parameter Setting

 Parameter
Mode 
Value Description

DefaultHandheldInsertMode NoFail Disables Extended Insert processing. 

FailOnError Enables Extended Insert processing.

Table 18. Business Component User Property Parameter

Business Component 
User Property Parameter Value Description

HandheldInsertFailMode Mode NoFail Disables Extended Insert processing.

FailOnErr
or

Enables Extended Insert processing.

Table 19. Combined Effect of Extended Insert Settings

Business Component 
Setting

HandheldInsertFailMode=

Application Settings Value

DefaultHandheldInsertMode=

NoFail FailOnError Omitted

NoFail NoFail NoFail NoFail
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Recovering Error Data in Siebel 
Handheld 
Synchronization errors are captured to the database, and can be accessed through the Conflict 
Administration screens. This mechanism is always enabled.

To access error data

1 From the application-level menu, choose Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

2 Click the Error Details view tab.

FailOnError FailOnError FailOnError FailOnError

No Setting on Business 
Component

NoFail FailOnError NoFail

Table 19. Combined Effect of Extended Insert Settings

Business Component 
Setting

HandheldInsertFailMode=

Application Settings Value

DefaultHandheldInsertMode=
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8 Installing the Handheld 
Application
This chapter includes the following topics:

■ �Preparing To Upgrade From a Previous Siebel Handheld Release� on page 85

■ �Installing on the Siebel Handheld Application� on page 85

■ �Reinstalling the Siebel Handheld Application� on page 88

■ �Uninstalling the Siebel Handheld Application� on page 89

■ �Preparing the Siebel Handheld Application for Barcode Scanning� on page 89

Preparing To Upgrade From a Previous 
Siebel Handheld Release
Siebel Handheld 7.7 does not support upgrades from previous releases of Siebel Handheld 
applications. To upgrade your existing application and to migrate your data and settings to Siebel 
7.7 use the following process. 

■ Back up the handheld device by synchronizing to your database. See, �Synchronizing Data on the 
Siebel Handheld Device� on page 102.

■ Uninstall your Siebel Handheld application. See, �Uninstalling the Siebel Handheld Application� on 
page 89.

■ Then install the new version of your Siebel Handheld application. See �Installing on the Siebel 
Handheld Application� on page 85.

Installing on the Siebel Handheld 
Application
There are two ways to install software onto any Windows-powered handheld device. The first is to 
create a partnership between a desktop or laptop PC and the handheld device using Microsoft 
ActiveSync. The second is to install the application from type of external media. See �Reinstalling the 
Siebel Handheld Application� on page 88 for more information.

NOTE: It is important to remember that end users must synchronize their handheld devices to 
download the application configuration and populate the database before they can use the 
application. Therefore, an administrator may install the application for an end user, but the 
synchronization must occur using the end user�s name and password.
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Installing Handheld for Companion Sync Users
Before you install and use Companion Sync (CS) with the Siebel Handheld application, you must first 
install the Siebel Mobile client on your PC. The Mobile Client Installer copies the Companion Sync 
files to your personal computer. 

NOTE: Users can only use Companion Sync to synchronize their Siebel Handheld application to a 
personal computer that already has the Siebel Mobile client installed. 

To install the Siebel Handheld application and Siebel Handheld Sync using CS

1 Using Microsoft ActiveSync, establish a partnership between the handheld device and the 
personal computer.

2 On the PC, network, or DVD, locate the folder where the Siebel Handheld Application folder is 
installed. In this folder, double-click setup.exe.

3 Choose the language you want to use for the installation and click OK.

The Welcome Screen appears. 

4 Click Next.

The Synchronization Options screen appears. 

5 Choose the Companion Sync option and click Next.

6 Select the desired language of the Siebel Handheld application and click Next.

A window appears showing the setup status, followed by several DOS windows, and the Add/
Remove Programs dialog box.

7 At the Installing Applications dialog box, click Yes to install in the default directory.

NOTE: The default directory in the Applications dialog is the directory specified by the system 
administrator in a setup file. So that the application works correctly, the Siebel Installer installs 
the application in the default directory. Therefore, even if you specify a different location for the 
application, the application is installed in the default location.

The Siebel Handheld application is installed on the handheld device. During the installation, the 
Installing Applications dialog box displays a progress bar.

It may take several minutes to install on the handheld device. When the application has been 
downloaded to the handheld device, the Application Downloading Complete dialog box appears 
on the PC. 

8 Click OK.

A message appears informing you that setup has finished installing the Siebel Handheld 
application on your computer.

9 Click Finish.

The Siebel Handheld icon appears in the Start > Programs screen on the handheld device.
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After installing the Siebel Handheld application and Siebel Handheld Sync, you must perform an 
initial synchronization before you can use the application. If you are installing the application for the 
first time on the device, synchronize the Siebel Remote database with Siebel Server, then 
synchronize the Siebel Handheld and Siebel Remote databases. See �Synchronizing Data on the Siebel 
Handheld Device� on page 102 for the procedure for synchronizing your data.

See Chapter 5, �Data Filtering,� for more information on using Companion Sync and setting filters.

Installing Handheld for Direct Server Sync Users
Most DSS users do not have access to a PC for creating a partnership with their handheld device. In 
this case, the administrator has to create partnerships with each user's device and install the 
application. Siebel Handheld applications can be installed in DSS mode using the Siebel Installer as 
described in this section.

To install the Siebel Handheld application using DSS

1 Using Microsoft ActiveSync, establish a partnership between the handheld device and the PC.

2 On the PC network or DVD-ROM, locate the folder where the Siebel Handheld Application folder 
is installed, then double-click setup.exe.

The installation process begins.

3 From the Choose Setup Language window, choose the language you want to use for the 
installation and click OK.

4 At the Synchronization Options screen, choose the Direct Server Sync option and then click Next.

The next screen displays and asks, �Would you like to deploy a CAB file to enable rapid 
installation for additional devices?�

NOTE: If you want to create a stand-alone installer, choose Yes, and then click Next. See 
�Reinstalling the Siebel Handheld Application� on page 88 for details.

5 To install the application on the device, click Next.

6 Select the desired language of the Siebel Handheld Application, and click Next.

A window appears showing the setup status, followed by several DOS windows.
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7 The Add/Remove Programs dialog appears. This is followed by the Installing Applications dialog 
that asks if you want to install in the default directory. Click Yes to install the Siebel Handheld 
application on the handheld device.

NOTE: The default directory in the Applications dialog is the directory specified by the system 
administrator in a setup file. So that the application works correctly, the Siebel Installer installs 
the application in the default directory. Therefore, even if you specify a different location for the 
application, the application is installed in the default location.

The Siebel Handheld installation automatically installs SSCE Service Pack 1 and overwrites 
existing files on your system. A message may appear asking if you want to replace existing files. 
Respond by tapping �Yes to All.�

During the installation, the Installing Applications dialog box displays a progress bar. It may take 
several minutes to install on the handheld device. When the application has been downloaded to 
the handheld device, the Application Downloading Complete dialog box displays on the PC.

8 Click OK.

A window appears informing you that setup has finished installing the Siebel Handheld 
application on your computer.

9 Click Finish.

The Siebel Handheld and Siebel Handheld Sync icons appear in the Startup screen on the handheld 
device.

After installing the Siebel Handheld application and Siebel Handheld Sync, you must perform an 
initial synchronization before the application can be used. Refer to �Synchronizing Data on the Siebel 
Handheld Device� on page 102 for the procedure for synchronizing your data.

See Chapter 5, �Data Filtering,� for more information on using Direct Server Sync and setting filters.

Reinstalling the Siebel Handheld 
Application
Follow the steps below to reinstall or upgrade your Siebel Handheld application.

To reinstall or upgrade the Siebel Handheld application

1 Before you reinstall the current application, you must first uninstall the current application on 
your device. See �Uninstalling the Siebel Handheld Application� on page 89 for more information.

2 Once you have uninstalled the application, you may then reinstall the application or install the 
newer version. See �Installing on the Siebel Handheld Application� on page 85, and follow the 
instructions for installing the Siebel Handheld application.

3 Synchronize your Siebel Handheld application. See �Synchronizing Data on the Siebel Handheld 
Device� on page 102 and follow the instructions for synchronizing your data.

NOTE: If you are using Companion Sync to synchronize your data, synchronize the Siebel 
Handheld database with the Siebel Remote database.
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Uninstalling the Siebel Handheld 
Application
Uninstalling the application deletes the database files as well as the application files.

CAUTION: Before you uninstall your application, you must synchronize your database to save any 
changes to your data since the last synchronization. If you do not synchronize before uninstalling, 
these changes will be lost. See �Synchronizing Data on the Siebel Handheld Device� on page 102 and 
follow the instructions for synchronizing your data.

To uninstall the Siebel Handheld application

1 Select Start > Settings.

2 Select the System tab and tap Remove Programs.

3 From Remove Programs, select the Siebel Handheld application and tap Remove.

NOTE: A dialog box appears saying that a file cannot be deleted. This occurs because a file may 
still reside in memory. Ignore this message and tap OK to delete all application and database 
files. No additional steps are required to remove the application and database files.

Preparing the Siebel Handheld 
Application for Barcode Scanning
If you are going to scan barcodes when performing a cycle count, you need to associate the scan 
trigger with a button on the handheld device. 

This assumes that you have already installed the drivers for the scanner you are using with your 
handheld device. For latest information on supported scanners, please refer to System Requirements 
and Supported Platforms on Siebel SupportWeb. 

To associate the scan trigger with a button on the handheld device

1 Select Start > Settings.

The Personal Settings tab appears.

2 Tap the Buttons Icon.

A table listing the assigned programs is displayed. For example, Button 1 is assigned to Calendar, 
and so on.

3 Select the button to which you want to associate the trigger. For example, Button 1.

4 Tap the Button assignment drop-down list. 

5 Select SocketTrigger from list of programs.

NOTE: You cannot use Button 5 (assigned to Record) as the device button to trigger the scan.
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9 Working with Siebel Handheld 
Applications
This chapter includes the following topics:

■ �Components of the Siebel Handheld Interface� on page 91

■ �Navigating the Siebel Handheld Interface� on page 94

■ �Navigating a List of Records in the Siebel Handheld Application� on page 95

■ �Entering Data with the Siebel Handheld Application� on page 96

■ �Finding and Querying Data in the Siebel Handheld Application� on page 97

■ �Printing with the Siebel Handheld Application� on page 98

■ �Exporting Data with the Siebel Handheld Application� on page 98

■ �Calendar and Calendar Views in the Siebel Handheld Application� on page 99

■ �Setting User Preferences in the Siebel Handheld Application� on page 100

■ �Backing Up and Restoring Data with the Siebel Handheld Client� on page 100

■ �Synchronizing Data on the Siebel Handheld Device� on page 102

■ �Synchronization Troubleshooting with the Siebel Handheld Client� on page 105

■ �Improving Siebel Handheld Application Performance� on page 106

Components of the Siebel Handheld 
Interface
The components of the handheld interface include the Screens menu, Show drop-down list, 
application-level menu, Queries drop-down list, toolbar, and status bar.
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Figure 2 shows the components of the Siebel Handheld application. 

Screens Menu
The screens menu is the first level of navigation in the Siebel Handheld application. When you launch 
the Siebel Handheld application for the first time, this tab is labeled Screens unless you have 
configured a start up view to appear. When you tap the screens menu, a drop-down list of all 
available screens appears. Tap the desired screen in the list to navigate to it. 

For information about configuring a start up view, see �Setting User Preferences in the Siebel Handheld 
Application� on page 100. 

Show Drop-Down List
The Show drop-down list is the second level of navigation in the Siebel Handheld application. This is 
where you choose views for the selected screen.

Application-Level Menu
The application�level menu consists of the File, Edit, View, and Help menus. Tap a menu to select a 
menu option. The options that are available in each menu vary depending on the task you are 
performing.

Figure 2. Siebel Handheld Screen Components
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Queries Drop-Down List
Up to two predefined queries (PDQs) are displayed in the Queries drop-down list. The list displays 
the query chosen when you synchronized (or the default filter if you did not change the Set Filters 
selection) and the All Records query, if it is defined. For more information, see Chapter 5, �Data 
Filtering.�

Siebel Toolbar
The Siebel toolbar has buttons for frequently used functionality like record navigation and querying. 
You can configure your toolbar and specify which buttons are displayed. See �Configuring User 
Interface Elements in Siebel Handheld� on page 24. 

■ Tap the New Record button to add a new record to the active list or form.

■ Tap the Back button to navigate to the previous view.

■ Tap the Forward button to navigate to the view you were in before you selected the Back button.

■ Tap the Record Navigation buttons to move through records in a form or a list.

■ Tap the New Query button to begin a new query in a form or a list.

■ Tap the Execute Query button to run the query you just created.

■ Tap the Maximize Minimize Applet button to expand the active applet so that it is the only applet 
displayed and takes up the entire screen display. This allows you to see more columns or more 
rows of data at one time. Tap again and the screen displays two applets.

Customizing the Toolbar
You can customize which buttons appear on your toolbar by selecting View > Customize Toolbar from 
the application menu.

To add and remove buttons from the toolbar, drag and drop the desired buttons between the Choose 
Toolbar Buttons dialog box and the toolbar.

Minimize Button
The Minimize button appears in the upper right corner of your window. When you tap the Minimize 
button, the application minimizes, but does not close. To reopen the minimized application, from the 
Start menu, tap the Siebel Handheld icon. To close (exit) the application, choose File > Exit.

Do not confuse the Minimize button that appears in the upper right corner with the Maximize 
Minimize Applet button that appears on the Toolbar.

Status Bar
The status bar appears at the bottom of the application window. It provides information about the 
current view. 
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Navigating the Siebel Handheld 
Interface
Navigating the Siebel Handheld application is achieved through the screens menu, the Show drop-
down list, drilling down, drilling across, toolbar buttons, and toggling.

Screens Menu
The screens menu provides the first level of navigation. Here you select the screen you want to work 
in. For more information about the screens menu, see �Components of the Siebel Handheld Interface� 
on page 91.

Show Drop-Down List
The Show drop-down list is the second level of navigation. After you have selected a screen from the 
screens menu, select a view from the Show drop-down list. Views in the Show drop-down list are 
specific to each screen.

For example, in the Activities screen you can pick the My Activities view from the Show drop-down 
list.

More Info View
To view all of the information available for a record, make sure it is selected, and choose More Info 
from the Show drop-down list.

NOTE: Not all screens have a More Info view.

Toggling Between Applets
A maximum of two applets can be displayed at one time in a Siebel Handheld application. In 
situations where there are more than two applets configured and a Toggle button has been 
configured, you may tap the Toggle button on the applet. Or you may select View > Toggle from the 
menu to toggle between applets.

Expandable Fields
Due to the limited screen size on the handheld, it is not always easy to view the data in a field without 
scrolling or resizing the field width. Therefore, some fields that could contain large amounts of text 
are expandable�that is, the data can be viewed in a text box. An ellipsis (...) appears in the field to 
indicate that the field is expandable. When you tap the ellipsis, a text box opens showing the data 
in that field. When you step off the field, the text box closes.

In form applets, an ellipsis is always visible in those fields that are expandable. However, in list 
applets, due to space constraints, the ellipsis is not always visible in expandable fields. When you 
tap on an expandable field in a list applet, the ellipsis appears. Once the ellipsis appears, you tap 
the ellipsis to open the text box.
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URLs in Applet Fields
Tapping on a field that contains a URL value launches the URL in Microsoft Internet Explorer.

Navigating a List of Records in the Siebel 
Handheld Application
Within the view you select from the Show drop-down list, you can view detailed information on a 
record. When records are displayed in a list, you can drill down or drill across the record to get 
additional details.

Drilling down occurs when you tap a hyperlink in a record and are taken to another view within the 
current screen. For example, if you are in the Accounts screen, and tap the Account Name hyperlink, 
you navigate to the details for that account. You do not leave the Accounts screen; you just move 
deeper into it.

NOTE: Hyperlinks are indicated by blue underlined text as long as they are set up this way in User 
Preferences. For more information see �Setting User Preferences in the Siebel Handheld Application� 
on page 100.

Drilling across a record occurs when you tap a hyperlink in a record and are taken to another view 
in a different screen. For example, tapping a hyperlink in the Accounts column of a contact record in 
the Contacts screen takes you to the record for that account in the Accounts screen.

Dynamic drilldown occurs when you tap a hyperlink in a record and are taken to another screen or 
just another view. Where you navigate to depends on the content in the drilldown field. 

History Arrows
To navigate back to views you have recently displayed, tap the Back button. After you have used the 
Back button, you can use the Forward button to navigate back to your original screen and view.

NOTE: The History arrows only allow you to navigate between views. These arrows do not allow you 
to recover data that may have been entered or deleted in another view.

Record Navigation Buttons
Use the Record Navigation buttons to move back and forth though a set of records. The navigation 
buttons are described in Table 20. 

Table 20. Record Navigation Buttons

Button Description

Navigates back to the previous record in the list or form.
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Entering Data with the Siebel Handheld 
Application
There are several different methods for entering data in the Siebel Handheld application. Tap the up 
arrow next to the Input Panel button to select a method. See the user guide for your device for 
information on using the different input methods.

Working with Columns in the Handheld Client
Data is displayed in lists and forms in your Siebel Handheld application. You can organize and work 
within it in a number of ways to better suit your needs.

There are several ways in which to organize columns in a list. You can:

■ Sort data by up to three columns

■ Resize columns

■ Change the order in which the columns appear

■ Show and hide columns

■ Lock columns for horizontal scrolling

You can sort records in a list by tapping in the column header of the column in which you want to 
sort the records. If the green column sort indicator points up, the column is sorted in ascending 
order. If it points down, the column is sorted in descending order.

If you need to sort by more than one column, you can open the Sort Order dialog box to sort up to 
three columns at one time. Open the Sort Order dialog box by choosing View > Advanced Sort from 
the application-level menu.

Resize columns by tapping and dragging the divider between the column headings until the column 
is the desired size.

You can change the order of columns using the Columns Displayed dialog box. Open the Columns 
Displayed dialog box by choosing View > Columns Displayed.

Navigates forward to the next record in the list or form.

Navigates back a view based on the navigation history. You can define 
which views are part of the history. If a view is set to not be recorded 
as part of the history, the back button won't go back to that view.

Table 20. Record Navigation Buttons

Button Description
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Show and hide columns using the Columns Displayed dialog box. In the Available columns list, select 
the items you want to show and tap the arrow to move the selected items to the Selected columns 
list. To hide columns, select the items and tap the arrow to move the selected items to the Available 
columns list.

Lock or unlock columns by tapping and holding the column header.

Finding and Querying Data in the Siebel 
Handheld Application
You can search for data using the Find or Query functionality in your Siebel Handheld application.

About Find in Handheld
Use Find to do a simple search for a record. You can access Find by choosing Edit > Find View > 
Find... from the application-level menu. This launches the Find dialog box, in which you can enter 
your search criteria. The asterisk wildcard function (*) can be used in the search criteria. Figure 3 
shows an example of the Find dialog window with the following fields: Look In, Last Name, Type, Last 
Call Date, Primary Specialty, and Rep Specialty.

NOTE: There may be a slight variation in your version of Siebel software, and the Find dialog box 
may not look exactly as shown here. 

About Queries in Handheld
Use Query to locate a number of records containing a specific set of criteria. There are a number of 
ways in which to perform query tasks in your Siebel Handheld application.

Figure 3. Find Dialog Box
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Creating a Query
To begin a query, you can choose Edit > Query > New from the application-level menu, or you can 
tap the New Query button on the toolbar. Both provide you with a blank form or list where you can 
enter your query criteria, depending on where you are in the application when you invoke the 
command. The asterisk wild card function (*) can be used in the search criteria.

Executing a Query
After you have created the query, you can execute it by choosing Edit > Query > Run from the 
application-level menu or by tapping the Execute Query button in the toolbar.

Refining a Query
You can refine your current query by choosing Edit > Query > Refine from the application-level menu.

Printing with the Siebel Handheld 
Application
You may print from any view in the Siebel Handheld application that has been configured to support 
printing. When you print from the handheld, a document that has been configured for the view is 
printed. You can print directly to a printer, or, if you are not connected to a printer at the time, you 
can queue your print jobs and wait until you have access to a printer to print your documents.

NOTE: When you print from a view, you are not necessarily printing what is visible on the screen at 
the time. Every field on the screen may not be relevant for the document. The document may contain 
only a portion of what is in the view, and it may also contain data that is not viewable at the time. 
A separate applet, which often cannot be viewed in the user interface, is configured specifically for 
printing.

The print templates used to generate the printed are installed during the time of setup.

For a list of supported printers, see the system requirements and supported platforms documentation 
for your application, see System Requirements and Supported Platforms on Siebel SupportWeb.

Print from the Siebel Handheld application by choosing File > Print. If you are connected to a printer, 
the print job runs. If you are not connected to a printer, the print job is sent to a print queue. View 
the print queue by choosing File > Print Queue.

Exporting Data with the Siebel Handheld 
Application
You may export data from any view in your application in HTML format or as tab delimited text and 
save it to a file. This file can be viewed in applications such as Microsoft Pocket Word, Microsoft 
Pocket Excel, and Internet Explorer.

To export data, select File > Export... to open the Export dialog box.
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In the Export dialog box, you may specify the following:

■ Format. Specify either HTML or Tab delimited text file. 

■ Export. Select Only active applet to export only the data in the active applet. Select All applets 
in view to export the data in all visible applets. 

■ Output file name. By default, the file is saved in the temp directory with the filename �output.� 
You may tap Browse to specify a different location or filename.

■ Paste Output to Clipboard. Select the checkbox to save the data to the clipboard.

■ Open file. Select the checkbox to automatically open the file. When you tap OK in the Export 
dialog box, the data is exported to the specified file, and the file is automatically opened.

NOTE: You must specify a valid output format for the application. See Table 21 for the correct 
formats to specify for the supported applications.

Calendar and Calendar Views in the 
Siebel Handheld Application
To view your calendar, choose Calendar from the screens menu.

You can view your calendar in a monthly, a weekly, or a daily format. To navigate within the calendar, 
select the calendar view you want to see from the Show drop-down list.

Customizing the Calendar
You can customize aspects of your calendar from the User Preferences view. For more information, 
see �Setting User Preferences in the Siebel Handheld Application� on page 100.

Table 21. Export Data Options

To export data to Do the following

Microsoft Word Set Format to �Tab delimited text file.�

Microsoft Excel Select the �And paste output to clipboard� check box. 
The Output format may be set either to HTML or �Tab 
delimited text file.� Paste the data from the clipboard 
into an Excel spreadsheet.

Microsoft Internet 
Explorer

Set Format to HTML.
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Setting User Preferences in the Siebel 
Handheld Application
You can customize aspects of your Siebel Handheld application from the User Preferences dialog box. 
Access the User Preferences dialog box by choosing View > User Preferences from the application-
level menu.

In the User Preferences dialog box you can:

■ Set a default startup screen.

■ Set number of maximum history threads to be saved.

■ Set the maximum percentage of the display area that the parent applet can take up.

■ Change font size.

■ Customize list spacing, column width settings, and grid lines.

■ Customize your calendar�s default view, start time, time slot interval, and default appointment 
duration.

■ Specify screen aesthetics such as alternating colors for rows and showing drilldown sources as 
hyperlinks.

Backing Up and Restoring Data with the 
Siebel Handheld Client
It is recommended that you back up your data to an external device�for example, a CompactFlash 
card or a Secure ID card. If the handheld device is damaged, the backup may not be retrievable. If 
you store your backups in RAM, depending on the size of your application and data extract, you may 
decrease the amount of memory available for the application, and your application performance may 
suffer.

Automatic Backup After Synchronization
The automatic backup feature must be enabled in the application by your System Administrator. If 
the backup feature is enabled, a backup is automatically created at the end of every synchronization. 
This way, you have an up-to-date snapshot of the database. You must never synchronize your data 
to the handheld device and then restore the database using an older copy of the database. If you 
do, the next time you synchronize, the application tries to rewrite changed transactions. This can 
cause data integrity problems. Therefore, when the database backup feature is enabled, a database 
backup occurs automatically at the end of each synchronization. Keep in mind that this makes the 
overall time to synchronize somewhat longer. The size of the database and the speed of the 
CompactFlash card also affect the time it takes to complete synchronization.

Backing Up Data
The following procedure describes how to back up the database on the handheld device.
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To back up the database

1 From the application-level menu, choose File > Backup.

NOTE: If the Backup menu item is disabled, contact your system administrator to have backup 
enabled in your application.

A dialog box appears, telling you that backing up the data will restart the application and prompts 
you to confirm that you want to continue.

2 Tap Yes to start the backup.

A status dialog box appears indicating that the backup is in progress and may take a few minutes. 
The Handheld configuration files and data is copied to the backup location specified in the 
setup.ini file. Typically, the backup location is a CF or SD card. In some cases, the location is a 
directory in memory.

A dialog box appears telling you whether the backup succeeded and asks if you want to return 
to the application.

3 Tap Yes to return to the application.

NOTE: If the backup fails, consult your system administrator.

Restoring Data from a Backup
In order to restore the application to its previous state, the user should contact the system 
administrator. Any work performed on the handheld device since the last backup will be lost.

To restore the database

1 Remove the external flash card from the damaged device and place it in a new handheld device 
where the application has been installed.

2 Navigate to the \Program Files\Siebel Handheld folder.

3 Start the restore by tapping the BackupUtility file twice.

A dialog box appears, asking you to confirm that you want to restore the device from a previous 
backup.

4 Tap Yes.

A status dialog box appears, indicating that the restore is in progress. The backup utility restores 
the files to the state when the backup was performed. A dialog box appears telling you if the 
restore was successful. If successful, it asks you to confirm that you want to restart the Siebel 
Handheld application.

5 Tap Yes to start using the application.
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Synchronizing Data on the Siebel 
Handheld Device
You must synchronize the data on your handheld device:

■ After you install or upgrade the Siebel Handheld application.

■ Before uninstalling the Siebel Handheld application.

■ On a regular basis to keep your data synchronized with Siebel Server and Siebel Mobile Web 
Client.

The sections that follow describe how to synchronize using Companion Sync (CS), Direct Server Sync 
(DSS) and Direct Server Sync via Proxy (DSSvP), and provide some troubleshooting tips.

Using Siebel Handheld Synchronization with the 
Handheld Client
Siebel Handheld Synchronization differs depending on whether users synchronize through 
Companion Sync or Direct Server Sync. The following procedures show how to launch and use 
Handheld Synchronization for each method.

NOTE: A given user can only synchronize using one method. For example, it is not possible to install 
a Siebel Handheld application that a particular user will synchronize both to the Siebel Mobile Web 
Client database through Companion Sync and also to the Siebel Server database directly through 
Direct Server Sync.

Using Companion Synchronization with the Handheld 
Client
End users that synchronize their data using Companion Sync must follow a three-step process to 
synchronize their handheld, remote, and server databases. Immediately before and after every 
Siebel Remote sync, you must perform a Companion Sync. This process can be time consuming for 
the end user and difficult for the administrator to enforce. 

Integrated Sync eliminates the need for you to initiate three separate sync sessions for each Siebel 
Remote sync. Integrated Sync is a one-button process that automatically initiates each of the 
following synchronization steps:

1 Handheld Upload and Processing�Handheld transactions are uploaded to the companion PC and 
processed.
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2 Siebel Remote Synchronization�The Siebel Mobile Client is synchronized with Siebel server. 
Transactions on the mobile client database are uploaded to Siebel server, and changes to Siebel 
server are downloaded to the mobile client database.

NOTE: If there is a handheld patch staged on the server, synchronization terminates and the patch 
is installed. After the patch installation is completed, the handheld user is prompted to synchronize 
again (using either Integrated Sync or Companion Sync) to complete the data extraction and 
download (that is, Step 3). It is critical that the handheld user synchronize a second time after the 
patch installation is completed. If he fails to do so, he is not able to start the Siebel Handheld 
application.

3 Handheld Data Extract and Download�Data is extracted from the mobile client database to the 
handheld device database.

You may use Companion Sync to synchronize your handheld with Siebel Mobile Client as many times 
as you wish between Integrated Sync sessions. However, it is recommended that you conduct 
Integrated Sync sessions frequently so that the Siebel Remote synchronization process does not take 
long periods of time to complete and update conflicts are minimized.

Synchronizing the Handheld Client for Companion Sync 
Users
When you synchronize, you have the option of either doing an Integrated Sync or Companion Sync. 
To do an Integrated Sync, select Perform Remote Sync when the Siebel Handheld Sync dialog box 
appears.

NOTE: You must close your Siebel Handheld application before synchronizing your application.

To perform Companion Sync

1 From the companion PC, establish a Microsoft ActiveSync connection to the handheld device. 

2 From the device, verify that the Siebel Handheld application is closed.

NOTE: On the Pocket PC 2003 operating system, the Minimize button (the button with the �X� 
in the top right corner of the application) minimizes but does not close the application. To close 
out the Handheld application in preparation for synchronization, you must use the File > Exit 
command.

3 From the companion PC, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

a Enter your user name and password.
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b By default, Perform Remote Sync is selected. To perform an Integrated Sync, accept the default 
setting.

If you want to do Companion Sync only, then unselect the Perform Remote Sync box.

Selecting Bypass Set Filters skips the step of selecting the filters and immediately starts the 
synchronization process. If you select Bypass Set Filters, then the filters that you selected 
the last time you synchronized are used. If this is the first time you are synchronizing, then 
the default filters are used.

4 Tap Login.

5 Tap Set Filters.

The Filters dialog box appears.

6 From the Filter list box, select the screen for which you want to choose a filter.

7 From the Choose drop-down box, select the filter you want to associate with the screen you 
selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

8 Tap OK and tap Start to begin synchronization.

a The Siebel Handheld Sync dialog box appears. If �Perform Remote Sync� was selected, this is 
followed by the Siebel Remote dialog box. When synchronization has successfully completed, the 
Finished dialog box appears.

b If a handheld patch needs to be installed, the synchronization process is interrupted and the 
patch is installed. After the patch is installed, you must restart Siebel Handheld Sync to complete 
the data extract process. If you fail to do this, you cannot start your application.

c The Finished dialog box appears indicating that the synchronization has successfully completed.

9 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Using Direct Server Synchronization with the Handheld 
Client
There are two methods for synchronizing between the handheld device and the Siebel application 
server:

■ Direct Server Sync (DSS) provides synchronization between the Siebel Handheld application and 
the Siebel application server.

■ Direct Server Sync via Proxy (DSSvP) provides synchronization between the Siebel Handheld 
application and the Siebel application server, using the desktop or companion PC to provide the 
network connection between the handheld device and the server.

NOTE: You must close your Siebel Handheld application before you synchronize with the Siebel 
application server.
Siebel Medical Handheld Guide Version 7.7104 ■



Working with Siebel Handheld Applications ■ Synchronization Troubleshooting with the
Siebel Handheld Client
To synchronize with the Siebel application server

1 If you are synchronizing using DSS, create a direct network connection through a modem or a 
direct LAN connection.

If you are synchronizing using DSSvP, establish an ActiveSync connection between the handheld 
device and the PC.

2 From the device, verify that the Siebel Handheld application is closed.

3 From the device, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

4 Enter your user name and password.

Selecting Bypass Set Filters skips the step of selecting the filters and immediately starts the 
synchronization process. If you select Bypass Set Filters, then the filters that you selected the 
last time you synchronized are used. If this is the first time you are synchronizing, then the 
default filters are used. 

5 Tap Login.

The Siebel Handheld Sync dialog box appears.

6 Tap Set Filters.

The Filters dialog box appears.

7 From the Filter list box, select the screen for which you want to choose a filter.

8 From the Choose drop-down box, select the filter you want to associate with the screen you 
selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

9 Tap OK, and then tap Start to begin synchronization.

NOTE: If a handheld patch needs to be installed, the synchronization process is interrupted and 
the patch is installed. After the patch is installed, you must restart Siebel Handheld Sync to 
complete the data extract process. If you fail to do this, you cannot start your application.

The Finished dialog box appears indicating the synchronization has successfully completed.

10 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Synchronization Troubleshooting with 
the Siebel Handheld Client
This section lists potential error messages that are associated with synchronization. In addition, this 
section explains how to fix transaction errors.
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General Synchronization Errors
There are a number of different errors that can occur when synchronization does not complete 
successfully, for example: 

■ Faulty wire connection

■ Server crash

■ Insufficient memory

■ Login error

When these errors occur, the user should exit Siebel Handheld Sync and launch the application again.

NOTE: When you restart Siebel Handheld Sync, you may see an error message that says that 
another instance of syncmanager.exe is running. You are asked whether you want to terminate the 
first instance or not, and you should choose Yes.

Transaction Conflicts
Transaction conflicts are minimized when customers adhere to the standard configuration practices 
outlined in this document. However, even when proper configuration practices are followed, conflicts 
can occur for a variety of reasons. For example, if a field value is updated on both the handheld client 
and the server between synchronization events, a transaction update conflict occurs. In this 
instance, the user is presented with an error dialog after synchronization has completed.

A transaction consists of one or more smaller transactions called mini-transactions. For example, if 
you update several fields in a record, the update to the record counts as a single transaction, and 
each update to a field is a mini-transaction. The Siebel Handheld application behaves in the same 
way as the Siebel Web application in that if any part of the transaction fails, the entire transaction 
fails. Assume, for example, that you update four fields in a record. If, during synchronization, three 
fields update correctly and one field fails to be updated, none of the fields in the record is updated.

Improving Siebel Handheld Application 
Performance
If you find that the performance of the Siebel Handheld application is very slow or begins to degrade, 
the following can help to improve the application performance:

■ Verify that your device meets the minimum memory requirements. See System Requirements 
and Supported Platforms on Siebel SupportWeb.

■ When you run the Siebel Handheld application, it is recommended that you do not run any other 
applications. By doing so, you maximize the amount of memory that is available to run the 
application.

■ Increase the amount of memory that is allocated for running applications.

■ Installing the binaries to a CompactFlash card. For more information, see �Setting up Siebel 
Handheld Application Installation on a CompactFlash Card� on page 72.
Siebel Medical Handheld Guide Version 7.7106 ■



Working with Siebel Handheld Applications ■ Improving Siebel Handheld Application
Performance
To increase application memory

1 From the Start menu, select Settings.

2 Select the System tab and tap Memory.

3 Move the slider bar so that more memory is allocated to Program Memory, then tap OK.
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10 Using Siebel Sales Handheld
This chapter includes the following topics:

■ �About Using Siebel Sales Handheld� on page 109

■ �About Managing Contacts in Siebel Sales Handheld� on page 109

■ �Managing Accounts in Siebel Sales Handheld� on page 111

■ �Developing Opportunities in Siebel Sales Handheld� on page 114

■ �Managing Customer Relationships in Siebel Sales Handheld� on page 118

■ �Developing Quotes in Siebel Sales Handheld� on page 122

■ �Managing Orders in Siebel Sales Handheld� on page 126

■ �Tracking Expenses in Sales Handheld� on page 128

About Using Siebel Sales Handheld
Siebel Sales Handheld provides mobile sales professionals with the sales tools and information to 
manage sales processes such as opportunity, account and contact management while they are in the 
field or away from their desk.

Although the sales process varies by organization, certain similarities do exist. Siebel Sales Handheld 
has been designed so that each organization can adapt its usage to best suit mobile business needs 
while building on similarities in practices found across many sales organizations. Organizations can 
use Siebel Sales Handheld in conjunction with the Siebel Sales Web client application or as a stand-
alone product.

Sales representatives may use the handheld to record contact and account information, manage 
opportunities, schedule sales activities, check product and pricing information, provide quotes and 
orders, and create expense reports. In addition, sales administrators and sales managers can 
customize the software to fit current business needs.

About Managing Contacts in Siebel Sales 
Handheld
Contacts are individuals with whom your company conducts business or expects to conduct business 
in the future. Contacts can be employees of other companies, independent consultants, vendors, or 
personal acquaintances. Contacts may be associated with several accounts, but a contact may be 
primary on only one account. Contacts may be associated with a number of opportunities, including 
those that are not related to their accounts.

The following contact management topics are included in this section:
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■ �Scenario for Managing Contacts in Sales Handheld� on page 110

■ �Adding Contacts in Sales Handheld� on page 110

■ �Associating Contacts with Opportunities in Sales Handheld� on page 111

Scenario for Managing Contacts in Sales Handheld
At a trade show, a sales representative exchanges business cards with the people she meets. Instead 
of waiting until she returns to her office, the sales representative uses Siebel Sales Handheld to enter 
essential contact information. When she returns to her office, she identifies individuals that may be 
possible sources for leads.

As the sales representative works with each contact, the possibility of doing business�an 
opportunity�may arise. If so, she can then create an opportunity and associate contacts and 
activities with it to track important milestones and key players for closing the deal.

Adding Contacts in Sales Handheld
Use the My Contacts or Personal Contacts views to enter information about your contacts. Contacts 
entered using the Personal Contacts view are not shared with team members.

To add a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts, or Personal Contacts.

■ My Contacts: Use this list for contacts that you might or might not share with the rest of your 
organization.

■ Personal Contacts: Use this list for contacts that are not shared with the rest of your 
organization.

3 Tap the New Record button, then fill the Last Name and First Name fields.

4 From the Show drop-down list, choose More Info, and then complete additional fields, as needed.

The following table describes some fields in the Contact form.

Fields Comments

Job Title A text field that displays the Contact�s professional title.

Account Displays the primary account with which the contact is 
associated. A contact may be associated with more than one 
account, but may be the primary contact on only one account 
at a time. To associate the Contact with an Account, navigate 
to the Contacts > Accounts view (if configured).
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Associating Contacts with Opportunities in Sales 
Handheld
A contact may be a source of revenue for your company. Potential revenue-generating events are 
called Opportunities. You will want to associate a contact with an existing opportunity to track 
information about both the opportunity and the contact. For more information, see �About Creating 
Opportunities in Sales Handheld� on page 115.

To associate a contact with an existing opportunity

1 Navigate to the Contacts screen.

The My Contacts list appears.

2 In the My Contacts list, select the contact with whom the opportunity will be associated.

3 From the Show drop-down list, choose Opportunities.

4 Tap in the Opportunities list, and then tap the New Record button.

The Add Opportunities list appears.

5 In the Add Opportunities list, select the opportunity to associate with the contact, and then tap 
OK.

Managing Accounts in Siebel Sales 
Handheld
An account represents the relationship between your company and the companies or individuals with 
whom you do business. You use the Accounts screen and its associated views as the primary 
navigation tool for your customer interactions.

The following topics related to account and account management are included in this section:

■ �Scenario for Managing Accounts in Sales Handheld� on page 112

■ �Creating Accounts in Sales Handheld� on page 112

■ �Associating Activities with Accounts in Sales Handheld� on page 113

■ �Associating Opportunities with Accounts in Sales Handheld� on page 114

Work Phone Number A text field that displays the contact�s work telephone number.

Site A default value that populates automatically based on the 
location of the primary account.

Fields Comments
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Scenario for Managing Accounts in Sales Handheld
A prospect is interested in learning more about the products and services that your company sells. 
The sales representative sets up a time for a sales call later in the week. 

During the sales call, the sales representative asks a number of questions to determine the account 
structure of the prospect�s business to help the representative determine how best to fit the 
prospect�s product needs. The sales representative learns that the prospect�s business has a total of 
four locations, and that sales and service are billed through the main office, although each location 
receives a billing statement.

After the sales representative meets with the prospect, he creates the account structure for his 
business.

Creating Accounts in Sales Handheld
When you identify a possible lead, the lead can be added as an account. You can then begin to add 
and track information about the account.

To create an account

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 Tap the New Record button.

3 In the Name field tap the ellipsis (...), enter a name for the account, and then select More Info.

4 In the More Info view, complete the necessary fields.

To add account addresses

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 Select the account record, and from the Show drop-down list, choose Addresses.

3 In the Account Addresses view, tap the Addresses list to select it, and then tap the New Record 
button.

4 Complete the fields for the address, and tap the Primary field to display a check mark if this is 
the primary address for the account.

To add additional account information

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 From the Show drop-down list, select More Info.
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3 Complete the fields to add additional information.

The following table describes some fields in the More Info form. The name and address fields are 
automatically populated with information entered at the My Accounts and Addresses views.

The My Accounts list appears.

Associating Activities with Accounts in Sales Handheld
An activity is a task or event that is generally, but not always, performed for a contact, account, or 
opportunity. You will likely have many meetings, calls, presentations, and other activities 
surrounding an account. 

Activities provide a place to enter and track this information. If the activity entered has a time 
associated with it, it will appear on the Activities and Calendar screens.

To associate activities with accounts

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 In the My Accounts list, select the account with which the activity will be associated.

3 From the Show drop-down list, select Activities.

Fields Comments

Parent Account Select the parent account from the Pick Account picklist.

Account Type Pick the Account Type from the list. Examples are Fulfillment 
Shipper, Commercial, Competitor.

Account Team Displays the primary Account Team member with which the 
account is associated. To associate the account with one or more 
team members, navigate to the Account > Account Team view.

URL Text entry. 

Industries Displays the primary industry with which the account is associated.

Price List Choose applicable price list from the Pick Price List dialog box.

Current Volume Enter amount, or tap the ellipses and enter Currency Code, 
Exchange Date and Amount in the dialog box. Then tap OK.

Potential Volume Enter amount, or tap the ellipses and enter Currency Code, 
Exchange Date and Amount in the dialog box. Then tap OK.

Status A list of values established by your company. Status examples 
might be Qualified, Silver, Active.

Currency Select the currency code from the Pick Currency Code list.
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4 In the Account Activities view, tap the Activities list to select it, and then tap the New Record 
button.

5 In the new row, complete the necessary fields.

The Type field defaults to Appointment.

6 Drill down on the default activity Type hyperlink to display the Activities screen�s More Info view.

7 In the More Info form, add and edit details about the activity. 

For more information, see �Creating Activities in Sales Handheld� on page 119.

Associating Opportunities with Accounts in Sales 
Handheld
Accounts are a source of business for your company. An opportunity is a potential revenue-
generating event and is another type of information that you can use to manage your accounts within 
Siebel Sales Handheld.

To add an opportunity to an account

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 From the Show drop-down list, select My Accounts.

3 In the My Accounts list, select the account to which the opportunity will be associated.

4 From the Show drop-down list, choose Opportunities.

The Account Opportunities view appears.

5 In the Account Opportunities view, tap the Opportunities list to select it, and then tap the New 
Record button.

6 In the Opportunities list, complete the necessary fields for the new record.

The Account field is automatically populated with the name of the selected account. Sales stage 
selections are based on the sales methods used by your organization.

Developing Opportunities in Siebel Sales 
Handheld
An opportunity is defined as a potential revenue-generating event. An opportunity is usually 
associated with an account and one or more contacts, products, activities, and quotes.

Examples of opportunities are:

■ At a trade show, a company representative expresses interest in purchasing a product.
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■ When called by a telesales representative, a contact indicates interest in contracting 
maintenance services.

■ In a conversation with an existing client, the client expresses an interest in upgrading to the 
newest product model.

The following topics related to opportunities are included in this section:

■ �Scenario for Developing Opportunities in Sales Handheld� on page 115

■ �About Creating Opportunities in Sales Handheld� on page 115

■ �About Sales Methods in Sales Handheld� on page 116

■ �Associating a Contact with an Opportunity in Sales Handheld� on page 117

■ �Associating a Product with an Opportunity in Sales Handheld� on page 117

■ �About Opportunity Quotes in Sales Handheld� on page 118

Scenario for Developing Opportunities in Sales 
Handheld
A sales representative is involved in revenue-generating and customer contact activities at her 
company. At a trade show she meets a prospective customer who could be a lead for a new business 
opportunity. Using her Siebel Sales Handheld application, the sales representative discovers that the 
company is listed in Siebel Sales as an account, but the person she met is not listed as a contact 
associated with the account.

After adding this person as a contact, the sales representative creates the opportunity. Next, the 
sales representative schedules meetings, records the associated activities, and associates other 
important contacts to the opportunity.

As the sales process continues, the sales representative gathers and updates information about the 
account, its contacts, and the opportunity. As the relationship grows, the sales representative can 
add, view, and share information and key knowledge with other members of the sales team.

About Creating Opportunities in Sales Handheld
Each time you identify an opportunity, you should create a new record.

To create an opportunity

1 Navigate to the Opportunities screen. 

The My Opportunities list appears.

2 Tap the New Record button, and enter a name in the Name field. 
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3 From the Show drop-down list, choose More Info and complete additional fields.

The following table describes some fields in the Opportunities - More Info form.

About Sales Methods in Sales Handheld
A sales method is a formalized approach or methodology used during the sales process. A sales 
method can encompass all activities associated with the sales process, from prospecting to 
forecasting to closing deals. This approach allows sales representatives to use the most appropriate 
method for opportunities. 

Field Comments

Name A required value that identifies the opportunity.

Account Allows you to associate an opportunity with an account. 

Description A text area for additional information about the opportunity.

Site A default value that populates automatically when you associate the 
opportunity to a specific account and location.

Primary Displays the primary Sales Team member for the opportunity. To 
associate the opportunity with one or more team members, navigate to 
the Opportunity > Sales Team view (if configured). 

Rev: Revenue. Allows you to enter the currency amount of the opportunity. 
This field defaults to zero.

Probability % Allows you to enter the percentage of confidence you have that the deal 
will close with the specified revenue on the specified close date. 
Probability automatically updates based on the Sales Method and Sales 
Stage selected.

Expected Value Displays a currency value that is calculated based on the potential 
revenue field multiplied by the value in the probability field. A lower 
percent in the probability field reduces the expected value that will be 
included in your revenue forecast.

Close Date A required field that allows you to enter the expected date on which the 
opportunity will close. The default date is the same as the Created Date. 
It is important to modify the date, if the opportunity will close on a 
different date, since this date is used in revenue forecasting.

Lead Quality A list of values established by your company that allows you to rank the 
quality of the lead. Default values include 1-Excellent, 2-Very High, 3-
High, 4-Fair, 5-Poor.

Sales Method A list of values established by your company that list the sales 
methodologies. For more information, see �About Sales Methods in Sales 
Handheld� on page 116.

Sales Stage A list of values established by your company that lists the sales stages 
associated with the sales method you selected. 
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The application administrator will create and implement the sales stages your company uses, and 
then establish values in your Siebel application that represent these methods and stages. A 
recommended business practice is to designate a default sales method in your Siebel application. 
This practice allows a sales method to be associated with each opportunity and aids in charting and 
reporting accuracy.

Sales methods can differ within a company. For instance, a sales method for managing a complex 
multimillion dollar opportunity may include 15 stages, while a sales method for a simple low-dollar 
opportunity may require only four stages.

For more information about creating or implementing sales stages, see Applications Administration 
Guide.

Associating a Contact with an Opportunity in Sales 
Handheld
As you work with an opportunity, you will want to maintain information about the contacts associated 
with the opportunity. For more information about contacts, see �Adding Contacts in Sales Handheld� 
on page 110.

The Opportunities screen�s Contacts view allows you to associate and review contact-related 
information for an opportunity.

To associate a contact with an opportunity

1 Navigate to the Opportunities screen

The My Opportunities list appears.

2 In the My Opportunities list, select the opportunity with which you will associate a contact.

3 From the Show drop-down list, choose Contacts.

4 Tap the Contacts list to select it, and then tap the New Record button.

5 In the Add Contacts dialog box, select the contact or contacts you wish to add, and then tap OK.

NOTE: To select multiple records, tap the control key and select the contact records.

Associating a Product with an Opportunity in Sales 
Handheld
Specific products can be associated with an opportunity. For example, if a customer is interested in 
purchasing a new product model, this information can be entered in the Products view.

After the information is entered, you can drill down on the product to find additional information such 
as product features and prices.
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To associate a product with an opportunity

1 Navigate to the Opportunities screen.

The My Opportunities list appears.

2 In the My Opportunities list, select the opportunity with which a product will be associated.

3 From the Show drop-down list, choose Products.

4 In the Opportunity Products view, tap the Products list to select it, and then tap the New Record 
button.

5 In the new row, tap the arrow in the Products field.

6 In the Pick Product dialog box, select the product, and then tap OK.

7 Complete the remaining fields, as needed.

About Opportunity Quotes in Sales Handheld
The Opportunity Quotes view displays quotes that have been generated for a specific opportunity. 
After adding products to an opportunity in the Opportunity Products view, you can navigate to the 
Opportunity Quotes view to initiate Auto Quote functionality or to manually create a quote. For more 
information, see �Creating Quotes in Sales Handheld� on page 122.

Managing Customer Relationships in 
Siebel Sales Handheld
An organization�s records should accurately reflect the amount of work required and performed to 
maintain customer satisfaction. This practice avoids duplication of effort if a different or an additional 
team member has to get involved. It also keeps everyone up to date as to exactly what activities 
have occurred and when they have occurred.

The following topics related to Activities are included in this section:

■ �About Activities in Sales Handheld� on page 119

■ �Scenario for Managing Activities in Sales Handheld� on page 119

■ �Creating Activities in Sales Handheld� on page 119

■ �Delegating Activities in Sales Handheld� on page 119

■ �Associating Contacts with Activities in Sales Handheld� on page 120

■ �Adding General Activities Using the Calendar in Sales Handheld� on page 120
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About Activities in Sales Handheld
Activities are various tasks or events that are performed for contacts, accounts, and opportunities. 
Activities that are given start times are automatically entered on the activities screen and your 
calendar. 

Scenario for Managing Activities in Sales Handheld
While working away from his desk, a sales manager receives a call from a customer who wants to 
visit the sales manager�s company for an executive summary meeting. The customer also wants the 
sales team to perform a product demonstration. The sales manager schedules the meeting using his 
handheld. After his next synchronization, the meeting appears on calendars of his team members. 
The sales manager delegates the tasks required to prepare for the meeting, such as preparing 
presentation slides, reserving a conference room, and configuring the demo system. These activities 
appear in the sales manager�s Activities screen and calendar for the customer�s account.

As the sales manager and his team members complete the activities, the activities are marked as 
done, providing key status information about the opportunity.

Creating Activities in Sales Handheld
Throughout the day, you have new tasks to accomplish and activities to monitor. These activities are 
part of your business. By keeping track of these activity records on your handheld, you make sure 
your team members know about these tasks, and you create a valuable history of your past 
interactions with customers.

To create a new activity

1 Navigate to the Activities screen.

The My Activities list appears.

2 Tap the New Record button, and in the new row, complete the necessary fields.

A default value is provided in the activity Type field.

3 Drill down on the hyperlink value in the Type field.

4 In the More Info form, pick the appropriate activity type from the list, and complete the fields.

Delegating Activities in Sales Handheld
If you work as part of a sales team or are the manager, an important part of managing your activities 
includes managing other people�s activities. When an activity needs to be performed by someone 
else, you can reassign or delegate it to an employee.
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To delegate an activity

1 Navigate to the Activities screen.

The My Activities list appears.

2 In the My Activities list, find the activity that needs to be delegated.

3 From the Show drop-down list, select Employees.

4 In the Activity Employees view, tap the Employees list to select it, and then tap the New Record 
button.

5 In the Add Employees list, select the employees to whom the activity will be assigned.

6 To make an employee the primary for the activity, tap the Primary field to display a check mark.

Associating Contacts with Activities in Sales Handheld
When you add an activity to your calendar, you may also want to have a record of contacts who will 
be participating in the activity. 

To associate contacts with activities

1 Navigate to the Activities screen.

The My Activities list appears.

2 In the My Activities list, select the activity with which a contact will be associated.

3 From the Show drop-down list, select Contacts.

4 In the Activity Contacts view, tap the Contacts list to select it, and then tap the New Record 
button.

5 In the Add Contacts dialog box, select the contacts, and then tap OK.

Adding General Activities Using the Calendar in Sales 
Handheld
General activities and appointments must have the Planned Start and Duration fields populated in 
order to be displayed in the correct time slot on the Daily Calendar view.

To add a general activity in the Calendar view

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select Daily, Weekly, or Monthly.

3 For My Weekly or My Monthly, select the day on which you want to schedule a general activity.
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4 On the toolbar, tap the New Record button.

You may also tap an open time slot within the daily view.

5 In the new record, complete the necessary fields for the appointment or task.

Some fields are described in the following table.

To specify contact participants

1 Navigate to the Calendar screen and locate the day the task or appointment occurs.

2 Drill down on the task or appointment hyperlink to display the Calendar form.

3 From the Show drop-down list, select Contact Participants.

4 In the Calendar Contacts view, tap the Contacts list to select it, and then tap the New Record 
button. 

5 In the Add Contacts dialog box, select contacts and tap OK.

To specify employee participants

1 Navigate to the Calendar screen and locate the day the task or appointment occurs.

2 Drill down on the task or appointment hyperlink to display the Calendar form.

If the appointment or task repeats over time, you will be asked to indicate if changes to the 
appointment should be applied to the specific occurrence, or to all occurrences. From the Show 
drop-down list, select Employee Participants.

3 From the Show drop-down list, select Employee Participants.

4 In the Calendar Employees view, tap the Employees list to select it, and then tap the New Record 
button.

Field Comments

Type The type of activity. Activity types might be call, email-outbound, 
demonstration, and so on.

Planned 
Start

This date-time field defaults to the time selected when you created the new 
appointment.

Duration When the duration is updated, the planned completion time is automatically 
adjusted.

Account Complete this field if the activity is related to a particular account. 

Repeat Tap the check box to display a check mark if the appointment or task is 
recurring.

Siebel Handheld Calendar does not support modification of single instances of 
recurring activities. For example, if you delete or modify an appointment 
scheduled to recur daily for 10 days, the entire series will be deleted.

Repeat Until The end date of a repeating appointment.
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5 In the Add Employees dialog box, select employees, and then tap OK.

Developing Quotes in Siebel Sales 
Handheld
When the customer is ready to purchase a product or service, you can develop a quote using Siebel 
Sales Handheld that includes specific prices for products and services with related payment terms. 

The following topics related to quote development in Sales Handheld are included in this section:

■ �Scenario for Developing Quotes in Sales Handheld� on page 122

■ �Creating Quotes in Sales Handheld� on page 122

■ �Using Auto Quote in Sales Handheld� on page 123

■ �Adding Quote Items in Sales Handheld� on page 124

■ �Printing Quotes in Sales Handheld� on page 125

Scenario for Developing Quotes in Sales Handheld
A mobile sales representative relies on quotes to create formal offers to clients for a variety of 
products and services that her company provides. Using Siebel Sales Handheld she can produce 
accurate offers at the customer site, with up-to-date product and pricing information. When details 
and pricing are finalized, the sales representative can print the quote and deliver it promptly to the 
customer.

Creating Quotes in Sales Handheld
Quotes includes effective dates, price lists, and discounts used in pricing products and services. 
Before any of this information can be added to a quote, however, the quote must be created with 
basic information.

To create a quote

1 Navigate to the Opportunities screen.

The My Opportunities list appears.

2 In the My Opportunities list, select the opportunity for which the quote will be generated.

3 From the Show drop-down list, select Quotes.

4 In the Opportunity Quotes view, tap the Quotes list to select it, and then tap the New Record 
button.

The new quote is automatically assigned a record identifier, a revision number, the default status 
of In Progress, and a created date.
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5 In the Name field, enter a name for the quote.

When you tab to an adjacent field, the quote name becomes a hyperlink.

6 Drill down on the hyperlink in the Name field to display the More Info form where you can add 
quote details.

Using Auto Quote in Sales Handheld
If you are working with an opportunity for which the products and solutions have already been 
specified in the Opportunity Products view, there is a faster method to generate a quote. You can use 
the Auto Quote button.

When Auto Quote generates a quote from an opportunity, quote line items are created for each 
product under the opportunity that has the Auto Quote flag checked. The Quote Item fields are 
populated from the corresponding Opportunity Product's fields, as shown in Table 22.

In addition, information from the generated quote�s Quote # field is copied to the Opportunity 
Products� Quote # field. The Part Number field of the generated Quote Item is determined by the 
quote item's product. 

Table 23 shows the quote record fields that are automatically completed when Auto Quote is used to 
create a quote.

Table 22. Quote Item Fields Populated by Opportunity Product Fields

Opportunity Product Fields Quote Item Fields

Product Product

Product Quantity Extended Quantity Requested

Write-In Product (not exposed in application) Write-In Product (not exposed in application)

Expected Delivery Date Requested Delivery Date (not exposed in 
application)

ID (not exposed in application) Opportunity Product ID (not exposed in 
application)

Table 23. Quote Fields Completed with Auto Quote

Field Value

Quote # System generated

Revision 1

Name Quote number, unless the user provides another value

Opportunity The opportunity from which the quote is automatically generated
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To create a quote using Auto Quote

1 Navigate to the Opportunities screen.

The My Opportunities list appears.

2 In the My Opportunities list, select the opportunity for which the quote will be generated.

3 From the Show drop-down list, select Quotes.

4 In the Opportunity Quotes view, tap Auto Quote.

A new row appears in the Quotes list, with the Quote #, Revision, Status and Created date filled 
in.

5 Provide a quote name, edit other fields as necessary, and then drill down on the hyperlink in the 
quote Name field.

6 In the Quote detail form, enter additional information about the quote.

a Select the applicable predefined Discount that will be applied to the quote. 

b Select the applicable predefined Price List.

NOTE: Auto Quote functionality is only available in the Opportunities screen Quotes view.

Adding Quote Items in Sales Handheld
Using the Quotes screen, you can add line items to quotes that you are developing. If the Auto Quote 
method is used, products associated with opportunities appear automatically as line items with any 
applicable discounts.

Line items can be used to:

■ Add new products as line items

Account The account for the opportunity

Account Site The location of the account associated with the opportunity

Status In Progress

Active Checked

Currency The currency code for the opportunity

Price List The price list associated with the opportunity�s account

Sales Rep User ID

Effective Current date

Through Current date plus 30 days (30 days is determined by the 
QUOTE_EXPIRATION_PERIOD LOV)

Table 23. Quote Fields Completed with Auto Quote

Field Value
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■ Apply manual price adjustments to the line items using the Toggle button.

NOTE: Siebel Handheld does not support complex quotes (bundled line items). Only simple line 
items can be created.

To add line items

1 Navigate to the Opportunities screen.

The My Opportunities list appears.

2 In the My Opportunities list, select the opportunity with which the quote is associated.

3 In the Show drop-down list, select Quotes.

4 In the Opportunity Quotes view, locate the quote in the list and drill down on the Name hyperlink.

The quote detail form appears.

5 From the Show drop-down list, select Quote Items.

6 In the Quote Line Items view, tap the Line Items list, and then tap the New Record button.

7 In the Line Items list, complete the required fields.

Quote Line Item price fields are automatically populated based on the product's price in the 
parent quote's price list.

If you are entering more than one line item, repeat Step 6 and Step 7 until each line item has 
been entered. Tap the Toggle button to display a form that you can use to add Item discounts 
and other adjustments.

To delete line items

1 Navigate to the Quotes screen.

The My Quotes list appears.

2 In the My Quotes list, select the quote containing the line item that will be deleted, and choose 
Quote Items from the Show drop-down list.

3 In the Quotes Line Items view, select the quote item in the list.

4 From the Edit Menu, select Delete Record. 

NOTE: Quote revisions are not supported on the handheld.

Printing Quotes in Sales Handheld
Once the customer has expressed significant interest, it is often appropriate to present a hard copy 
quote. 
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To print a quote

1 Navigate to the Quotes screen.

The My Quotes list appears.

2 In the My Quotes list, select the quote containing the line items that will be printed.

3 From the Show drop-down list, select Quote Items.

4 Align the infrared ports on the handheld device and the printer.

5 In the parent Quotes form, tap the Print button.

Managing Orders in Siebel Sales 
Handheld
After you have completed the initial quote, and the customer has agreed to the products and prices 
you have presented, you create a sales order.

The following order management topics are included in this section:

■ �Creating Orders in Sales Handheld� on page 126

■ �Adding Order Line Items in Sales Handheld� on page 127

■ �Entering Terms and Totals in Sales Handheld� on page 127

Creating Orders in Sales Handheld
You can create orders from quotes manually or by using the Auto Order button.

To create an Auto Order from your quote

1 Navigate to the Quotes screen.

The My Quotes list appears.

2 In the My Quotes list, select the quote from which an order will be generated.

3 From the Show drop-down list, select Orders.

4 In the Quotes list, select the quote, and then in the Orders list tap AutoOrder.

A new record appears in the Orders list, with the order date, number, type, status and so on, 
filled in. 

5 In the Orders list, drill down on the Order # hyperlink.

6 Tap the Orders Line Items list to select it, and then tap the New Record button.

A new row appears in the Line Items list.
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7 Tap in the Products field.

The Pick Products dialog box appears.

8 Select the product to add as a line item, and tap OK.

To manually create an order

1 Navigate to the Orders screen.

2 The My Sales Orders list appears.

3 Tap the New Record button.

A new row appears in the Sales Orders list.

4 Complete the necessary fields for the new order record.

From the Show drop-down list, choose More Info to display a form where you can add more 
details.

Adding Order Line Items in Sales Handheld
Once the initial sales order is created, you can complete the line items that make up the order.

1 Navigate to the Orders screen.

The My Sales Orders list appears.

2 In the My Sales Orders list, select the order to which line items will be added.

3 From the Show drop-down list, select Line Items.

4 Tap the Line Items list to select it, and then tap the New Record button.

A new row appears in the Line Items list with the Line # and Status fields completed. 

5 Complete the fields for the line item.

Repeat the previous step to add additional line items.

The Totals field automatically updates with the Quantity Requested total, and the Order record 
Item Total and Total fields get updated based on the sum of the Line Item Start Price and Net 
Price fields, respectively.

Entering Terms and Totals in Sales Handheld
After completing the line items, navigate to the Order Terms view to enter shipping and payment 
information for the order.
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To add terms and totals

1 Navigate to the Orders screen.

The My Sales Orders list appears.

2 In the My Sales Orders list, select the order.

3 From the Show drop-down list, select Order Terms.

4 In the Order Terms view, tap the Terms form to select it.

5 In the Terms form, complete the necessary fields (such as Payment Terms, Ship Carrier, and so 
on).

NOTE: The basic Sales Handheld configuration does not include detailed shipping and billing 
fields. These fields are based on different business components and can be configured as 
required.

Tracking Expenses in Sales Handheld
You can track expenses and create expense reports using Siebel Sales Handheld.

The following expense management procedures are included in this section:

�Creating an Expense Report in Sales Handheld� on page 128

�Submitting an Expense Report in Sales Handheld� on page 129

Creating an Expense Report in Sales Handheld
You can create expense reports in Siebel Sales Handheld, then upload them to your server at the 
time of sync.

To create an expense report

1 Navigate to the Expenses screen.

The My Expense Reports list appears.

2 Tap the New Record button, and complete the necessary fields for the new record.

3 From the Show drop-down list, select More Info to view additional fields.

NOTE: You must complete the Submit To field or you will get an error message and your expense 
report will not be saved.

To add detailed line items

1 Navigate to the Expenses screen. 

2 In the My Expense Reports list, locate the expense report record.
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3 From the Show drop-down list, select Expense Items.

4 In the Expense Report Line Items view, tap the Line Items list, and then tap the New Record 
button. 

5 In the new row, complete the necessary fields for the line item.

You can not enter Line Items whose Start or End Date is outside of the Expense Report period. 

NOTE: Siebel Sales Handheld Expense Reports functionality does not currently support the 
Mileage expense type or detailed Hotel expense tax itemization. If these expense types are 
required, you must enter these items using the desktop Siebel Sales application.

6 Repeat the previous steps to add line items. 

The cumulative total of all expense line items is automatically displayed in the Totals field.

Submitting an Expense Report in Sales Handheld
After creating an expense report, you�ll then need to submit it for approval. 

To submit an expense report

1 Navigate to the Expenses screen.

The My Expense Reports screen appears.

2 Select the desired expense report, then tap the Status field, and select submitted from the drop-
down list. 

The next time you sync to your enterprise system, the expense report will be submitted.
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A Troubleshooting
This appendix addresses some of the common issues faced while deploying Siebel Handheld. The 
appendix presents troubleshooting tips in three areas:

■ Installation

■ Performance

■ Log Files

The audience for this appendix is Siebel database administrators, system administrators, and 
application administrators.

�Installation� on page 131

�Synchronization� on page 132

�Log Files� on page 133

�SQLTrace� on page 135

�End User Error Messages� on page 136

�Web Server Timeout Errors� on page 136

�Performance� on page 136

�Siebel Services� on page 139

Installation
Siebel Handheld supports a specific and limited set of devices, handheld OS, desktop OS, server OS, 
server databases, and languages. This range of devices and platform support varies widely across 
the range of Siebel Handheld releases and must be carefully checked to confirm support. See System 
Requirements and Supported Platforms on Siebel SupportWeb for your Siebel application for 
information on supported Handheld OS, desktop OS, server OS, and server databases.

Client Installation, Backup, and Restore
If you run into problems while installing the Siebel Handheld application on client devices from a 
desktop PC, refer to the following checklist. Most installation problems are covered by this checklist.

■ Is the device certified and supported? Refer to the system requirements and supported platforms 
documentation for the Siebel Handheld application.

■ Confirm that the device has 64 MB of RAM with the majority of it available for the Siebel Handheld 
application.
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■ Is an ActiveSync connection running (green icon)? If not, check your computer to make sure that 
the serial or USB port is activated and functioning correctly.

■ If previous versions of Siebel Handheld were installed on the device, did you uninstall the 
application? See �Uninstalling the Siebel Handheld Application� on page 89.

Siebel Handheld binaries may also be installed to a CompactFlash card to conserve (RAM) memory. 
The application will still be loaded into memory when it executes. To install on the CompactFlash 
card, set the ApplicationBinariesLocation and ApplicationDataLocation parameters in the setup.ini 
file. See �Setting up Siebel Handheld Application Installation on a CompactFlash Card� on page 72.

Siebel Handheld (application only - no data) may also be backed up to a CompactFlash card to aid 
in deployments. Using the built-in backup utility that comes with Compaq (QUtilities) and HP Jornada 
(HP Backup) devices, a backup image may be created which can then be restored onto other devices. 
The initial backup image should be made of a device that has not done an initial synchronization. An 
initial synchronization will still be required by each user to receive the configuration and data.

It is also possible to back up Siebel Handheld on a PC using the Backup/Restore feature within 
ActiveSync.

Synchronization
Synchronization problems can be caused by incorrect settings in the Siebel Handheld setup.ini or .cfg 
files. Be sure that application names, data sources, and SRFs are correct.

Make sure to set the URL setting (DSSURL) in the client setup.ini for direct server synchronization 
installations. Be sure to list the views (DefaultViews) in the application .cfg file. Also, do not forget 
to grant the user visibility to these views in the Application Administration > Responsibilities view.

NOTE: Check the log files and confirm the accuracy of the generated connect string.

Companion Sync Checklist
Use the following checklist to troubleshoot problems you encounter using Companion Sync.

■ Is the latest version of ActiveSync (v.3.5 or later) installed and running?

■ Is ActiveSync connected (green icon)?

■ Do you have the correct data source defined in the handheld .cfg file?

■ If you have problems logging in, check to make sure that you can use the same credentials to 
log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in to sync each 
device. Failure to do so causes data corruption.

Direct Server Sync Checklist
Use the following checklist to troubleshoot problems you encounter using Direct Server Sync.
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■ Did you install all client and server components successfully?

■ Is there a PDA OM running on the Siebel Server?

■ Did you bounce the IIS, SWE, and Siebel Server after installation?

■ Do you have network access to the URL for DSS? Can you ping the IIS server from inside and, if 
applicable, from outside the firewall?

■ Can you successfully run a SWE command?

■ Do you have the correct DSS URL defined in the setup.ini file?

■ Is the network connection working from the device? Try Pocket Internet Explorer.

■ If you have problems logging in, check to make sure that you can use the same credentials to 
log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in to sync each 
device. Failure to do so causes data corruption.

Re-synchronizing Problems
Generally if, for whatever reason, synchronization is terminated, the end user is prompted with a 
message and the synchronization process ends. In this situation the synchronization session is 
allowed to close. However, if the connection with the server is unintentionally broken, the session 
may not have a chance to close before the connection is broken. Therefore, if the end user tries to 
immediately synchronize again, he may get an error message and may not be able to synchronize. 
Should this occur, the end user should wait for a period of time (generally, 15 minutes) to allow the 
session to time out and terminate. Once the session terminates, the end user should be able to 
synchronize again.

Log Files
This section discusses issues related to log files.

Direct Server Sync Log Files
To assist Siebel Technical Support, collect the following files when logging a Siebel Handheld service 
request. The following files are found on the machine where Siebel Server is installed:

■ All server sync user files in the Siebel Root\siebsrvr\hhsync\application directory\user id\node id 
directory.

■ Server NT application event log extract.

■ Server NT system event log extract.
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■ All files in the Siebel Root\siebsrvr\log directory including CompName_task.log.

where CompName is the name of an application server component, and task is a Siebel task 
number.  Each sync session is assigned a new Siebel task, so there will be many of these.  An 
example "CompName" value is "SalesCE_enu" (note that language is part of the component 
name itself). 

■ All files from all subdirectories under the Siebel Root\siebsrvr\logarchive directory.

■ Server perfmon log files (showing memory, network, disk performance), if available.

The following files are found on the machine where the Web Server (that is, IIS) is installed:

■ SWE log files from Siebel Root\eappweb\log (all files).

■ IIS server NT application event log extract.

■ IIS server system event log extract.

■ IIS server perfmon log files (showing memory, network, disk performance), if available.

Companion Sync Log Files
To assist Siebel Technical Support, collect the following log files when logging a Siebel Handheld 
service request. The following files are found on the companion PC where Siebel Mobile Web Client 
is installed:

■ Client Siebel Handheld Sync log file: \log\syncmanager_log.txt.

■ All files in the Siebel Root\client\hhsync\application directory\user id\node id directory.

■ NT application event log extract.

■ NT system event log extract.

■ All files in the Siebel Root\client\log directory.

■ Perfmon log files (showing memory, network, disk performance), if available.

Handheld Device Logs
The following log files are found in the /Program Files/Siebel Handheld directory on the handheld 
device:

■ dbimport_log.txt�This file is a log of the database objects that were imported during 
synchronization. The file is located in the \Program Files\Siebel Handheld directory on the 
handheld client.

■ sql_stmt_log.txt�This file logs all SQL statements generated by the application. You must set 
a parameter in the setup.ini file to turn this log on. The log file is located in the \Program 
Files\Siebel Handheld directory on the handheld client. See �Deployment of Siebel Handheld� on 
page 61 for more information about setting the parameter.
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■ ssa_errors_log.txt�This file is a log of all system error messages. You must set a parameter 
in the setup.ini file to turn this log on. The log file is located in the \Program Files\Siebel Handheld 
directory on the handheld client. See �Deployment of Siebel Handheld� on page 61 for more 
information about setting the parameter.

■ syncmanager_log.txt�This file contains all of the messages displayed on the Sync Manager 
dialog box as well as some basic information about synchronization, such as data source and 
connect string. You can set the logging level for this file using the SyncLogReportingLevel 
parameter in the setup.ini file.

For Direct Server Sync deployments, the file is located in the \Program Files\Siebel Handheld 
directory on the handheld client. For Companion Sync deployments, the file is located in the 
Siebel Root\client\log on the companion PC.

Logging Handheld Synchronization Errors

Siebel Handheld Sync logs all the strings that the user sees in the sync message window as well as 
many informational messages that do not get displayed in the UI. These informational messages are 
used to help track down where an error occurred. Siebel Handheld Sync determines which messages 
get logged based on a value stored in the registry under the key SyncLogReportingLevel. The values 
range from 0 to 4; 0 logs all error messages and strings that the user sees, and 4 logs all data that 
Siebel Handheld Sync sends and receives.

If Siebel Handheld Sync fails for some reason, check the syncmanager_log.txt file immediately after 
the failure. If you need more detail, increase the logging level and run Siebel Handheld Sync again. 
Use the LoggingLevels parameter in the setup.ini file to change the logging level. Furthermore, each 
time a user synchronizes, the syncmanager_log.txt file is overwritten with the new data.

SQLTrace
Use SQLTrace for diagnostic purposes if you encounter serious configuration errors or performance 
problems and cannot otherwise diagnose the problem. The problem may quickly become apparent 
in the log entries from SQL tracing.

To enable SQL tracing

1 Log into srvrmgr from a  (m:\siebel\bin\w32ud) prompt. 

2 Run: change evtloglvl ObjMgrSqlLog=4 for comp [OMName], where [OMName] = the OM name 
(for example, <ApplicationName>CEObjMgr_enu). 

3 Log enties are written to <OMName>ObjMgr_enu as described in �Log Files� on page 133.

NOTE: SQL tracing only logs SQL statements for one user at time. SqlTrace is applied to the first 
user who synchronizes after tracing is enabled.

CAUTION: When SQL tracing is enabled, synchronization is severely and adversely affected. 
Therefore, it is recommended that you turn SQL tracing on for a limited time to diagnose a 
specific problem, then turn SQL tracing off.
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End User Error Messages
End users may encounter error messages when they synchronize their data. For more information 
on these messages, see �Synchronization Troubleshooting with the Siebel Handheld Client� on 
page 105.

Web Server Timeout Errors
If synchronization times are long due to the size of the database file or the speed of the network 
connection, your end users may encounter Web server timeout errors and synchronization failures. 
First try to resolve this problem by reducing the size of your extract and configuring your server 
performance. If after doing this, your end users continue to experience timeout errors, then increase 
the timeout parameter on IIS for the default Web Server.

Follow the procedure for your platform to change the timeout parameter.

To change the timeout parameter on Windows 2000 

1 From the Start menu, select Programs > Administrative Tools > Internet Services Manager.

2 From the Internet Information Services window, select the local machine, right-click on the 
Default Web Site, and select Properties from the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and increase the 
number of seconds.

5 Click OK.

To change the timeout parameter on Windows NT

1 From the Start menu, select Programs > Windows NT 4.0 Option Pack > Microsoft Personal Web 
Server >Internet Service Manager. 

2 Under Internet Information Server, right-click on the Default Web Site and select Properties from 
the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and increase the 
number of seconds.

5 Click OK.

Performance
This section discusses ways you can optimize your client performance, server performance, and 
network performance.
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Client Performance
Client performance is affected primarily by the device capability (minimum 206 MHz processor and 
64 MB RAM), configuration, and the quantity of data loaded onto the device. In general, screen-to-
screen and view-to-view navigation times of 3 to 4 seconds or less should be considered normal. 

It is strongly recommended that customers follow these general guidelines to optimize the 
performance of their handheld applications:

■ Keep configuration under 30 views.

■ Keep RML file size under 1.75 MB.

■ Keep database files (dbfile.txt) under 2 MB. 

Use filters as outlined in the Siebel 2000 Handheld Synchronization Technical Note.

■ Keep the number of records for each business component under 2,500.

■ Avoid installing other applications on the device at the same time.

■ Users should synchronize their data frequently.

Additional configuration information can be found in the Siebel Technical Note 405, Siebel Handheld 
Synchronization.

The Professional Services Mobile eBusiness Competency group has a Siebel Handheld Quickstart 
program that is mandatory for all new Siebel Handheld customers to assess their configuration and 
deployment.

The Siebel Handheld client will benefit from periodic closing and restarting the application to release 
memory consumed by the handheld operating system. Use File > Exit in the menu to exit from the 
Siebel Handheld application.

If an external VGA driver is or has been loaded on the device in the past and is no longer needed, 
be sure to unload it, because it is known to have significant performance impacts on handheld 
devices.

Server Performance
Server performance affects the performance and scalability of Direct Server Sync processes. 
Customers should engage Expert Services to do a Scalability Review. The following guidelines are 
general in nature and pertain to the Siebel Handheld sync components running on a Siebel Server:

■ Use Performance Monitor to track memory and processor performance on the Siebel server.

■ Make sure that the Servers (IIS, GW, OM and DB) are on the same high speed LAN segment.

■ Siebel Handheld Sync components will stress Siebel Server and database performance because 
of the intensive interactions during large concurrent synchronizations.

■ Estimate that 64 MB is used per Siebmtsh.exe instance.

■ To calculate the theoretical maximum concurrent users:

■ Numusers=Server_Memory*threads_per_process_ratio/64 MB.
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■ Optimize the Threads per Process Ratio (Max Tasks/Max MT Servers) per Technical Note 405, 
Siebel Handheld Synchronization. 

■ Set Max Tasks=Max. number of concurrent users (for example, 150).

■ Set MinMTServers=MaxMTServers (for example, 30 for 5:1 ratio, if this is determined to be 
appropriate).

To optimize and tune a Siebel DB server:

■ Use Performance Monitor to track memory and processor performance on the DB server.

■ Turn on SQL tracing and search for long-running SQL calls.

■ Estimate 64 MB of RAM for each concurrent user.

■ Consider creating indexes to tune the queries (only performed with the assistance of Siebel 
Expert Services).

■ Consider using a RAID 0+1 disk array with an expanded number of spindles to optimize database 
performance.

NOTE: Make sure that DB Server settings are set to recommended values. Timeouts should be set 
at the Siebel Server. Be careful that the timeout is set longer than the longest SQL query.

Network Performance
The condition of the network affects Direct Server Sync performance and scalability. In general, a 
low-latency, high-bandwidth network is preferred with dedicated rather than shared network 
connections. The following are general network considerations:

■ Make sure there is adequate bandwidth throughout the entire round-trip of network packets and 
estimate where bottlenecks will occur due to high concurrent load. For example, if 50 users are 
concurrently synchronizing 1 MB each, 50 MB of data must pass through the network. If this data 
is passing through a single leased 56 KB per second line, then this data will minimally take 
500,000 KB/56 KB/sec=8928 seconds=148 minutes. In reality, a 56 KB per second line will offer 
only 30-40 KB per second average throughput, which causes further bandwidth constraints. 
Check the total available bandwidth of network providers (private or public ISP).

■ Verify that you have low latency lines with ping round trips of less than 1 second (1000 ms) with 
no dropped packets.

■ Verify if roundtrips occur with less than 10 hops.

■ Check the actual throughput of network connections by performing simple file transfers with no 
Siebel software.

■ Nonvalidated VPN software from third parties accounts for 30 to 60 percent of additional packet 
overhead because of the encryption.

Network problems can usually be resolved by working with network providers to size network 
connections and optimize network routing. Consider the use of burst networks, quality of service 
contracts, private networks, and dedicated modem banks directly into a high-speed LAN 
environment. Noisy phone lines in some countries may benefit from the use of an external modem 
card from Xircom or Pretec instead of the built-in modem on the HP Jornada 720.
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Siebel Services
You may wish to consult experts who have experience designing and configuring handheld 
applications, and who are knowledgeable about optimizing the performance of the applications.

Siebel Professional Services
To make deployment planning and implementation successful, Siebel Handheld customers are 
encouraged to engage the Siebel Mobile eBusiness Competency group. The Siebel Professional 
Services team has developed a Siebel Handheld Quickstart solution which defines the strategy, 
approach, and roadmap for successful Siebel Handheld deployments. Working directly with 
experienced handheld experts from the Mobile eBusiness Competency, customers can develop a 
complete deployment strategy, approach, and roadmap to facilitate their handheld implementation 
in a short time period.

Siebel Expert Services
All Siebel Systems customers should work with Siebel Expert Services to conduct detailed 
configuration and hardware sizing reviews. This helps customers make sure they have implemented 
the most effective and efficient solutions possible. Siebel Handheld customers benefit by making sure 
Siebel Handheld applications are configured according to best practices and that server environments 
are properly designed.
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B Screens and Views
Siebel Handheld Client supports a subset of the screens and views supported by the Siebel Web Client 
application. Other screens and views can be configured for your Siebel Handheld Client application 
if they are based on currently supported classes. Application developers and application 
administrators will find the information in this appendix useful.

If you configure screens and views based on unsupported classes, you may see anomalous results. 
For information on how to determine the classes used by other screens and views, see Object Types 
Reference.

Screens and Views
The screens and views shipped with the Siebel Sales Handheld sample application are shown in 
Table 24.

Table 24. Siebel Sales Handheld Screens and Views

Screen View Name on UI View Name in Siebel Tools (salesce.cfg)

Contacts My Contacts SHCE Sales Visible Contact List View

More Info SHCE Sales Contact Details View

Personal Contacts SHCE Sales Personal Contact List View

Opportunities SHCE Sales Contact Detail - Opportunities View

Accounts My Accounts SHCE Sales Account List View

My Team�s Accounts SHCE Sales Manager�s Account List View

More Info SHCE Sales Account Detail View

Activities SHCE Sales Account Detail - Activities View

Contacts SHCE Sales Account Detail - Contacts View

Addresses SHCE Sales Account Detail - Business Address 
View

Opportunities SHCE Sales Account Detail - Opportunities View

Opportunities My Opportunities SHCE Sales Opportunity List View

My Team�s Opportunities SHCE Sales Manager�s Opportunity List View

More Info SHCE Sales Opportunity Detail View

Activities SHCE Sales Opportunity Detail - Activities View
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Contacts SHCE Sales Opportunity Detail - Contacts View

Quotes SHCE Sales Opportunity Quote View

Products SHCE Sales Opportunity Detail - Products View

Employees All Employees SHCE Sales Employee List ReadOnly View

Employees - More Info SHCE Sales Employee Detail View

Calendar Daily SHCE Sales Calendar Daily View - My

Weekly SHCE Sales Calendar Weekly View - My

Monthly SHCE Sales Calendar Monthly View - My

Employee Participants SHCE Sales Calendar Employee Participants View

Contact Participants SHCE Sales Calendar Contact Participants View

Note: This view does not 
have a view name in the UI. 
It is a drill�down view.

SHCE Sales Calendar Add/Modify View

Activities My Activities SHCE Sales Activity List View

More Info SHCE Sales Activity Detail View

Contacts SHCE Sales Activity Contact Participants View

Employees SHCE Sales Activity Employee Participants View

Expense Reports My Expense Reports SHCE Sales Expense List View

More Info SHCE Sales Expense List Detail View

Expense Items SHCE Sales Expense Item List View

Quotes My Quotes SHCE Sales Quote List View

More Info SHCE Sales Quote List Detail View

Quote Items SHCE Sales Quote Detail View

Orders SHCE Sales Quote Orders View

Orders My Sales Orders SHCE Sales Order Entry - My Orders View (Sales)

More Info SHCE Sales Order Entry - Detail Orders View 
(Sales)

Line Items SHCE Sales Order Entry - Line Items View (Sales)

Order Terms SHCE Sales Order Entry - Order Terms View 
(Sales)

Table 24. Siebel Sales Handheld Screens and Views

Screen View Name on UI View Name in Siebel Tools (salesce.cfg)
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Products All Products SHCE Sales Product List View

More Info SHCE Sales Product Detail View

Pricing Price Lists SHCE Sales Price List View

More Info SHCE Sales Price List Detail View

Line Items SHCE Sales Price List Line Item View

Table 24. Siebel Sales Handheld Screens and Views

Screen View Name on UI View Name in Siebel Tools (salesce.cfg)
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C Business Components and 
Classes
Siebel Handheld Client supports a subset of the business components and classes supported by the 
Siebel Web Client application. This appendix lists the supported business components, business 
component classes, and applet classes.

�Supported Business Components for Siebel Handheld� on page 145

�Business Component Classes� on page 146

�Applet Classes� on page 147

Supported Business Components for 
Siebel Handheld
Table 25 lists the supported Business Components for Siebel Sales Handheld.

Table 25. Siebel Sales Handheld Business Components

Supported Business Components

Account

Action

Business Address

Contact

Contact (All)

Contact (Personal)

Employee

Employee (MM)

Expense

Expense Item

Internal Product

Opportunity

Opportunity Product

Order Entry - Line Items

Order Entry - Orders
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Business Component Classes
Table 26 lists the supported Business Component classes for Siebel Sales Handheld.

Price List

Quote

Quote Item

Table 26. Siebel Sales Handheld Business Component Classes

Supported Business Component 
Classes

CSSBCActivity

CSSBCBase

CSSBCBCExpitm

CSSBCExprpt

CSSBCLineItem

CSSBCOppty

CSSBCOrder

CSSBCPriceList

CSSBCProdBuyNow

CSSBCProdRev

CSSBCQuote

CSSBCQuoteItem

CSSBCUser

Table 25. Siebel Sales Handheld Business Components

Supported Business Components
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Applet Classes
You may create additional screens and views for your handheld application. Any new screens and 
views must be based on classes and Business Components that are supported for the Sales Handheld 
application. Refer to Table 27 for the supported applet classes.

Configuring Siebel eBusiness Applications

Table 27. Siebel Sales Handheld Applet Classes 

Supported Applet Classes

CSSFrame

CSSFrameAlarmList

CSSFrameBase

CSSFrameCECalAddModify

CSSFrameCEGridDay

CSSFrameCEGridMonth

CSSFrameCEGridWeek

CSSFrameCEHome

CSSFrameCEMultPart

CSSFrameList

CSSFrameListBase

CSSFrameListExpitm

CSSFrameListQuote

CSSFrameListQuoteItem

CSSFrameQuote
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D User Properties and Methods
This appendix documents the handheld-specific user properties and methods for the Siebel Handheld 
application.

User Properties

Global User Properties
The following user properties apply to all business components.

Table 28. User Properties

Name Comments

HandheldSyncPickMode User property on a field of a business component. When set to 
NoFail, turns Extended Pick processing ON. See �Extended Pick 
Processing in Siebel Handheld� on page 79 for more information.

HandheldSyncInsertMode User property on a business component. When set to FailOnError, 
enables Extended Insert processing. See �Extended Insert Processing 
in Siebel Handheld� on page 82 for more information.

OverridePopupVisibility Overrides Popup Visibility Type on a business component. Use 
OverridePopupVisibility to change the visibility on a picklist without 
changing the Popup Visibility Type. See �Overriding the Popup 
Visibility� on page 60 for more information.

View Used with the GotoView method. Specifies the view to be displayed 
when navigating from one view to another. See �Applet Focus 
Behavior� on page 23 for more information.

Table 29. User Properties

Name Description

HandheldSyncPickMode User property on a field of a business component. When set to 
NoFail, turns Extended Pick processing ON. See �Extended Pick 
Processing in Siebel Handheld� on page 79 for more information.

HandheldSyncInsertMode User property on a business component. When set to FailOnError, 
enables Extended Insert processing. See �Extended Insert 
Processing in Siebel Handheld� on page 82 for more information.
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Methods
The following details methods you can use for your Siebel Handheld application.

AutoQuote
The AutoQuote method generates a quote from an opportunity. The opportunity may contain one or 
more products. A quote item is generated for each product in the opportunity that has the AutoQuote 
field flag selected.

When the AutoQuote method is executed, the quote business component fields are populated with 
the values shown in Table 30.

Table 30. AutoQuote Method

Field Value

Quote Number This field is assigned a system-generated 
value

Revision 1

Name Quote Number 
(or user-provided name)

Opportunity Opportunity from which AutoQuote was called

Account Opportunity�s account

Account Location Opportunity�s account location

Status In Progress

Active Flag is set to on

Currency Opportunity�s currency code

Price List Opportunity�s price list

Sales Rep User�s login 

Start Date Today�s date

End Date Today�s date + 30 days
(30 days is determined by the 
QUOTE_EXPIRATION_PERIOD LOV)
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The Quote Item business component fields are populated from the corresponding Opportunity 
Product�s business component fields as shown in Table 31:

Fields that are noted as �Not exposed� do not appear in the user interface.

In addition, the Quote Number field in the generated quote is copied back to the Opportunity Product 
view (Table 32).

AutoOrder
The AutoOrder method generates an order from a quote. AutoOrder creates a corresponding line item 
for each quote item in the quote. The Order Entry Line Items business component fields are 
populated with the corresponding Quote Item business component fields as shown in Table 33.

Table 31. Population of Fields in Quote Item View

Source Field Destination Field

From Opportunity Product View Quote Item View

Product Product

Product Quantity Extended Quantity Requested

Write-In Product (Not exposed) Write-In Product (Not exposed)

Expected Delivery Date Requested Delivery Date (Not exposed)

ID (Not exposed) Opportunity Product ID (Not exposed)

Table 32. Population of Fields in Opportunity Product View

Source Field Destination Field

From Quote View To Opportunity Product View

Quote Number Quote Number (Not exposed)

Table 33. Population of Fields in Order Entry - Line Items View

Source Field Destination Field

From Quotes � Quote Items View To Order Entry - LIne Items View

Extended Quantity Requested Extended Quantity

Product Product

Discount Amount (Not exposed) Discount Amount (Not exposed)

Discount Percent Discount Percent (Not exposed)
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If the quote item�s product is a service product, then the following fields are also copied from the 
Quotes � Quote Items view to the Order Entry - Line Items view (Table 34).

When AutoOrder is executed, the quote�s Status field is updated to �Order Placed.�

When AutoOrder is executed, the following fields in the Order Entry - Orders business component 
are pre-populated (automatically populated?) as shown in Table 35.

Description (Not exposed) Description (Not exposed)

Requested Delivery Date (Not exposed) Due Date (Not exposed)

Unit Price (Not exposed) Unit Price (Not exposed)

Volume Discount Id (Not exposed) Volume Discount Id (Not exposed)

Volume Discount Item Id (Not exposed) Volume Discount Item Id (Not exposed)

Base Price Base Price 

Adjusted List Price Adjusted List Price

Covered Product Id (Not exposed) Covered Product Id (Not exposed)

Table 34. Copied Fields for Service Products

Source Field Destination Field

From Quote � Quote Items View To Order Entry - Line Items View

Covered Quote Item Id (Not exposed) Covered Quote Item Id (Not exposed)

Service Price Amount (Not exposed) Service Price Amount (Not exposed)

Service Price Percent (Not exposed) Service Price Percent (Not exposed)

Service Price Method (Not exposed) Service Price Method (Not exposed)

Table 35. Pre-populated Fields in Order Entry - Orders Business Component

Order Entry - Order Business 
Component Field Value

Order Number System-generated value

Account Quote�s Account

Account Location Quote�s Account Location

Contact Last Name Quote�s Contact Last Name

Table 33. Population of Fields in Order Entry - Line Items View

Source Field Destination Field

From Quotes � Quote Items View To Order Entry - LIne Items View
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Contact First Name Quote�s Contact First Name

Order Priority Medium

Status Pending

Order Type Sales Order

Active Set to Active (Turned on? Flag is set to on?)

Order Date Today�s date

Discount Quote�s Discount

Price List Quote�s Price List

Currency Code Quote�s Currency Code

Requested Ship Date Quote�s Requested Ship Date (Not exposed)

Created Today�s date

Created By Name User�s login ID

Discount Amount (Not exposed) Quote�s Discount Amount (Not exposed)

Primary Organization Id (Not 
exposed)

Quote�s Primary Organization Id (Not exposed)

Table 35. Pre-populated Fields in Order Entry - Orders Business Component

Order Entry - Order Business 
Component Field Value
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E Print Tagging Language
This chapter describes the print tagging language that is used to create print templates for your 
handheld device.

The audience for this appendix is Siebel application developers.

�Overview of Siebel Handheld Print Tagging Language� on page 155

�Using Variables in Print Templates� on page 171

�Using Variables in Print Templates� on page 171

Overview of Siebel Handheld Print 
Tagging Language
You can create the print template file in any text editor.

■ Tags are enclosed in angle brackets and identified with the keyword TAG, followed by a colon.

For example: <TAG: ....>

■ Parameters are specified with a keyword, followed by an equals sign. Arguments are in 
uppercase, surrounded by quotation marks.

For example, Font = "FONT FACE"

■ Values are in uppercase and lowercase, surrounded by quotation marks. 

For example: Font = "Helvetica"

■ Tags may appear in any order in the file. The only required tag is the Title tag.

■ Variables within a print template must be uniquely named. Variable names must be one-word 
strings and spaces are not allowed.

The following tags are used to specify the format of the print output, which applets are included, and 
the query that is executed:

■ Applet�Specifies which applets are used in the document.

■ Comment�Adds comments that do not appear in the final document.

■ Divider�Adds visual lines to visually separate different parts of the document.

■ Footer�Adds information such as page numbers, date, and time.

■ Format�Specifies characteristics such as font, boldface, italics, and underline.

■ Header�Adds information such as page numbers, date, and time.
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■ Page Break�Specifies a break in the text, forcing the text that follows to appear on the next 
page.

■ Picture�Adds graphic images to the document.

■ Title�Specifies a name for the template that appears in the print job list.

In addition, you may add static text in the print template.

The following print tags allow you to calculate additional information and add it to your reports:

■ GetTotal�Calculates the total for a column of data.

■ GetField�Gets the value of a field.

■ GetCount�Calculates the number of records.

You can also calculate dates and times using the GetDate and GetTime tags, and you can retrieve 
the value of the registry using GetRegistry.

All of this information is stored in variables that you specify. In addition, you can assign any value 
to a variable using the SetVariable tag. You can present this information in your report using the Cell 
and EndofLine tags to create tables of information. See �Using Variables in Print Templates� on 
page 171 for an example of how variables can be used to present information in print templates.

Applet

Description
Specifies the applet to be printed.

Usage
Any data that appears in your document must be generated from the applets in the view. Therefore, 
you must create applets that will produce the data required for your document.

Use the Applet tag to specify any number of list or form applets within the template and to locate 
the applet in your document. In the form view, a maximum of two fields per row are supported.

Syntax
<TAG:Applet Name="APPLET NAME" Query="QUERY STRING" Caption="CAPTION" 
Headerdivider="HEADERDIVIDER" Recorddivider="RECORDDIVIDER" Wrap="WRAP">

Parameter Description

TAG:Applet (Required) Applet tag indicator.

APPLET NAME (Required) Applet name as defined in Siebel Tools.
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Example
<TAG:Applet Name="Order List" Headerdivider="TRUE">

Cell

Description
Prints the string stored in STRING or VARIABLE NAME at the specified location on the current line.

Usage
Use the Cell tag to create cells of data in a row in a table. Use it with the EndOfLine tag. If the data 
exceeds the width of the cell specified by Startat and Endat, it wraps to the next line.

QUERY STRING (Optional) Specifies the query string directly set to the business component 
supporting the document.

If the query string is not specified, the currently active query string in the view 
is applied to expose the relevant records.

CAPTION (Optional) Specifies whether the captions in the form applets are suppressed.

Valid values are TRUE (default) and FALSE. This parameter does not apply to 
list applets. Column headings in list applets are always enabled.

HEADERDIVIDER (Optional) Specifies whether a divider is printed below the column heading in 
list applets.

Valid values are TRUE and FALSE (default). This parameter does not apply to 
form applets.

RECORDDIVIDER (Optional) Specifies whether a horizontal divider is printed between records in 
list applets.

Valid values are TRUE and FALSE (default). This parameter does not apply to 
form applets.

WRAP (Optional) Specifies whether text field values are word wrapped. 

Valid values are TRUE and FALSE (default). This parameter does not apply to 
numeric fields.

Parameter Description
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Syntax
<TAG:Cell Startat="START" Endat="END" Name="STRING" Variable="VARIABLE NAME" 
Align=ALIGNMENT"

Example
<TAG:Divider Weight="3" Startat="20" Endat="80">
<TAG:Cell Startat="0" Endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Defective:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Defective Count:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveCount" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Good Count:" Align="RIGHT">

Parameter Description

TAG:Cell (Required) Required tag indicator.

START (Required) Specifies the starting point of the cell, expressed as a percentage 
of the printable page width. For example, if 
START =10, then the cell starts at the point that is 10% from the left edge 
of the printable width.

END (Required) Specifies the end point of the cell, expressed as a percentage of 
the printable page width. For example, if END=50, then the cell ends at the 
point that is 50% from the left edge of the printable width.

STRING (Optional) String value. If Variable is not specified, then String is a required 
parameter. 

VARIABLE NAME (Optional) Name of variable where the value is stored. If String is not 
specified, then Variable is a required parameter.

ALIGNMENT (Optional) Specifies the alignment of the string.

Valid values are LEFT (default), CENTER, and RIGHT.
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<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodCount" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv3reg">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv5str">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="30" Variable="vvv4date">
<TAG:Cell Startat="30" Endat="70" Variable="vvv4longdate">
<TAG:Cell Startat="70" Endat="100" Variable="vvv8time">
<TAG:EndOfLine>

Comment

Description
Adds code comments to the print template.

Usage
Use to add explanatory notes or documentation to explain and maintain the print template. Comment 
tags are ignored during printing and do not appear in the printed document.

Syntax
<REM: COMMENT>

Example
<REM: Quotation Print Template. This template includes four applets.>

Divider

Description
Renders a horizontal line across the width of the page.

Parameter Description

REM (Required) Comment tag indicator.

COMMENT (Optional) Comment text.
Siebel Medical Handheld Guide Version 7.7 ■ 159



Print Tagging Language ■ Overview of Siebel Handheld Print Tagging Language
Usage
Use to visually separate the different sections of your document. The Divider tag can be used 
between other tags; therefore, you may add a line between two applets. However, you cannot embed 
a Divider within an applet.

Syntax
<TAG:Divider Weight="WEIGHT" Startat="START" Endat="END">\

Example
<TAG:Divider Weight="2" Startat="20" Endat="80">

EndOfLine

Description
Specifies the end of a row and advances to the next line.

Usage
Use to create rows of data in a table. Used with the Cell tag.

Syntax
<TAG:EndOfLine>

Example
<TAG:Cell Startat="0" Endat="50" Name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>

Parameter Description

TAG:Divider (Required) Divider tag indicator.

WEIGHT (Optional) Specifies line thickness.

Valid values are 1�5. The default value is 1, which produces a line 0.2 mm 
wide. Increasing the value by 1 increases the width by 0.2 mm. A 5 produces 
a line that is 1 mm wide.

START (Optional) Percentage that specifies the starting point of the line. The default 
is 0%, the farthest left point.

END (Optional) Percentage that specifies the end point of the line. The default is 
100%, the farthest right point.
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Footer

Description
Adds footer information such as page numbers, the current date, and the current time.

Usage
You may, for example, always want the text �Thank you for your business!� to appear on the bottom 
of your receipts. If so, you may include this text in a Footer tag.

The Footer tag may be specified anywhere in the template file; however, it will always appear at the 
very bottom of your document. Only one Footer tag is applied to the document. If you have multiple 
Footer tags in the file, only the last Footer tag is used; any other Footer tags are ignored.

If you include a Footer tag in your template, then you must set the BottomMargin in setup.ini to a 
minimum of 20.

The footer has three sections, Left, Center, and Right, which are used to position the information in 
the footer.

The text in the footer is formatted in 10 point, Helvetica font. If Helvetica is not available on your 
system, the default font is used. You cannot customize text formatting of the Footer tag. The Format 
tag does not affect the formatting of the footer.

Syntax
<TAG:Footer Left="DATA" Center="DATA" Right="DATA">

Example
<TAG:Footer Left="<date>" Right="<page>"

Parameter Description

TAG:Footer (Required) Footer tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing
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Format

Description
Specifies the characteristics of the text�the typeface or font, whether the text is in boldface, italics, 
or underlined, and the text alignment.

Usage
The font specification specifies the characteristics of all text that follows the tag until the next Format 
tag.

The text alignment tag (Align) behaves somewhat differently. When the applet is rendered, the field 
alignment specification takes precedence over the Align parameter.

Syntax
<TAG:Format Face="FONT FACE" Size="FONT SIZE" Bold="BOLD" Italic="ITALIC" 
Underline="UNDERLINE" Align="TEXT ALIGNMENT">

Example
<TAG:Format Face="Helvetica" Size="10">

Parameter Description

TAG:Format (Required) Format tag indicator.

FONT FACE (Required) Specifies the typeface of the text.

Any typeface installed on the handheld device may be specified. There is no 
default for this parameter.

FONT SIZE (Required) Specifies the text size.

Any installed font size for an installed typeface on the handheld device may 
be specified. There is no default for this parameter.

BOLD (Optional) Specifies whether the text is in bold.

Valid values are TRUE or FALSE (default). If TRUE, text is set to bold.

ITALIC (Optional) Specifies whether the text is in italic. 

Valid values are TRUE or FALSE (default). If TRUE, text is set to italic.

UNDERLINE (Optional) Specifies whether the text is underlined.

Valid values are TRUE or FALSE (default). If TRUE, text is set to underline.

TEXT ALIGNMENT (Optional) Specifies the text alignment.

Valid values are LEFT (default), RIGHT, and CENTER.
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GetCount

Description
Calculates the number of records in the selected rows and assigns this value to a variable.

Usage
Use GetCount to calculate the number of records and print this value in your report.

Syntax
<TAG:GetCount Appletname="APPLET NAME" Query="QUERY STRING" Variable="VARIABLE 
NAME">

Example
<TAG:GetCount Appletname="CS HH Product Bucket List Applet" Query="Status|Good" 
Variable="StatusGood">

GetDate

Description
Gets the current date, offsets the date by the number of days specified in Dayoffset, and stores the 
result in a variable.

Usage
Use GetDate to print a specific date in your report.

Parameter Description

TAG:GetCount (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

QUERY STRING (Optional) Search specification for the rows to be included in the row set. If 
not specified, the current search specification is used.

The syntax for the query string is: Field Name|Query Statement. You may 
specify one or more query strings separated by a vertical bar (|).

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.
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Syntax
<TAG:GetDate Dayoffset="NUMBER OF DAYS" Variable="VARIABLE NAME" Logformat="DATE 
FORMAT">

Example
<TAG:GetDate Longformat="TRUE" Variable="LongDate">

GetField

Description
Gets the value of the specified column of the first row of selected rows and assigns the result to a 
variable.

Usage
Use GetField to print a value without developing a print applet. Design the query and sort strings so 
that the desired record is the first record in the selected rows. GetField only allows you to get the 
value in the first record.

Syntax
<TAG:GetField AppletName="APPLET NAME" Fieldname="FIELD NAME" Query="QUERY STRING" 
Sort="SORT STRING" Variable="VARIABLE NAME">

Parameter Description

TAG:GetDate (Required) Required tag indicator.

NUMBER OF DAYS (Optional) Number of days by which the current date is offset. For example, 
�100 subtracts 100 days from the current date; 100 adds 100 days to the 
current date. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

DATE FORMAT (Optional) TRUE prints the date in long date format (for example, Monday, 
February 11, 2002). FALSE prints the short date format (for example, 2/21/
02). The default is FALSE.

Parameter Description

TAG:GetField (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

FIELD NAME (Required) Name of the field or column.

QUERY STRING (Optional) Search specification for the rows to be included in the total. If not 
specified, the current search specification is used.
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Example
<TAG:GetField AppletName="CS HH Product Bucket List Applet" Fieldname="Quantity" 
Variable="ProdBucketListField">

GetRegistry

Description
Gets a value in the registry for Siebel Handheld and assigns it to a variable.

Usage
Use GetRegistry to print the contents of the registry key in your report.

Syntax
<TAG:GetRegistry Name="REGISTRY NAME" Variable="VARIABLE NAME">

Example
<TAG:GetRegistry Name="InstallDir" Variable="Registry">

SORT STRING (Optional) Sort specification. If not specified, the current sort specification 
is used.

The syntax is: Field Name [ASC][DESC]. The default is ASC (Ascending).

For example: Sort="Account DESC, Date". In the example, the Account field 
is sorted in descending order, then the date field is sorted in ascending order.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description

TAG:GetRegistry (Required) Required tag indicator.

REGISTRY NAME (Required) Value the registry.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description
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GetTime

Description
Gets the current time, offsets the time by the number of seconds specified in Secondoffset, and 
assigns the result to a variable.

Usage
Use GetTime to print a specific time in your report.

Syntax
<TAG:GetTime Secondoffset="NUMBER OF SECONDS" Variable="VARIABLE NAME">

Example
<TAG:GetTime Secondoffset="3600" Variable="Time">

GetTotal

Description
Calculates the total for the specified column for all selected rows and assigns the value to a variable.

Usage
Use GetTotal to calculate a column total and display the total in your report.

Syntax
<TAG:GetTotal AppletName="APPLET NAME" FieldName="FIELD NAME" Query="QUERY STRING" 
Variable="VARIABLE NAME">

Parameter Description

TAG:GetTime (Required) Required tag indicator.

NUMBER OF SECONDS (Optional)Number of seconds by which the current time is offset. For 
example, �100 subtracts 100 seconds from the current time; 100 adds 
100 seconds to the current time. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description

TAG:GetTotal (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.
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Example
<TAG:GetTotal AppletName= "CS HH Product Bucket List Applet" Fieldname="Quantity" 
Variable="ProdBucketListTotal">

Header

Description
Adds header information such as page numbers, the current date, and the current time.

Usage
You may always want the current date and time to appear on your invoices. If so, you may include 
this information in a Header tag.

The Header tag may be specified anywhere in the template file; however, it always appears at the 
very top of your document. Only one Header tag is applied to the document. If you have multiple 
Header tags in the file, only the last Header tag is used; any other Header tags are ignored.

If you include a Header tag in your template, then you must set TopMargin in setup.ini to a minimum 
of 20.

The header has three sections, Left, Center, and Right, which are used to position the information in 
the header. The Left parameter aligns the text with the left margin, and the Right parameter right 
aligns the text with the right margin. The Center parameter centers the text in the header.

The text in the header is formatted in 10 point, Helvetica font. If Helvetica is not available on your 
system, the default font is used. You cannot customize text formatting of the Header tag. The Format 
tag does not affect the format of the header. 

FIELD NAME (Required) Name of the field or column. Specify a field or column with 
numeric data. If you specify a field with non-numeric data, a 0 is assigned 
to the variable.

QUERY STRING (Optional) Search specification for the rows to be included in the total. If not 
specified, the current search specification is used.

The syntax for the query string is: Field Name|Query Statement. You may 
specify one or more query strings separated by a vertical bar (|). 

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description
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Syntax
<TAG:Header Left="DATA" Center="DATA" Right="DATA"

Example
<TAG:Header Center="Company Confidential">

Page Break

Description
Forces text that follows the tag to appear on the next page.

Usage
Use this for multipage documents or forms.

Syntax
<TAG:PageBreak>

Example
<TAG:PageBreak>

Picture

Description
Specifies graphic files included in the print template.

Parameter Description

TAG:Header (Required) Header tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing

Parameter Description

TAG:PageBreak (Required) Page break tag indicator.
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Usage
Use to add graphic images, such as a company logo, to your documents. 

The supported file formats are BMP and JPG. 

Graphics files are located in the \Program Files\Siebel Handheld\templates directory on the handheld 
device. Specify the full path name of the file for the Name parameter.

Scaling or graphics operations, such as inverse image, are not supported.

The Alignment and Position parameters are used together to place the graphic. Alignment specifies 
the left edge, the center, or the right edge of the graphic. Position is distance, specified in 
millimeters, from the left edge of the paper. 

■ If Alignment ="Left" and Position="30", then the left edge of the graphic is set 30 millimeters 
from the left edge of the paper. 

■ If Alignment = "Center" and Position = "30", the center of the graphic is set 30 millimeters from 
the left edge of the paper.

■ If Alignment = "Right" and Position = "30", the right edge of the graphic is set 30 millimeters 
from the left edge of the paper.

If Position is not specified, it defaults to 0. Depending on the Alignment setting, the graphic is left-
aligned (Alignment = "Left"), the graphic is right-aligned (Alignment = "Right"), or the graphic is 
centered (Alignment ="Center")

Syntax
<TAG:Picture Name="FILE NAME" Alignment="ALIGNMENT" Position="POSITION">

Example
<TAG:Picture Name="\Program Files\Siebel Handheld\templates\logo.bmp" Alignment="Right" 
Position="88">

Parameter Description

TAG:Picture (Required) Picture tag indicator.

FILE NAME (Required) Specifies the full path and name of the graphics file.

ALIGNMENT (Optional) Specifies the left edge, the center, or the right edge of the graphic. 
Used with the Position parameter to specify the horizontal position of the graphic.

Valid values are LEFT (default), CENTER, and RIGHT.

POSITION (Optional) Specified in millimeters, it is the distance from the left edge of the 
paper. Used with the Alignment parameter to specify the horizontal position of the 
graphic. The default is 0.
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SetVariable

Description
Sets a value to a variable.

Usage
Use SetVariable to assign a value to a variable. You can then print the value by specifying the variable 
in the Cell tag.

Syntax
<TAG:SetVariable Name="VALUE" Variable="VARIABLE NAME>

Example
<TAG:SetVariable="100" Variable="TotalQuantity">

Static Text
You may add static text anywhere in your template by using the current Format settings. The text 
goes across the entire page width. If it exceeds the width of the page, it wraps to the next line.

Example
This quote is valid for 60 days from the date on this quotation.

Title

Description
Name used to identify the template.

Usage
The Title tag is a required tag in your print template file. 

Parameter Description

TAG:SetVariable (Required) Required tag indicator.

VALUE (Required) A value.

VARIABLE NAME (Required) Name of variable where the value is stored.
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When you print your document, this title appears in the print job list. This title does not appear on 
the document that is printed. Use static text to add the document title to your template.

Syntax
<TAG:Title Title="TITLE">

Example
<TAG:Title Title="Quotation">

Using Variables in Print Templates
The following example shows how to use variables in a print template.

<TAG:Title Title="Inventory Report">

<REM: **********Variable Assignment Examples**************>

<TAG:SetVariable name="THIS IS VARIABLE" variable="VarStr">
<TAG:GetRegistry name="InstallDir" variable="VarReg">
<TAG:GetDate dayoffset="10" variable="VarDate">
<TAG:GetDate longformat="TRUE" variable="VarLongDate">
<TAG:GetTime secondoffset="-3600" variable="VarTime">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
variable="VarTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
query="Status|Good" variable="VarGoodTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
query="Status|Defective" variable="VarDefectiveTotal">
<TAG:GetField appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
variable="VarQuantityField">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" query="Status|Good" 
variable="VarGoodCount">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" query="Status|Defective" 
variable="VarDefectiveCount">

<REM: **********Variable Assignment Examples End************>

<REM: Inventory Print Template. This template includes 3 applets. The ENU template>

<TAG:Format Face="Helvetica" Size="16" Align="Center">
[Distributor Name
Street Address
City, Country Postal Code
Phone Number   Fax Number]

Parameter Description

TAG:Title (Required) Title tag indicator.

TITLE (Required) Title text. May be between 1�255 characters.
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<TAG:Format Face="Helvetica" Size="20" Bold="TRUE" Align="Center">
Inventory Report
<TAG:Format Face="Helvetica" Size="8" >
<TAG:Applet Name="CS HH Inv Loc Print Applet" Caption="TRUE" Wrap="TRUE">
<TAG:Applet Name="CS HH Product Bucket List Applet" Line="FALSE" Headerdivider="TRUE" 
Recorddivider="FALSE" Wrap="TRUE">

<REM: *************Variable Usage Example***************>

<TAG:Divider Weight="3" startat="20" endat="80">
<TAG:Cell startat="0" endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell startat="0" endat="50" name="TOTAL Defective:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveTotal" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodTotal" Align="RIGHT"
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Defective Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveCount" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Good Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodCount" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarReg">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarStr">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="30" variable="VarDate">
<TAG:Cell startat="30" endat="70" variable="VarLongDate">
<TAG:Cell startat="70" endat="100" variable="VarTime">
<TAG:EndOfLine>

<REM: ***********Variable Usage Example End***************>

<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="LEFT">
Warehouse Signature
<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="RIGHT">

Rep Signature
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You configure printing attributes in the setup.ini file. This appendix describes the printing parameters 
for Siebel application developers and application administrators.

Overview of Siebel Handheld Print 
Configuration Settings
The administrator sets up the default printer setting in the setup.ini file located in the setup directory.

There are a number of parameters to specify printing on the handheld. The parameters specify the 
following:

■ Printer attributes (printer model, port, baud rate, and printer handshake).

■ Printing attributes (portrait or landscape orientation, print density and quality, use of 
compression techniques, and advancing continuous�feed paper).

■ Dimensions of the paper (U.S. or European standard paper sizes or custom�size paper).

■ Margin settings of the pages (left, right, top, and bottom margins).

These parameters are specified in the [Printing] section of the setup.ini file located in the setup 
directory. The file contains default settings for all the printing parameters. Review the settings in the 
file to verify that these settings will work for your printing environment. If necessary, edit the 
settings as required. You may use any text editor to edit the file.

See Appendix E for a list of the printing parameters and valid values.

The parameters are set using the following syntax:

PARAMETER_NAME = VALUE

For example: PrinterType = 1

The parameters are listed below in alphabetical order by the parameter name.

MarginBottom
Use the MarginBottom parameter to specify the dimensions of the bottom margin of your page. 
Specify the margin in millimeters using a whole number; decimal fractions are not valid. The default 
is 5 millimeters.

The data specified in the Footer tag of the print template is printed in the margin specified by 
MarginBottom. Therefore, if the print template includes a Footer tag, you must specify a wide enough 
bottom margin to accommodate the footer. MarginBottom should be set to a minimum of 20 
millimeters. For more information, see �Footer� on page 161.
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MarginLeft
Use the MarginLeft parameter to specify the width of the left margin of your page. Specify the margin 
in millimeters using a whole number; decimal fractions are not valid. The default is 5 millimeters.

MarginRight
Use the MarginRight parameter to specify the width of the right margin of your page. Specify the 
margin in millimeters using a whole number; decimal fractions are not valid. The default is 5 
millimeters.

MarginTop
Use the MarginTop parameter to specify the dimensions of the top margin of your page. Specify the 
margin in millimeters using a whole number; decimal fractions are not valid. The default is 5 
millimeters.

The data specified in the Header tag of the print template is printed in the margin specified by 
MarginTop. Therefore, if the print template includes a Header tag, you must specify a wide enough 
top margin to accommodate the footer. MarginTop should be set to a minimum of 20 millimeters. For 
more information, see �Header� on page 167.

PaperHeight
If the paper that your printer uses is not one of the supported standard sizes, then set PaperSize to 
5 (custom paper dimensions). Then, specify the height of the paper, in millimeters, using the 
PaperHeight parameter. You must use a whole number; decimal fractions are not valid. The default 
is 280 millimeters. If you specify a value of 1�4 for PaperSize, the PaperHeight parameter is ignored.

Use the PaperWidth parameter to specify the width of the paper.

PaperSize
Specify one of the standard paper sizes or specify a custom paper size. (See Table 36.) If you specify 
custom paper size (5), you must also specify the PaperWidth and PaperHeight parameters. The 
default is custom paper dimensions.
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See also PaperWidth and PaperHeight.

PaperWidth
If the paper that your printer is printing to is not one of the supported standard sizes, then set 
PaperSize to 5 (custom paper dimensions). Then, you must specify the width measurement of the 
paper, in millimeters, using the PaperWidth parameter. You must use a whole number; decimal 
fractions are not valid. The default is 5 millimeters. If you specify a value of 1�4 for PaperSize, the 
PaperWidth parameter is ignored.

Use the PaperHeight parameter to specify the length of the paper.

PrinterBaudrate
Use PrinterBaudrate to specify the speed of the data transmission for the printer. (See Table 37.)

Table 36. Paper Dimensions

Value Description

1 Letter size (8.5" x 11.5")

2 A4 (210 mm x 297 mm)

3 B5 (176 mm x 250 mm)

4 Legal size (8.5" x 14")

5 (default) Custom paper dimensions (Specify PaperWidth and PaperHeight parameters.)

Table 37. Printer Baud Rate

Value Description

0 Always use 0 for LPT or Network printer ports or for COM ports that communicate 
with the printer at 4800 baud

1 (default) 9600 baud

2 19200 baud

3 38400 baud

4 57600 baud

5 115200 baud
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PrinterCompressed
Use PrinterCompressed to specify the data compression mode. (See Table 38.) For the printers 
supported in this release, always set PrinterCompressed to 1.

PrinterDensity
Use the PrinterDensity parameter to get a lighter or darker output from the printer. Start with the 
default setting, 2, which corresponds to the printer manufacturer�s default. As you get feedback from 
the field, you may need to adjust this setting.

The valid values are 0�4 where 0 is the lightest print density, 4 is the heaviest print density, and 2 
is average print density.

PrinterDither
Use to specify the method by which different colors are represented. (See Table 39.) For the printers 
supported in this release, PrinterDither should always be set to 0.

Table 38. Data Compression

Value Description

0 No compression techniques used

1 (default) Use any known compression

Table 39. Print Dithering

Value Description

0 (default) Use color diffusion

1 Use dithering
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PrinterDraftMode
Use PrinterDraftMode to specify the quality of the printing. (See Table 40.) For the printers supported 
in this release, PrinterDraftMode should always be set to 0.

PrinterFormFeed
Use PrinterFormFeed to specify how paper advances to the next page. (See Table 41.) If using sheets 
of paper, set PrinterFormFeed to 0. 

Specify 1 or 2 for continuous�feed paper:

■ Set PrinterFormFeed to 1 if you do not need to conserve paper or if you want pages of uniform 
length. The printer scrolls to the length specified by the PageHeight parameter and trims the 
page there. 

■ Set PrinterFormFeed to 2 to conserve paper or if it does not matter if your pages are of varying 
length. In this case, the printer scrolls 25 millimeters beyond the last printed line and trims the 
page there. The scroll distance, 25 mm, is not customizable.

For both values, 1 and 2, the page length never exceeds PageHeight.

Table 40. Print Quality

Value Description

0 (default) Use the highest quality printing

1 Use a lower quality printing if available

Table 41. Printer Form Feed

Value Description

0 (default) Printer sends a form feed command to the printer at the end of each page. Use 
this setting for sheet paper.

1 Printer scrolls the page to the length specified by the PaperHeight parameter.

2 Printer scrolls the page 25 millimeters past the last printed line of the page.
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PrinterHandshake
Use PrinterHandshake to define the serial port handshake. (See Table 42.) The PrinterHandshake 
parameter applies only when the printer port is a Com1 or Com2 port. If PrinterPort is set to Com1 
or Com2, then set PrinterHandshake to 1. 

PrinterOrientation
Specify whether the paper is to be oriented vertically (portrait) or horizontally (landscape). (See 
Table 43.) Not all printers can print in landscape orientation. Therefore, you will need to check the 
specifications for your printer.

PrinterPort
Specify the port to which the printer is connected with the PrinterPort parameter. (See Table 44.)

If PrinterPort is an LPT port or a network path (2 or 9), then the PrinterBaudrate must be set to 0.

Table 42. Printer Handshake

Value Description

0 Uses Xon/Xoff

1 (default) Uses hardware control lines

2 No handshaking of serial port

Table 43. Paper Orientation

Value Description

1 (default) Portrait (vertical)

2 Landscape (horizontal)

Table 44. Printer Port

Value Description

0 Com1: serial port

1 Com2: serial port

2 LPT: parallel port

3 (default) IR Infrared port

4 Com3: serial port
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PrinterType
Specify the type of printer using the PrinterType parameter. See Table 45 for the list of supported 
printers.

Default Printing Settings
The following are the printing parameters from the setup.ini file. The values shown are the default 
settings.

[Printing]

PrinterType= 14
PrinterPort= 3 
PrinterBaudrate= 1
PrinterHandshake= 1
PrinterOrientation= 1
PrinterDensity= 2
PrinterCompressed= 1
PrinterDither= 0

5 Com4: serial port

6 Com5: serial port

7 Com6: serial port

8 Print to file OUTPUT.PRN

9 Print to network address

10 Bluetooth BlueCard solution by Wireless Solutions

11 Socket PNC Bluetooth card support

12 Bluetooth BlueCard solution by Anycom

13 Com7: serial port

14 Com8: serial port

Table 45. Printer Type

Value Description

6 Pentax PocketJet 200

14 (default) O�Neil microFlash2i and microFlash4t printers

108 O�Neil microFlash8i printer

Table 44. Printer Port

Value Description
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PrinterDraftMode= 0
PrinterFormFeed= 0
PaperSize= 5
PaperWidth= 115
PaperHeight= 280
MarginLeft= 5
MarginRight= 5
MarginTop= 5
MarginBottom= 5
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Siebel Handheld Synchronization, using with 

handheld client 102
synchronizing data, about 102

data filtering
developing data filters, steps 51
pick applet, data filtering for 56
Sales Handheld PDQ filters 52

database backups
about 100
automatic backup after 

synchronization 100
database backup parameters. editing 71
enabling, about 70
restoring data from a backup 101
setting up database backups 71
troubleshooting 131

DDvP
See Direct Server Sync via Proxy

default sync filters, about 52
deleting

quote line items 125
Direct Server Sync via Proxy, about 15
Direct Server Synchronization

See also Direct Server Synchronization (DDS) 
infrastructure

about 56
about and diagram 15
checklist, using to troubleshoot 132
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described 14
handheld application, using to install 87
handheld client, using with 104
log files, using for troubleshooting 133
network performance, 

troubleshooting 138
patches, using to deploy 75
server performance, troubleshooting 137

Direct Server Synchronization (DDS) 
infrastructure

DDS components, about installing 64
DSS object manager configuration file, 

editing 65
hardware and network configuration, 

recommended 63
multiple synchronization servers, using 67
planning, about 62
server logging levels, configuring 66
server process management, 

optimizing 67
server topology overview 63
Siebel Server installer, using 64
synchronization performance and scalability, 

about 67
synchronization security, about 67

direct synchronization server, 
described 14

Divider print tag 159
documents, defining 34
downloading patches 77
drilldowns, about 31
DSS object manager configuration file, 

editing 65
dynamic hyperlink, about 31

E
ellipsis, and expandable fields 94
employee participants, specifying 121
end user error messages

See troubleshooting
EndofLine print tag 160
error data, accessing 84
error messages

See troubleshooting
errors

general synchronization errors 105
synchronization transaction conflicts 106

expenses, tracking
detailed line items, adding 128
expense report, creating 128
expense report, submitting 129
procedures, about 128

exporting data 98

extended insert processing
about and synchronization 82
enabling 82

extended pick processing
about and synchronization 79
enabling 80

external media
backing up to 71
handheld application, about installing 

from 74
stand-alone installer, creating 74

F
features, new 11
Find

about using 97
Footer print tag 161
form applets, configuring

about 25
designing, about 34
group boxes, about 26
labels, about 26
layout sequence 25

Format print tag 162
Forward button, about 95

G
general sync filters, about 52
GetCount print tag 163
GetDate print tag 163
GetField print tag 164
GetRegistry print tag 165
GetTime print tag 166
GetTotal print tag 166
global user properties, list of 149
GotoView method, using 23
group boxes, about configuring 26
guidelines

Siebel Handheld client screen, about 
designing for 21

Siebel Handheld client, configuration 
guidelines 21

Siebel Handheld, recommended configuration 
guidelines 32

H
handheld device logs

list of log files 134
synchronization errors, logging 135

handheld interface
See interface

Header print tag 167
help
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Siebel Expert Services, about using 139
Siebel Professional Services, about 

using 139
History arrows, about 95
Home Page applet, using 26
Hotel expense tax itemization

about supporting 129
hyperlinks, about 31

I
installing

barcode scanning, preparing handheld 
application for 89

CompactFlash card. setting up installation 
on 72

Companion Sync, using to deploy 
patches 76

database backup parameters, editing 71
Direct Server Sync, using to deploy 

patches 75
Direct Server Sync, using to install handheld 

application 87
external media, about installing from 74
external media, backing up to 71
install directory, changing 74
patches, about distributing 74
patches, downloading 77
print templates in the Install directory 72
process of installation 68
read-only files, changing attributes 77
reinstalling the handheld application 88
restart parameter, setting 73
restoring from a backup, about 72
setup.ini file, editing 68
software on handheld. about 85
stand-alone installer, creating 74
SyncURL, changing 73
uninstalling handheld application 89
upgrade kits, creating to remotely deploy 

patch files 77
upgrading the handheld application 88
user database backup, about enabling 70
user database backup, setting up 71
using Companion Sync users to install 

handheld application 86
Integrated Sync

handheld client, synchronizing for Companion 
Synch 103

synchronizing data, and 102
interface

application-level menu 92
components, about and diagram 91
expandable fields 94

Minimize button 93
More Info view, navigation level 94
Queries drop-down list 93
screens menu, about 92
screens menu, navigation level 94
Show drop-down list, about 92
Show drop-down list, navigation level 94
Siebel toolbar, about 93
Siebel toolbar, customizing 93
status bar 93
toggling between applets 94
URLs in applet fields 95

L
labels, about configuring 26
list applets, configuring

about 24
designing, about 35
recommended strategy 24

log files
Companion Sync logs, using for 

troubleshooting 134
Direct Server Sync logs, using for 

troubleshooting 133
handheld device logs, using for 

troubleshooting 134

M
MarginBottom parameter 173
MarginLeft parameter 174
MarginRight parameter 174
MarginTop parameter 174
Maximize Minimize Applet button, 

about 93
media

external media, backing up to 71
handheld application, about installing from 

external media 74
stand-alone installer, creating 74

memory, increasing 107
menu bar, about 30
methods

AutoOrder method 151
AutoQuote method fields 151
AutoQuote method values 150

Mileage expense type
about supporting 129

Minimize button, about 93
More Info View

navigation level 94
multiple synchronization servers

about using 67
Multi-Value Group applet, support of 19
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N
naming conventions, about 22
network performance, about 138
new features 11

O
opportunities

adding to an account 114
contact, associating with an 

opportunity 117
contacts, associating with an existing 

opportunity 111
creating opportunities 115
defined and examples 114
opportunity quotes, about 118
product, associating with an 

opportunity 117
sales methods, about 116
scenario 115

orders, managing
about 126
Auto Order, creating orders from 

quote 126
manually create an order 127
order line items, adding 127
terms and totals, adding 127

P
Page Break print tag 168
PaperHeight parameter 174
PaperSize parameter 174
PaperWidth parameter 175
parent form applet, about 22
PatchAgent, about 74
patches

Companion Sync, using to deploy 
patches 76

Direct Server Sync, using to deploy 
patches 75

distributing, about 74
downloading 77
read-only files, changing attributes 77
synchronizing data, and 102
upgrade kits, creating to remotely deploy 

patch files 77
PDQ filters, administration

Companion Sync, about 55
Direct Server Sync mode, about 56

PDQs
Queries drop-down list, and 93

performance
application memory, increasing 107
client performance, about 137

handheld screen, about designing for 21
improving by identifying user activities 21
improving performance, about 106
network performance, about 138
server performance, about 137
SQLTrace and synchronization 135

pick applets, data filtering for
about 56
business object declarations, setting 

examples 58
configuration file directives 57
Popup Visibility Type setting, overriding 60
visibility, designating 59

Picture print tag 168
pop-up lists

auto pop-up lists, about using 26
Popup Visibility Type setting, 

overriding 60
predefined queries

Queries drop-down list, and 93
Predefined Queries (PDQs)

general and default PDQ filters, 
described 52

preferences
setting user preferences 100

print applets
designing, about 34

Print buttons, configuring 35
print tagging language

See print templates
print templates

Applet print tag 156
Cell print tag 157
Comment print tag 159
creating print templates 36
Divider print tag 159
EndofLine print tag 160
Footer print tag 161
Format print tag 162
GetCount print tag 163
GetDate print tag 163
GetField print tag 164
GetRegistry print tag 165
GetTime print tag 166
GetTotal print tag 166
Header print tag 167
Install directory. installing in 72
Page Break print tag 168
Picture print tag 168
print template file, creating overview 155
SetVariable print tag 170
Static Text print tag 170
Title print tag 170
variables, example using in template 171
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views, associated with 23
PrinterBaudrate parameter 175
PrinterCompressed parameter 176
PrinterDensity parameter 176
PrinterDither parameter 176
PrinterDraftMode parameter 177
PrinterFormFeed parameter 177
PrinterHandshake parameter 178
PrinterOrientation parameter 178
PrinterPort parameter 178
PrinterType parameter 179
printing

handheld application, printing with 98
quotes 125

printing, configuration settings
default printing settings, list of 179
MarginBottom parameter 173
MarginLeft parameter 174
MarginRight parameter 174
MarginTop parameter 174
PaperHeight parameter 174
PaperSize parameter 174
PaperWidth parameter 175
parameters and syntax 173
PrinterBaudrate parameter 175
PrinterCompressed parameter 176
PrinterDensity parameter 176
PrinterDither parameter 176
PrinterDraftMode parameter 177
PrinterFormFeed parameter 177
PrinterHandshake parameter 178
PrinterOrientation parameter 178
PrinterPort parameter 178
PrinterType parameter 179

printing, configuring
about 33
applet, configuring for printing 35
documents, defining 34
form applets, designing 34
list applets, designing 35
print applets, designing 34
Print buttons, configuring 35
print templates, creating 36

products
associating with an opportunity 117

projects
naming conventions, and 22

Q
queries

about using 97
creating a query 98
executing 98

refining 98
Queries drop down list, about 93
quotes, developing

about 122
Auto Order, creating from quote 126
Auto Quote, about using 123
Auto Quote, creating a quote 124
creating quotes 122
developing quotes scenario 122
opportunity quotes, about 118
printing quotes 125
quote item, adding 124
quote item, deleting 125

R
read-only files

changing attributes for upgrade kits 77
record navigation buttons 95
records, navigating a list of

about 95
Back and Forward buttons 95
History arrows 95
record navigation buttons 95

reinstalling the handheld application 88
reports

expense report, creating 128
expense report, submitting 129
views, associated with 23

repository
compiling 33

restart parameter, setting 73
restoring data

from a backup 101
troubleshooting 131

S
Sales Handheld PDQ filters

about 52
sales methods, about 116
screens

designing screens for Siebel Handheld, 
about 22

screen allocation 22
views, list of 141

screens menu
about 92
navigation level 94

scripting
deactivating scripts, about 61
user interface methods, calls to 61

server installation
Direct Server Synchronization (DDS), about 

installing 64
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Direct Server Synchronization (DDS), using 
Siebel Server installer 64

DSS object manager configuration file, 
editing 65

hardware and network configuration, 
recommended 63

multiple synchronization servers, using 67
planning for, about 62
server logging levels, configuring 66
server process management, 

optimizing 67
server topology overview 63
synchronization performance and scalability, 

about 67
synchronization security, about 67

server logging levels, configuring 66
server performance, troubleshooting 137
server process management, 

optimizing 67
ServiceCE Generic, about 30
setup.ini file, editing 68
SetVariable print tag 170
Shipping field, about supporting 128
Show drop-down list

about 92
navigation level 94

Siebel Anywhere
using to create upgrade kits 77

Siebel eScript
issues and validation 61

Siebel Expert Services
about using 139

Siebel Handheld Client
application memory, increasing 107
auto-pop-up list, using 26
compiling the repository 33
configuration guidelines 21
configuration guidelines, recommended 32
Direct Server Synchronization, using with 

handheld client 104
form applets, about configuring 25
general synchronization errors 105
handheld screen, about designing for 21
Home page applet, about 26
hyperlinks, about 31
improving performance, about 106
list applets, configuring 24
menu bar, about 30
Multi-Value Group applet, support of 19
printing, configuring 33
process of configuring 17
scripting, about 61
Siebel Web Client, differences in 

configuring 18

status bar, about 31
synchronization conflicts, preventing 32
synchronization transaction conflicts 106
synchronizing for Companion Synch 103
testing the handheld application 38
toolbars, about 30
unsupported functions 19
user functionality, defining 20
user interface elements, about 

configuring 24
Siebel Handheld projects

about creating and naming conventions 22
Siebel Handheld Synchronization

application memory, increasing 107
Companion Synchronization, using with 

handheld 102
Direct Server Synchronization, using with 

handheld client 104
general synchronization errors 105
handheld client, synchronizing for Companion 

Synch 103
handheld client, using 102
improving performance, about 106
synchronization transaction conflicts 106

Siebel Handheld upgrade kit
creating upgrade kit 77
read-only files, changing attributes 77

Siebel Mobile Web Client
Companion Sync, using to deploy 

patches 76
installation, about 68
read-only files, changing attributes for 

upgrade kits 77
upgrade kit, creating 77

Siebel Professional Services
about using 139

Siebel Server installer
DSS component, using to install 64
DSS object manager configuration file, 

editing 65
server logging levels, configuring 66
server process management, 

optimizing 67
Siebel toolbar

about 93
customizing 93

Siebel Visual Basic (VB)
issues and validation 61

Siebel Web Client
Multi-Value Group applet, support of 19
scripting, issues and validation 61
Siebel Handheld client, differences in 

configuring 18
unsupported functions 19
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signature capture
enabling, about and screen capture 

buttons 36
signature capture applet control user 

properties 37
software

about installing on handheld 85
SQLTrace, enabling 135
.SRF file

compiling repository file 33
stand-alone installer, creating 74
Static Text print tag 170
status bar

application window, appears at bottom 
of 93

toolbar, located above 31
submitting

expense report 129
synchronization

Direct Server Sync via Proxy, about 15
Direct Server Sync, about and diagram 15
methods and architecture 14
overview 14
servers, types of 14

synchronization, conflict handling and 
recovery

about 79
error data, accessing 84
extended insert pick processing, about 82
extended insert pick processing, 

enabling 82
extended pick processing, about 79
extended pick processing, enabling 80

synchronizing
application memory, increasing 107
automatic backup after 

synchronization 100
Companion Synchronization, using with 

handheld 102
data, about 102
Direct Server Synchronization, using with 

handheld client 104
general synchronization errors 105
handheld client, synchronizing for Companion 

Synch 103
handheld synchronization errors, 

logging 135
improving performance, about 106
multiple synchronization servers, using 67
performance and scalability, about 67
resynchronization problems, 

troubleshooting 133
security, about 67

Siebel Handheld Synchronization, using with 
handheld client 102

synchronization conflicts, preventing 32
transaction conflicts 106
troubleshooting, about problems caused 

by 132
SyncURL, changing 73

T
technical support

Siebel Expert Services, about using 139
Siebel Professional Services, about 

using 139
templates

print templates, creating 36
print templates, views associated with 23

terms, adding to order line items 127
testing the handheld application 38
timeout parameter

Windows 2000, changing on 136
Windows NT, changing on 136

Title print tag 170
toggling between applets 94
toolbars

about 93
configuring 31
customizing 93
toolbar functions 30

totals, adding to order line items 127
troubleshooting

client installation, backup, and restore 131
client performance, about 137
Companion Sync checklist, using 132
Companion Sync log files 134
Direct Server Sync checklist, using 132
Direct Server Sync log files 133
general synchronization errors 105
handheld device logs 134
network performance, about 138
resynchronization problems 133
server performance, about 137
Siebel Expert Services, about using 139
Siebel Professional Services, about 

using 139
SQLTrace, enabling 135
synchronization transaction conflicts 106
synchronization, about problems caused 

by 132
timeout parameter, changing on Windows 

2000 136
timeout parameter, changing on Windows 

NT 136
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U
ui

See user interface elements, configuring
uninstalling the handheld application 89
upgrade kits

creating to remotely deploy patch files 77
read-only files, changing attributes 77

upgrading
handheld application 88
preparing to upgrade 85

URLs
in applet fields, 95

user functionality, defining
about 20

user interface elements, configuring
about 24
auto pop-up lists, about using 26
buttons, about and behavior 27
form applets, about configuring 25
Home Page applet, about 26
hyperlinks, about 31
list applets, about configuring 24
menu bar, about 30
status bar, about using 31
toolbars functions 30
toolbars, about configuring 31

user interface methods
calls to business component script 61

user preferences

about customizing 100
user properties

global user properties, list of 149
list of 149

V
views

default behavior, overriding 23
designing views for Siebel Handheld, 

about 22
drill-down only 23
new views, adding 41
print templates or reports, associated 

with 23
visibility, designating 59

W
Web server timeout errors

timeout parameter, changing on Windows 
2000 136

timeout parameter, changing on Windows 
NT 136

Windows
timeout parameter, changing on Windows 

2000 136
timeout parameter, changing on Windows 

NT 136
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